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IMPORTANT!
READ CAREFULLY BEFORE USE.
KEEP THIS GUIDE FOR FUTURE REFERENCE.
Screenshots and graphics in this book may differ slightly from your product due to differences in
your product firmware or your computer operating system. Every effort has been made to ensure
that the information in this manual is accurate.

Related Documentation
• Quick Start Guide
The Quick Start Guide shows how to connect the NAS and get up and running right away.
• Web Configurator Online Help
The embedded Web Help contains descriptions of individual screens and supplementary
information.

Online Support Information
Visit our product support website at http://www.zyxel.com/support/support_landing.shtml and
choose from these topics:
• ZyXEL Support Center - Acquire firmware, software, FAQ, product application or other support
files for ZyXEL devices.
• Downloads - Acquire firmware, software, driver or other support files for ZyXEL devices.
• Knowledge Base - Find articles related to product applications, FAQ, and user experience.
• Warranty Information - ZyXEL offers warranty to the original end user (purchaser) that the
product is free from any material or workmanship defects for a specific period (the Warranty
Period) from the date of purchase. The Warranty Period varies by region.
• Product Registration - Register your ZyXEL product to receive the latest drivers and firmware
updates.
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Getting to Know Your NAS
1.1 Overview
Use the NAS as your own personal cloud. Here are some key features:
Start using ZyXEL NAS instantly with FindMe - Use ZyXEL FindMe to discover your NAS on your
home network and get in control in under 15 seconds. Then do an easy installation with no need to
install a NAS utility.
Access and share files from your NAS wherever you are - Using the ZyXEL Drive mobile app
makes it easy.
Create a shared cloud space for people without a NAS - Provide your cloud space for your
friends or family members when you share a folder from the NAS with the ZyXEL Drive mobile app.
Your friends and family members don’t need to purchase an additional NAS - just install the ZyXEL
Drive mobile app on their mobile devices.
Protect your data from drive failure - The NAS’s RAID 1 capability clones contents from one
drive to another. If a drive is damaged or corrupted, you still have another drive to restore from or
use.
Get up and running quickly with the easy-to-use interface - The ZyXEL NSM (NAS Station
Management) 5.1 intelligent desktop provides a rich feature set of tools with an easy-to-understand
GUI design to help you get things done quickly. The multitasking capability through a multi-window
interface enables you to quickly get applications up and running.
Check your NAS while you’re away - Even if you have several ZyXEL NAS devices, visit the
myZyXELcloud Web portal from anywhere to see their health status at a glance.
Stream multimedia contents to your big screen TV - Bring your favorite multimedia files on
the NAS to the big screen. ZyXEL zCloud app lets you play your favorite videos, music, or photos on
your big screen with TV streaming devices such as Apple TV, Google Chromecast, Roku 3, and
Amazon Fire TV; or directly on smart TVs like those from Samsung and LG.
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Figure 1 Example of the NAS in a Home Network

NAS
Above is the NAS in a home network. Users back up and share data on the NAS. The media player
plays the NAS’s media files on the TV. A USB hard drive provides extra storage space and files are
copied directly from the USB mass storage device to the NAS.
Place the NAS behind a firewall and/or IDP (Intrusion Detection and Prevention) device to protect it
from attacks from the Internet.
Refer to the Quick Start Guide for hardware connections and how to install and remove hard drives
from the disk trays.

Note: Turn off and disconnect the NAS before you install or remove the internal hard disk
or disks.

1.2 LEDs
This table describes the NAS’s LEDs.
Table 1 LEDs
LED

COLOR STATUS

DESCRIPTION

POWER

White

On

The NAS is turned on and receiving power.

Off

The NAS is turned off.

On

The NAS has fully started and is operating normally.

Blinking

The NAS is starting up or upgrading the firmware.

SYSTEM

White

Note: Do not turn off the NAS while it is upgrading the firmware or you may
render it unusable.
Red

On

The NAS has a system error.
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Table 1 LEDs (continued)
LED

COLOR STATUS

DESCRIPTION

HDD

White

On

The hard disk drive is connected properly to the NAS. This LED stays on
white when the hard disk drive is in hibernation if you do not enable sleeping
HDD LED blinking.

Blinking

The NAS is saving data to the hard disk drive.

Slow
Blinking

Sleeping HDD LED blinking is enabled and the hard disk drive is in
hibernation.

On

The NAS detected an error on the hard disk drive (like a bad sector for
example). The NAS automatically tries to recover a bad sector, but the LED
stays red until the NAS restarts.

Off

The NAS cannot detect a hard disk in the disk bay or the LED is disabled.

White

On

A USB device is connected to the NAS and the NAS is ready to copy.

Blinking

The NAS is copying or synchronizing files.

Red

On

Copying or synchronizing files to or from the USB or SD failed.

Off

No USB device is connected.

On

The NAS has a successful 10/100 Mbps Ethernet connection.

Red

COPY

LAN1 /
LAN2

Green

Amber

Blinking

The 100M LAN is sending or receiving packets.

Off

The NAS does not have a 10/100 Mbps Ethernet connection.

On

The NAS has a successful 1000 Mbps Ethernet connection.

Blinking

The 1000 M LAN is sending or receiving packets.

Off

The NAS does not have a 1000 Mbps Ethernet connection.

1.3 Hard Disks
The NAS has internal hard disk bays. Install SATA (Serial Advanced Technology Attachment) hard
disks. Note that the SATA hard disks are treated as internal or SATA volumes. Any hard disk
connected to a USB port is considered an external or USB volume.

1.4 SD Card
Use up to a 128 GB SDXC card with the front panel SD card slot. The SD card slot works with the
COPY/SYNC button (see Section 1.6 on page 17 for details).

1.5 Power Button
Use the power button on the front panel to turn the NAS on or off.
• Press the power button for one second to turn on the NAS.
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Figure 2 Using the Power Button to Turn Off the NAS

Press

1 Beep

2 Beeps
2 more seconds

3 seconds

Release for
hardware
shutdown

Release for
software
shutdown

• To have the NAS go through its normal software shutdown process and turn itself off, press the
power button until you hear one beep (after about three seconds), then release it.
• To perform a hardware shutdown and have the NAS immediately turn itself off without going
through the normal shutdown process, press the power button until you hear a second beep
(after about five seconds), then release it.

1.6 COPY/SYNC Button
Use the COPY/SYNC button on the front panel to copy or synchronize files between a connected
USB or SD device and the NAS. See Section 17.10 on page 232 for more details on how to
configure the copy/sync settings.

1.7 RESET Button
Use the RESET button on the rear panel to restore the NAS’s default settings.
Figure 3 The RESET Button

Press

1 Beep

2 Beeps
5 more seconds

Release to Reset
IP Address
Password

Release to
Clear All Settings

• Press the RESET button until you hear one beep (after about two seconds), then release it. You
will hear one more beep after you release the button.
This resets the NAS’s IP address and password to the default values.
• Press the RESET button until you hear two beeps. After the second beep, continue pressing the
button for five more seconds, then release it. You will hear three quick beeps after you release
the button.
This resets the NAS to the factory default configuration. All settings you have configured on the
NAS, including IP address, password, user accounts, groups, and so on will be reset to the
factory defaults.
The reset process does NOT affect the volume settings, nor data stored on the NAS.
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You should periodically back up your configuration file to your computer (see Section 26.5 on page
310 for details about managing the NAS’s configuration file). You could then restore your
configuration in the event that you or someone else reset the NAS to the factory defaults.

Note: Keep the NAS in a secure location in order to prevent unauthorized reset of the
device.
You may need to close and re-open the NAS Starter Utility to discover the NAS. This is because the
NAS automatically re-acquires IP address information, so its IP address may change. If no IP
address information is assigned, the NAS uses Auto-IP to assign itself an IP address and subnet
mask. For example, you could connect the NAS directly to your computer. If the computer is also
set to get an IP address automatically, the computer and the NAS will choose addresses for
themselves and be able to communicate.
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Getting Started
2.1 Overview
Use FindMe or the NAS Starter Utility to find and access the NAS and the files on it.
The NAS Starter Utility supports Windows XP, Windows Vista, Windows 7, and Windows 8. Click
Help to open a Web Help page about the NAS Starter Utility screens.

Note: Installing this version of the NAS Starter Utility uninstalls previous versions.
Note: Refer to the Quick Start Guide for your NAS’s hardware connections and the steps
for installing the NAS Starter Utility.

2.2 FindMe
1

Connect to https://findme.zyxel.com in your browser to find and connect to your NAS.

2

Use the default username “admin” and password “1234” to log in. See Chapter 7 on page 38 for
more on the web desktop.
Figure 4 NAS Login Screen

2.3 NAS Starter Utility
• The NAS Starter Utility broadcasts a request packet when you first run it. Each NAS has an NAS
Starter Utility Agent that always listens and responds to requests from the NAS Starter Utility.
The NAS Starter Utility receives the response packet that contains information, such as host
name, IP, and so on.
• If you plan to use more than one NAS in your network, configure them with unique server
names. This enables you to identify each NAS in the NAS Starter Utility screens.
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2.3.1 NAS Seeker Screen
Use this screen to view the NASs in your network. The NAS’s Server Name. The default is ‘NAS’
followed by the number of your model (‘NAS540’ for example). See Section 2.3.5 on page 23 for
how to change it to a more recognizable one in your network.
Click the NAS Starter Utility icon on your desktop or in the Windows system tray to start the NAS
Starter Utility. Alternatively you can click Start > Programs > ZyXEL > NAS Starter Utility.
Figure 5 NAS Starter Utility Desktop Icon

Figure 6 NAS Starter Utility Windows System Tray Icon

The first time you open the NAS Starter Utility the discovery screen appears as follows.
Figure 7 NAS Seeker

The following table describes the labels in this screen.
Table 2 NAS Seeker
LABEL

DESCRIPTION

Connect

Select a NAS and click this to connect to it.

Refresh

Click this to refresh the screen. The NAS Starter Utility does not automatically refresh.
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Table 2 NAS Seeker (continued)
LABEL

DESCRIPTION

Status

This shows whether the NAS is Online, Unreachable, Configuring, or Config Failed.

Server Name

This is the server name you configured for the NAS. If you have more than one NAS in
your network, it is recommended that you give each one a unique name for identification
purposes.

IP Address

This is the current IP address of the NAS.

2.3.2 Main NAS Starter Utility Screen
The main NAS Starter Utility screen displays after you select an NAS in the NAS Seeker screen.
Figure 8 NAS Starter Utility Main Screen

The following table describes the labels in this screen.
Table 3 NAS Starter Utility Main Screen
LABEL

DESCRIPTION

?

Click this to display the utility help.

Configuration

Click this to configure system settings (see Section 2.3.5 on page 23).

NAS Seeker

Click this to use the NAS Seeker screen (Section 2.3.1 on page 20) to find and connect to
a different NAS on your network.

Server Name

This is the server name you configured for the NAS. If you have more than one NAS in
your network, it is recommended that you give each one a unique name for identification
purposes.

IP Address

This is the current IP address of the NAS.
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Table 3 NAS Starter Utility Main Screen (continued)
LABEL

DESCRIPTION

MAC Address

This is the NAS’s unique physical hardware address (MAC).

Firmware Version

This shows the version of firmware the NAS is currently using.

Status

This shows whether the NAS is Online, Uninitialized, Unreachable, Configuring, or
Config Failed.

Run Initialization
Wizard

This button displays if the NAS detects that the NAS has not yet configured any of the
installed hard disks. Click this button to go to the Web Configurator login screen (see
Section 7.2 on page 38).

Capacity

This shows the NAS’s total, in-use, and remaining storage capacity.

DeskTop

Click this button to go to the Web Configurator login screen (see Section 7.2 on page 38).

Network Drive

Click this to add the NAS as a network drive in your computer’s Windows Explorer.

Shared Folder

Click this to log into the NAS’s file directory in Windows Explorer.

myZyXELcloud

Click this to go to mycloud.zyxel.com to set up a free DDNS hostname for the NAS so you
can connect to it easily from the Internet.

2.3.3 Directory of the NAS
In the main NAS Starter Utility screen click Shared Folder to log into the NAS’s file directory in
Windows Explorer. Enter the administrator user name and password and click Login.
Figure 9 Login

The utility opens the NAS’s directory in Windows Explorer.
Figure 10 Directory
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2.3.4 Network Drive
In the main NAS Starter Utility screen click Network Drive to add the NAS as a network drive in
your computer’s Windows Explorer.
Enter your user name and password and click Login to be able to add the NAS’s shares to which
you have access as network drives. Otherwise select Guest and click Login to be able to add the
NAS’s public shares as network drives.
Figure 11 Login

Select a share on the NAS and the drive letter on your computer to which you want to map it. The
shares that each user can select to map depends on the user’s permissions. For example, if share1
is private to user1, then only user1 is allowed to map share1. The table displays the NAS shares
that are already mapped to drive letters on your computer. After you click Apply you can see the
new drive in Windows Explorer (My Computer) where you can access and use it like your
computer’s other drives.
Figure 12 Network Drive

2.3.5 Configure System Settings
Use these screens to be able to change the NAS’s server name, time zone, PPPoE, IP address,
subnet mask, default gateway, or DNS settings.
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Click Configuration > System Setting in the main utility screen to display the following screen.
Figure 13 NAS Starter Utility > Configuration > System Setting

The following table describes the labels in this screen.
Table 4 NAS Starter Utility > Configuration > System Setting
LABEL

DESCRIPTION

Server Name

Specify a name to uniquely identify the NAS on your network. You can enter up to 15
alphanumeric characters with minus signs allowed but not as the last character. The
name must begin with an alphabetic character (a-z) and is case sensitive.

Time Zone

Choose the time zone of your location. This will set the time difference between your
time zone and Greenwich Mean Time (GMT).

Enable PPPoE
Connection

Click this if your Internet connection requires you to enter a user name and password to
connect to the Internet. Enter your user name and password

IP Address

Use these fields to configure the IP address of the LAN interface through which you are
connected to the NAS.
When the LAN interfaces are set to stand-alone, this configures the IP address of the LAN
interface in the same subnet as your computer. It configures LAN1 if both LAN interfaces
are in the same subnet as your computer.
If you use the administrator configuration screens to set the LAN interfaces to link
aggregation, this configures the IP address that both LAN interfaces share.

Automatically get
IP address

Select this if the NAS is automatically assigned an IP address from the ISP or a DHCP
server in your network.

Manually assign IP
address

Select this if you want to assign the NAS a fixed IP address, subnet mask and default
gateway.

Note: Do not configure an IP address that is already in use in your network. This results to
a network IP address conflict and makes the NAS inaccessible.
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Table 4 NAS Starter Utility > Configuration > System Setting (continued)
LABEL

DESCRIPTION

Use from DHCP
server

Domain Name System (DNS) is for mapping a domain name to its corresponding IP
address and vice versa. Select this if the NAS is automatically given DNS information
from the ISP or a DHCP server in your network.

DNS

Domain Name System (DNS) is for mapping a domain name to its corresponding IP
address and vice versa.
Select Use from DHCP server if the NAS is automatically given DNS information from
the ISP or a DHCP server in your network.
Select Manually assign DNS server if you were given specific IP address(es) of the
DNS server(s). Enter the primary and secondary DNS in the corresponding fields.
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Accessing Your Cloud Remotely
Use the NAS to set up your own secure personal cloud. Keep your videos, photos, music, and files
safely at home and under your control. Access, share, and stream files from anywhere using your
PC, Mac computer, and mobile devices.

3.1 myZyXELCloud Service
Use the myZyXELCloud service at https://mycloud.zyxel.com to set up a free hostname like
name.zyxel.me and set the NAS to use it. This lets you easily access the NAS through the Internet.
The myZyXELcloud Web portal also lets you monitor the NAS’s health from anywhere.

3.2 ZyXEL Drive
Use the ZyXEL Drive app to stream or download photos, videos, and music to your Android or iOS
phone through the Internet. You can also upload files from your phone to the NAS.
After setting up the myZyXELCloud service, go to http://zyxel.to/zdrive to get the ZyXEL Drive app
for your Android or iOS phone.
Log in, sign-up, and start playing.

3.2.1 ZyXEL Drive Welcome
Community Sharing - Send invitation links to friends and family to conveniently share selected
NAS folders.
DirectConnect - Privately and securely access your NAS content from anywhere.
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Figure 14 ZyXEL Drive Welcome

3.2.2 NAS and File List
My own NAS - Access and share files from your own NAS.
Shared With Me - Access files on someone else’s NAS folder that they have shared with you.
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Figure 15 NAS and File List

3.2.3 Uploading and Media Streaming
Use ZyXEL Drive to upload photos and videos from your mobile device to the NAS. You can also
stream videos and music stored on the NAS.
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Figure 16 Uploading and Media Streaming
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zCloud
ZyXEL zCloud app lets you play your favorite multimedia files on the NAS on your big screen TV.
Use TV streaming devices such as Apple TV, Google Chromecast, Roku 3, and Amazon Fire TV; or
play files directly on smart TVs like those from Samsung and LG.
• Browse your media contents from your NAS directly on your Android or iOS device.
• View photos stored on your NAS with the app's built-in slideshow.
• Play music stored on your NAS.
• Watch videos stored on your NAS .
• Upload files from your Android device to your NAS.
• Upload photos and videos from your iOS device to your NAS.
• Browse and manage files stored on the NAS.
• Compatibility: Requires Android 4.0.3 or later or iOS 7 or 8.

4.1 Using zCloud
Install the zCloud app from Google Play or the Apple App store. Then tap the zCloud icon to open it.
Figure 17 zCloud Icon

The main menu displays.
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Figure 18 zCloud Android and iOS Main Menus

Find a NAS - use your NAS’s IP address and your user name and password to connect to it.
NAS540 - access the NAS’s default photo, music, and video shares. You can play, download, upload
and manage files.
Download - access and manage files downloaded from the NAS to your Android or iOS device and
manage download tasks.
Upload - view and manage upload tasks.

4.2 zCloud TV Streaming
Here is an example of the zCloud app letting you choose a player to use to stream a video on your
TV.
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Figure 19 zCloud Android and iOS TV Streaming
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Managing Users, Groups, and Shares
5.1 Managing Users, Groups, and Shares
• Use the Users screens (Chapter 22 on page 281) to create and manage administrator and user
accounts.
• Use the Groups screens (Chapter 23 on page 287) to create and manage groups of user
accounts. You can assign users to groups and grant individual groups access rights to specific
shares.
• Use the Shares screens (Chapter 24 on page 291) to manage access permissions mapped to
specific folders on a volume. A share is equivalent to the Windows concept of a shared folder.
Map a share to a network drive for easy and familiar file transfer for Windows users.
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Backing Up, Retrieving, and Syncing Files
6.1 About Backups
Backup before you need it. The NAS’s multiple backup methods make it easy to follow the 3-2-1
backup rule:
• At least 3 copies of data
• Stored on at least 2 different media
• With at least 1 copy off-site.

6.2 Managing a USB Device and USB Backups
Use the USB ports and SD card slot to copy or synchronize files between a connected USB or SD
device and the NAS. You can use the USB drive or SD card for off-site backups.
• Use the Copy/Sync button on the front panel to copy or synchronize files between a connected
USB or SD storage device and the NAS. See Section 17.10 on page 232 to configure the copy/
sync settings.
• Use the NAS’s Backup screens (Section 27.3 on page 321) to schedule backups of files and
folders on your NAS to a USB device or SD card. See Section 14.14.2 on page 194 for an
example.

6.3 Remote Backups
Use the NAS’s Backup screens (Section 27.3 on page 321) to schedule backups of files and folders
on your NAS to another ZyXEL NAS or a NAS using rsync.
• See Section 14.14.1 on page 192 for an example of backing up to a remote NAS.
• Use the Restore screens (Section 27.4 on page 332) to restore previous backups based on the
backup job. See Section 14.14.3 on page 196 for an example.
• If you deleted an archive backup job or the NAS or the RAID array containing the backup job
failed, you can restore by backup files. See Section 14.14.3 on page 196 for an example.

6.4 Internal Backups
Use the NAS’s Backup screens (Section 27.3 on page 321) to schedule backups of files and folders
on your NAS to another folder on the NAS.
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• See Section 14.14.2 on page 194 for an example of how to back up the NAS to another NAS.
• Use the Restore screens (Section 27.4 on page 332) to restore previous backups based on the
backup job. See Section 14.14.3 on page 196 for an example.

6.5 Cloud Backups
Use the NAS with cloud services for off-site backups and synchronization.
• Use Dropbox (Chapter 20 on page 274) to log the NAS into your Dropbox account to easily
move files to your NAS and have the NAS download *.torrent files.
• Use Memopal (Section 18.7 on page 254) to back up files on the NAS to your Memopal online
backup and storage account.

6.6 Synchronizing Files
Besides backups, the NAS also provides pure synchronization solutions.

Note: Synchronization is not backup. When you delete a file in one location,
synchronization deletes it in the other location. Do not store your only copy of a
document in a synchronized folder.
• Use the GoogleDriveClient package (Section 18.8 on page 256) to two-way synchronize local
NAS folders and Google Drive accounts. Changes in the Google Drive account appear in the local
sync folder and changes in the local sync folder appear in the Google Drive account.
• Use the ownCloud package (Section 18.6 on page 251) to host your own private cloud on the
NAS. The ownCloud package lets the NAS work as an ownCloud server so computers and mobile
devices using the ownCloud client can access, sync, and share files across devices.
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Web Configurator
7.1 Overview
This chapter describes how to access the NAS web configurator and provides an overview of its
screens. The web configurator is an HTML-based management interface that allows easy NAS setup
and management using an Internet browser.
Use Internet Explorer 11.0.9, Mozilla Firefox 31.0, Safari 5.1.7, Google Chrome 37.0.2, or later
versions of these browsers. The recommended screen resolution is 1440 by 900 pixels or higher.
In order to use the web configurator you need to allow:
• Web browser pop-up windows from your device. Web pop-up blocking is enabled by default in
Windows XP SP (Service Pack) 2.
• JavaScript (enabled by default).

7.2 Accessing the NAS Web Configurator
1

Make sure your NAS is properly connected and that your computer is in the same subnet as the
NAS (refer to the Quick Start Guide or the appendices).

2

Open your browser and type in the server name of the NAS. The default is “nas” followed by the
number of your model (“nas540” for example). Configure the server name of your NAS using the
Network Configuration screen (Section 2.3.5 on page 23) of the NAS Starter Utility.
Figure 20 NAS URL

3

The default username and password are “admin” and “1234” respectively. Enter your username and
password. See Chapter 22 on page 281 for how to create other user accounts. If you use the option
to stay logged in (assuming you do not log out), make sure you keep your computer secure from
unauthorized access. Click the arrow to log in. Logging in with a (non-administrator) user account
takes you to a different Desktop screen (see Section 7.3 on page 41 for details).
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Figure 21 NAS Login Screen

Make sure you have a backup of any existing data in the hard disk before
installing it in the NAS. Creating a volume formats the hard disk and
deletes all data in the process.
4

This screen displays if you have not created a volume yet. Click Create Volume to make a volume
or click the x to close the screen to go to the Desktop (Section 7.3 on page 41).
Figure 22 Welcome Screen

5

Select Create single volume on RAID for a simple set up. Go to Section 8.3.1 on page 55 for
details.
Select Create Multiple volumes on disk group to be able to create more than one storage
volume. Go to Section 8.3.3 on page 64 for details.
Figure 23 Create Volume
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If you choose Existing on disk group, you will go to the screens below after clicking Next.
Figure 24 Existing on Disk Group

If this is the first time the NAS has created a volume, it needs to reboot after the volume is created.
Click Yes to reboot or No to go to the Desktop.
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Figure 25 Reboot

7.3 Desktop
The Desktop screen displays after you log in. Hover your mouse over the heading bar icons to
display their names.
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Figure 26 Desktop (Administrator)
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Figure 27 Desktop (User)
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Note: The Web Configurator session automatically times out if left idle for 15 minutes.
Simply log back into the NAS if this happens to you.
1

Desktop - click this to minimize all windows so you can see the desktop. Click it again to restore
the windows to their previous state.
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2

Storage Manager- click this to open the storage configuration screens.

3

Control Panel - click this to open the control panel screens to configure the network setting and
upgrade firmware.

4

Status Center - click this to display NAS status information.

5

Help - click this to display the NAS’ embedded help system screens.

6

Administrator - click this to open the administrator configuration screens in a new tab.

7

File Browser - click this to see files in a tree-folder structure.

8

Photo - click this to view photos in the shares that publish photos.

9

Music - click this to view and play music files in the shares that publish music.

10 Video - click this to view and play video files in the shares that publish videos.
11 myZyXELcloud - click this to go to mycloud.zyxel.com to set up a free DDNS hostname for the
NAS so you can connect to it easily from the Internet.
12 User - click this to display the Logout link.
13 Eject NAS External Drives - click this to eject the connected external volumes.
14 Playzone Settings - click this to open the playzone configuration screen in a new tab.
15 Application Zone - click this to open the application zone in a new tab.

7.3.1 Status Zone
The Status Zone displays icons for various features you can access.
Table 5 Status Zone Icons
ICON

DESCRIPTION
Click System Status to open the Status Center screen. System Status displays the health
state of the NAS. A green circle with a check mark indicates healthy.

Web Sessions displays the current number of web sessions. Click this to go to the Network
screen for more details.
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Table 5 Status Zone Icons (continued)
ICON

DESCRIPTION
Click this to select widgets to show on the status bar.

Select or clear the widgets to show or hide on the Status bar. Click OK to save your changes or
Cancel to exit this screen without saving changes.
Click this to hide or show the status bar.

7.3.2 Grouping Icons
You can drag one icon to another one and make them a group as shown below.
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Figure 28 Grouping Icons

After the group is created, the default group name is NewGroup. You can click the icon to change
the group name. In the following example, the group name is changed to Media.
Figure 29 Change the Group Name

You can also move the group to another page by right-clicking the icon as shown next.
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Figure 30 Move the Group Location
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Storage Manager
8.1 Overview
This chapter displays the status of both internal and external storage, and introduces how to
configure disk groups, volumes, and iSCSI functions. Click Storage Manager on the Desktop to
go to the following screens in a new window.

8.2 Storage Manager Overview
Click Storage Manager on the Desktop to display the status of both internal and external
storage, and configure disk groups, volumes, and iSCSI functions.
The Storage Manager Overview screen displays the status, current storage configuration and
volume usage of internal volumes and capacity usage of external volumes.
Figure 31 Storage Manager > Overview > Internal Volumes
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Figure 32 Storage Manager > Overview > External Volumes

The following table describes the labels in this screen.
Table 6 Storage Manager > Overview
LABEL

DESCRIPTION

Storage

The circular icon displays the overall health state of the NAS.
A green circle with a check mark indicates healthy.
An orange circle with an exclamation mark indicates attention. This appears when
a volume or disk group is degraded. Click Repair to repair it.
An red circle with an exclamation mark indicates danger. This appears when a
volume or disk group is crashed. You cannot recover the volume.

Volume Usage

This shows how much of each volume is currently used.
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Table 6 Storage Manager > Overview (continued)
LABEL
Volume (for Internal
Volumes)

DESCRIPTION
This section shows the current storage usage for each volume built directly on top
of a RAID. These volumes have higher access performance than volumes on a disk
group but are less flexible in regards to size.
Details include the currently used percentage of the volume.
Shared Folder (Normal) - green on the circle represents the volume’s
percentage of used capacity in a healthy state.
LUN (Normal) - blue on the circle represents the iSCSI LUN’s percentage of used
capacity.
Degraded - orange on the circle represents the volume’s percentage of used
capacity in a degraded state. Degraded means one or more disks has failed but
you can still replace a faulty disk to recover the volume.
Crashed/Full - a red exclamation point represents the volume is in a down state.
Down means you cannot recover the volume. Full means the volume has run out
of space.
Available - gray on the circle represents the volume’s percentage of unused
capacity.
This section also displays the volume’s used capacity, and total capacity available.

Volume (for External
Volumes)

Details include the currently used percentage of the volume.
Used - green on the circle represents the volume’s percentage of used capacity in
a healthy state.
Full - a red exclamation point represents the volume has run out of space.
Unformatted - purple on the circle represents the connected USB storage device
is not formatted with a file system.
Unsupported - violet on the circle represents the connected USB storage device
uses a file system the NAS does not support.
Available - gray on the circle represents the volume’s percentage of unused
capacity.
This section also displays the volume’s used capacity, and total capacity available.

Volume on Disk Group

This section shows the current storage usage for each volume built on top of a
disk group. You can expand a volume’s size after creation if the disk group has
unallocated space. You can also expand a disk group by adding hard disks.

8.3 Internal Storage
A volume is a basic storage space on the NAS. To store data on the NAS, you must create at least
one volume. Your NAS supports the following:
• Internal volumes (built on the hard disks installed in the NAS)
• External volumes (built on the external storage devices attached to the NAS)
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Internal Volumes
Table 7 Internal Volumes
OPTION

DESCRIPTION

Volume

Allocates all the available space to the volume.
Provides better performance.

Volume on Disk
Group

Allows you to create multiple volumes on a disk group.
Allows you to customize the size of a volume.

RAID Types
The following table describes RAID types.

Note: RAID 5, RAID 6, RAID 10, and the hot spare option apply to 4-bay NAS devices.
Table 8 RAID Types
RAID
TYPE

NO. OF
HDD

NO. OF HDD
ALLOWED TO
FAIL

Basic

1

0

Use Basic with one disk. It has no fault
tolerance.

JBOD

2-4

0

Use JBOD with two or more disks for
maximum capacity. This is just a collection of
disks with no fault tolerance.

sum of HDD sizes

RAID 0

2-4

0

Use RAID 0 with two or four disks for
maximum speed and no fault tolerance.

sum of HDD sizes

RAID 1

2-4

(No. of HDD) -1

Use RAID 1 to create an exact copy of data
on one disk to a second disk. Use this with
two to four disks to mirror primary data to
another disk(s) with high performance.

Smallest HDD size

DESCRIPTION

CAPACITY
1 x (HDD size)

You can add a hot spare to a 2-disk RAID 1.
RAID 5

3-4

1

Use RAID 5 with three or four disks to
balance performance and hard disk capacity
usage with data protection in case of disk
failure.

RAID 6

4

2

RAID 10

4

1 HDD in each
RAID 1 group

(No. of HDD – 1) x
(smallest HDD
size)

You can add a hot spare to a 3-disk RAID 5.
Use RAID 6 with four disks for more data
protection in case of disk failure.

(No. of HDD – 2) x
(smallest HDD
size)

Use RAID 10 with four disks to get better
performance than RAID 6, with slightly less
data protection.

(No. of HDD / 2) x
(smallest HDD
size)

Repair Volumes or Disk Groups
If a hard disk in a RAID 1 with a hot spare or a RAID 5 with a hot spare fails, the NAS automatically
uses the hot spare to re-build the volume or disk group. Later you can replace the failed hard disk
and add the new disk as a hot spare.
A hard disk failure in a RAID 1, RAID 5, RAID 6, or RAID 10 degrades the volume or disk group.
Replace the failed disk and use the Internal Storage screen’s Repair link to repair the volume.
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Change RAID Type
You can change the following RAID types without losing stored data. This can help you manage your
storage capacity as you add more disks.
Table 9 Internal Volumes
RAID TYPE

WHAT YOU CAN CHANGE IT TO

Basic

RAID 1

RAID 1

RAID 1 with a hot spare or RAID 5

RAID 5

RAID 5 with a hot spare or RAID 6

Expand Volumes or Disk Groups
As your content grows, you can do the following to expand the storage capacity of a volume or disk
group without losing stored data.
Table 10 Expand Volumes and Disk Groups
EXPANSION
METHOD

DESCRIPTION

Using
unallocated disk
space

You can add more storage space to a volume if there is still some space unallocated on the
same disk group.

Adding disks

You can add one or more disks to a JBOD, RAID 1 or RAID 5.
The hard disk you want to add must have capacity equal to or greater than the smallest
disk in the volume or disk group.

Replacing with
larger disks

You can replace smaller disks in a RAID 1, RAID 5, or RAID 6 with larger disks.
Replace disks one-by-one.
Replace the smallest disk in the volume or disk group first.
After replacing a disk, you must use the Internal Storage screen’s Manage link to repair
the volume.
Wait for the repair process to complete before you replace another disk.

Use the Volume screen to configure and manage internal volumes. From the Internal Storage
screen, click Volume to open the screen as shown.
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Figure 33 Internal Storage Volume

The following table describes the labels in this screen.
Table 11 Internal Storage > Volume
LABEL

DESCRIPTION

Volume
Use this section to configure and manage volumes built on hard disks directly.
Create

Click this to format internal hard disks and create a new volume. All data on the disk(s)
will be lost.

Note: This button is not available while the NAS is creating, deleting, or changing the
RAID type of any volume or disk group.
A pop-up screen appears if all installed hard disks are used by other volumes or disk
groups. You will need to install another hard disk into the NAS if any disk tray is available
or remove unnecessary volumes or disk groups to release the storage space. Click OK to
close this screen.

No Disk in NAS
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Table 11 Internal Storage > Volume (continued)
LABEL

DESCRIPTION

Manage

Select a volume and click Manage to edit, repair or expand the volume.

Note: This button is available only when you can repair, expand or change RAID type.
Delete

Select a volume and click Delete to remove it.

Note: If you delete a volume, all data in the volume disks is erased.
Add Hot Spare

Select a RAID 1 or RAID 5 volume and click Add Hot Spare to add another disk as a
hot-spare (standby) to the RAID array. A pop-up screen displays.

Figure 34 Add Hot Spare

Select a disk from the drop-down list box and then click Apply.
See Table 8 on page 50 for more information about RAID.

Note: The capacity of the disk you are adding must be equal to or greater than the largest
disk in the RAID 1 or RAID 5 array.
Remove Hot Spare

Select a RAID 1 or RAID 5 volume and click Remove Hot Spare to remove the standby
drive from the RAID array.

Status

This field shows whether the volume is normal, degraded, crashed, Creating, Deleting,
Expanding, Repairing or Changing the RAID type.
Normal: A green circle represents a healthy volume.
Degraded: An orange circle represents a degraded RAID 1 volume.
Crashed: A red circle represents a down volume.
The following status also displays the percentage of an action has been completed.
Creating: The NAS’s percentage progress in creating the volume.
Deleting: The NAS’s percentage progress in deleting the volume.
Expanding: The NAS’s percentage progress in expanding the volume. For a RAID 1
volume, this also displays the percentage of resynchronizing the NAS has finished and
the evaluated remaining time.
Repairing: The NAS’s percentage progress in repairing the volume. For a RAID 1
volume, this also displays the percentage of resynchronizing the NAS has finished and
the evaluated remaining time.
Changing: The NAS’s percentage progress in changing the volume’s RAID type. For a
RAID 1 volume, this also displays the percentage of resynchronizing the NAS has
finished and the evaluated remaining time.

Volume Name

This field shows the name of the volume. Click the column’s heading cell to display an
arrow. Use the arrow to sort the table entries in ascending or descending order.

RAID Type

This field shows what type of disk storage technology (Basic, a RAID level or JBOD) a
volume uses.
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Table 11 Internal Storage > Volume (continued)
LABEL

DESCRIPTION

Usage

This field shows the percentage of the volume being used, the percentage that is
available, and the total disk size.

Hot Spare

This field shows the name of the standby disk if there is any for a RAID 1 or RAID 5
volume. Otherwise, it shows not supported.

Volume on Disk Group
Use this section to configure and manage volumes built on disk groups.
Create

Click this to format internal hard disks and create a new volume on a disk group. All data
on the disks will be lost.

Note: This button is unavailable when a volume or disk group is being created, deleted or
changing the RAID type.
Edit

Select a volume and click Edit to expand the volume’s capacity.

Delete

Select a volume and click Delete to remove it.

Note: If you delete a volume, all data in the volume disks is erased.
Note: Deleting a volume on a disk group here does not delete the corresponding disk
group. To delete a disk group, click Internal Storage > Disk Group.
Disk Group X

This field shows the name of the disk group, the percentage of the disk group size that is
available, the disk group size being used, and the total disk group size.

Status

This field shows whether the volume is normal, degraded, crashed, Creating, Deleting,
Expanding, Repairing or Changing the RAID type.
Normal: A green circle represents a healthy volume.
Degraded: An orange circle represents a degraded RAID 1 volume.
Crashed: A red circle represents a down volume.
The following status also displays the percentage of an action has been completed.
Creating: The NAS’s percentage progress in creating the volume.
Deleting: The NAS’s percentage progress in deleting the volume.
Expanding: The NAS’s percentage progress in expanding the volume. For a RAID 1
volume, this also displays the percentage of resynchronizing the NAS has finished and
the evaluated remaining time.
Repairing: The NAS’s percentage progress in repairing the volume. For a RAID 1
volume, this also displays the percentage of resynchronizing the NAS has finished and
the evaluated remaining time.
Changing: The NAS’s percentage progress in changing the volume’s RAID type. For a
RAID 1 volume, this also displays the percentage of resynchronizing the NAS has
finished and the evaluated remaining time.

Volume Name

This field shows the name of the volume. Click the column’s heading cell to display an
arrow. Use the arrow to sort the table entries in ascending or descending order.

File System

This field shows what file system the volume uses. At the time of writing, your NAS uses
the EXT4 file system for internal volumes.

Usage

This field shows the percentage of the volume being used, the percentage that is
available, and the total disk group size.
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8.3.1 Creating a Volume
Use the Create Volume screen to configure a volume directly on a disk/RAID, which has better
performance. Click Create in the Volume section of the Internal Storage > Volume screen to
open the screen as shown.

Note: Create a volume on a disk group instead if you want to have multiple volumes on a
disk. See Section 8.3.3 on page 64 for more information. Moreover, the maximum
size for one volume is 16TB.
Figure 35 Create Volume

The following table describes the labels in this screen.
Table 12 Create Volume
LABEL

DESCRIPTION

Step 1. Select Disks and RAID Type
Select disks

This section lists all available hard disks in the table and displays the disk trays where they
are currently installed on the graphic at the right.
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Table 12 Create Volume (continued)
LABEL

DESCRIPTION
Select one or more hard disks where you want to create a volume. Use the check box on
the top to select or unselect all entries in this column.

Disk Name

This field shows the name of the hard disk.

Size

This field shows the total disk size.

Model Name

This field shows the model of the hard disk.

Choose a RAID
type

Select a RAID type from the drop-down list box. The corresponding space allocations of
available size, data protection area, and wasted size display.
Use Basic with one disk.
Use JBOD with two or more disks for maximum capacity.
Use RAID 0 with two or four disks for maximum speed.
Use RAID 1 with two or more disks to mirror primary data to another disk(s) with high
performance.
Use RAID 5 with three or more disks to balance performance, hard disk capacity usage
with data protection in case of disk failure.
Use RAID 6 with four disks for more data protection in case of disk failure.
Use RAID 10 with four disks to get better performance than RAID 6, with slightly less data
protection.
See Table 8 on page 50 or Section 8.6 on page 98 for more information.

Note: Use the same capacity of hard disks for RAID 1, 5, 6, or 10 to avoid wasting space.
Back

This button is not available at this step.

Next

Click Next to go to the next step.

Cancel

Click Cancel to close the screen without saving any settings.

Step 2. Summary
Use this screen to review the settings you configured in the last step.
Disk Selected

This field displays the hard disks you have selected.

RAID Type

This field displays the type of RAID on which the volume will be built.

Volume Type

This field displays the type of the volume, Single volume on RAID (no disk group).

Volume Name

This field displays the name of the volume.

Volume
Capacity

This field displays the size of the volume.

Back

Click Back to go to the previous step.

Apply

Click Apply to save the settings.

Cancel

Click Cancel to close the screen without saving any settings.

8.3.2 Managing a Volume
Use the Manage Volume screen to repair, expand a volume or change the volume’s RAID type. In
the Internal Storage > Volume screen, select a volume and then click Manage in the Volume
section to open the screen as shown.
The available options vary depending on the conditions it matches. For example, the Repair RAID
option is available only when a degraded volume is selected.
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Figure 36 Manage Volume (Repair RAID)

A
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Figure 37 Manage Volume (Expand the volume by adding disk(s) )

A
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Figure 38 Manage Volume (Change RAID Type)
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Figure 39 Manage Volume (Change RAID Type)

A

Cloud Storage User’s Guide

60

Chapter 8 Storage Manager

The following table describes the labels in this screen.
Table 13 Manage Volume
LABEL

DESCRIPTION

Repair RAID

Select this to repair a degraded RAID volume.

Expand the
volume by
adding disk(s)

Select this to add one or more disks to a JBOD, RAID 1 or RAID 5 volume. You can add a
disk to increase an array’s capacity or to use as a hot-spare (standby). When you add a
disk to an existing array, you do not have to re-create shares, access rights and so on as
you would if you create a new volume.

Note: This option is available when a disk has not been allocated to any volume or disk group
yet.
Expand the
volume with
unallocated disk
space

Select this to add more storage space to a volume if there is still some space unallocated on
the same disk group. Select this if the NAS fails to expand a volume by adding disk(s) and
the final volume capacity is not as expected. For example, you want to expand a 1 TB RAID
1 volume by adding two more 1 TB disks. The volume size should be 2 TB after expansion,
however, you just see 1 TB. Use this option to fix the issue.

Change RAID
Type

Select this if you want to change the volume’s RAID type from Basic to RAID 1, RAID 1 to
RAID 5, or RAID 5 to RAID 6.

The following describes labels on the following screens after you select Repair RAID in this screen.
Step 1. Select Disks
A

This shows the name of the volume you have selected.

Status

This field displays the status of the volume.

RAID Type

This field displays the type of RAID on which the volume is built.

Disk Info
Status

This field displays the status of the disk.

Disk Name

This field displays the name of the disk.

Size

This field displays the total capacity of the disk.

Model Name

This field displays the model of the disk.

Select a disk to
replace the
failed one

This section lists all available hard disks in the table and displays the corresponding disk
tray of the disks you selected on the graphic at the right.
Select one or more hard disks for increasing the volume’s capacity. Use the check box on
the top to select or unselect all entries in this column.

Disk Name

This field shows the name of a hard disk.

Size

This field shows the total disk size.

Model Name

This field shows the model of the hard disk.

Expected
Capacity

This field shows the corresponding space allocations of available size, data protection area,
and wasted size according to your selections on hard disks above.

Back

Click Back to go to the previous step.

Next

Click Next to go to the next step.

Cancel

Click Cancel to close the screen without saving any settings.

Note: Use the same capacity of hard disks for RAID 1, 5, 6, or 10 to avoid wasting space.

Step 2. Summary
Use this screen to review the settings you configured in the last step.
Action

This field displays for what the configuration is.

Volume Name

This field displays the name of the volume.

Disk Selected

This field displays the hard disks you have selected.
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Table 13 Manage Volume (continued)
LABEL

DESCRIPTION

Volume
Capacity

This field displays the total available size of the volume.

Back

Click Back to go to the previous step.

Apply

Click Apply to save the settings.

Cancel

Click Cancel to close the screen without saving any settings.

The following describes labels on the following screens after you select Expand the volume by adding
disk(s) in this screen.
Step 1. Select Disks
A

This shows the name of the volume you have selected.

Status

This field displays the status of the volume.

RAID Type

This field displays the type of RAID on which the volume is built.

Disk Info
Status

This field displays the status of the disk.

Disk Name

This field displays the name of the disk.

Size

This field displays the total capacity of the disk.

Model Name

This field displays the model of the disk.

Select disk(s) to
add

This section lists all available hard disks in the table and displays the corresponding disk
tray of the disks you selected on the graphic at the right.
Select one or more hard disks for increasing the volume’s capacity. Use the check box on
the top to select or unselect all entries in this column.

Disk Name

This field shows the name of a hard disk.

Size

This field shows the total disk size.

Model Name

This field shows the model of the hard disk.

Expected
Capacity

This field shows the corresponding space allocations of available size, data protection area,
and wasted size according to your selections on hard disks above.

Note: Use the same capacity of hard disks for RAID 1, 5, 6, or 10 to avoid wasting space.
Back

Click Back to go to the previous step.

Next

Click Next to go to the next step.

Cancel

Click Cancel to close the screen without saving any settings.

Step 2. Summary
Use this screen to review the settings you configured in the last step.
Action

This field displays for what the configuration is.

Volume Name

This field displays the name of the volume.

Disk Selected

This field displays the hard disks you have selected.

Volume
Capacity

This field displays the total available size of the volume.

Back

Click Back to go to the previous step.

Apply

Click Apply to save the settings.

Cancel

Click Cancel to close the screen without saving any settings.

The following describes labels on the following screens after you select Expand the volume with
unallocated disk space in this screen.
Summary
Action

This field displays for what the configuration is.
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Table 13 Manage Volume (continued)
LABEL

DESCRIPTION

Volume Name

This field displays the name of the volume.

Volume
Capacity

This field displays the total available size of the volume.

Back

Click Back to go to the previous step.

Apply

Click Apply to save the settings.

Cancel

Click Cancel to close the screen without saving any settings.

The following describes labels on the following screens after you select Change RAID Type in this screen.
Step 1. Select Disks and RAID Type
A

This shows the name of the volume you have selected.

Status

This field displays the status of the volume.

RAID Type

This field displays the type of RAID on which the volume is built.

Disk Info
Status

This field displays the status of the disk.

Disk Name

This field displays the name of the disk.

Size

This field displays the total capacity of the disk.

Model Name

This field displays the model of the disk.

Select disk(s)

This section lists all available hard disks in the table and displays the corresponding disk
tray of the disks you selected on the graphic at the right.
Select one or more hard disks for changing the volume’s RAID type. Use the check box on
the top to select or unselect all entries in this column.

Disk Name

This field shows the name of a hard disk.

Size

This field shows the total disk size.

Model Name

This field shows the model of the hard disk.

Choose a RAID
type

Select a RAID type from the drop-down list box. The corresponding space allocations of
available size, data protection area, and wasted size display.
Use RAID 1 with two or four disks to mirror primary data to another disk(s) with high
performance.
Use RAID 5 with three or more disks to balance performance, hard disk capacity usage
with data protection in case of disk failure.
Use RAID 6 with four disks for more data protection in case of disk failure.
See Table 8 on page 50 or Section 8.6 on page 98 for more information.

Note: Use the same capacity of hard disks for RAID to avoid wasting space.
Back

Click Back to go to the previous step.

Next

Click Next to go to the next step.

Cancel

Click Cancel to close the screen without saving any settings.

Step 2. Summary
Use this screen to review the settings you configured in the last step.
Action

This field displays for what the configuration is.

Volume Name

This field displays the name of the volume.

Disk Selected

This field displays the hard disks you have selected.

RAID Type

This field displays the type of RAID on which the volume will be built.
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Table 13 Manage Volume (continued)
LABEL

DESCRIPTION

Volume
Capacity

This field displays the total size of the volume.

Back

Click Back to go to the previous step.

Apply

Click Apply to save the settings.

Cancel

Click Cancel to close the screen without saving any settings.

8.3.3 Creating a Volume on Disk Group
Use the Create Volume on Disk Group screen to configure a volume on an existing or new disk
group. Click Create in the Volume on Disk Group section of the Internal Storage > Volume
screen to open the screen as shown.

Note: It is suggested to create a volume directly on a disk instead of on a disk group if
high performance is important to you. See Section 8.3.1 on page 55 for more
information.
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Figure 40 Create Volume on an Existing Disk Group
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Figure 41 Create Volume on a New Disk Group
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The following table describes the labels in this screen.
Table 14 Create Volume on Disk Group
LABEL

DESCRIPTION

Choose an Action
Create Volume on

Select Existing on disk group and a disk group from the drop-down list box to
create a volume on the disk group. This option is available only when there is an
existing disk group available.
Select New disk group to create a disk group and then a volume on the disk
group.

The following fields describe the labels on the following screens if you select Existing on disk group on the
Choose an Action screen.
Step 1. Create Volume
Disk group information
Name

This field displays the name of the disk group.

Unallocated capacity

This field displays the percentage of the available size, the size in use, and total
size of the disk group.

Create Volume
Volume Name

This field displays the default name of the volume. You can also type a new name
for the volume.

Allocated Volume Size

This field displays the number of Gigabytes available on the volume by default.
You can change the size to allocate to this volume. Click MAX to allocate all
available size of the disk group to the volume.

Back

Click Back to go to the previous step.

Next

Click Next to go to the next step.

Cancel

Click Cancel to close the screen without saving any settings.

Step 2. Summery
Volume Type

This field displays the type of the volume, Multiple volumes on RAID (Disk
Group X) where Disk Group X is the disk group’s name.

Volume Name

This field displays the name of the volume.

Volume Capacity

This field displays the size of the volume.

Back

Click Back to go to the previous screen.

Next

Click Next to go to the next step.

Cancel

Click Cancel to close the screen without saving any settings.

The following fields describe the labels on the following screens after you select New disk group on the
Choose an Action screen.
Step 1. Select Disks and RAID Type
Select disks

This section lists all available hard disks in the table and displays the disk trays
they are currently installed on the graphic at the right.
Select one or more hard disks where you want to create a volume. Use the check
box on the top to select or unselect all entries in this column.

Disk Name

This field shows the name of the hard disk.

Size

This field shows the total disk size.

Model Name

This field shows the model of the hard disk.
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Table 14 Create Volume on Disk Group (continued)
LABEL

DESCRIPTION

Choose a RAID type

Select a RAID type from the drop-down list box. The corresponding space
allocations of available size, data protection area, and wasted size display.
Use Basic with one disk.
Use JBOD with two or more disks for maximum capacity.
Use RAID 0 with two or four disks for maximum speed.
Use RAID 1 with two or more disks to mirror primary data to another disk(s) with
high performance.
Use RAID 5 with three or more disks to balance performance, hard disk capacity
usage with data protection in case of disk failure.
Use RAID 6 with four disks for more data protection in case of disk failure.
Use RAID 10 with four disks to get better performance than RAID 6, with slightly
less data protection.
See Table 8 on page 50 or Section 8.6 on page 98 for more information.

Note: Use the same capacity of hard disks for RAID 1, 5, 6, or 10 to avoid wasting
space.
Back

Click Back to go to the previous screen.

Next

Click Next to go to the next step.

Cancel

Click Cancel to close the screen without saving any settings.

Step 2. Create Volume
Disk group information
Name

This field displays the name of the disk group.

Unallocated capacity

This field displays the percentage of the available size, the size in used, and total
size of the disk group.

Create Volume
Volume Name

This field displays the default name of the volume. You can also type a new name
for the volume.

Volume Capacity

This field displays the number of Gigabytes available on the volume by default.
You can set the size to allocate for this volume. Click MAX to allocate all available
capacity of the disk group to the volume.

Back

Click Back to go to the previous step.

Next

Click Next to go to the next step.

Cancel

Click Cancel to close the screen without saving any settings.

Step 3. Summary
Use this screen to review the settings you configured in the last step.
Disk Selected

This field displays the hard disk(s) on which the RAID array will be built.

RAID Type

This field displays the type of RAID on which the volume will be built.

Volume Type

This field displays the type of the volume, Multiple volumes on RAID (Disk
Group X) where Disk Group X is the disk group’s name.

Volume Name

This field displays the name of the volume.

Volume Capacity

This field displays the size of the volume.

Back

Click Back to go to the previous step.

Apply

Click Apply to save the settings.

Cancel

Click Cancel to close the screen without saving any settings.
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8.3.4 Editing a Volume on Disk Group
Use the Edit Volume on Disk Group screen to expand a volume’s capacity. In the Internal
Storage > Volume screen, select a volume and then click Edit in the Volume on Disk Group
section to open the screen as shown.
Figure 42 Edit Volume on Disk Group

The following table describes the labels in this screen.
Table 15 Edit Volume on Disk Group
LABEL

DESCRIPTION

Unallocated
capacity on Disk
Group X

This field displays the percentage of the disk group size unallocated to other volumes, the
size in use, and total size of the disk group.

Current volume
size

This field displays the total size of the volume, excluding the file system size.

New volume
size

This field displays the smallest size to which you can expand the volume (this includes the
volume’s current available size, file system size, and a minimum additional capacity for
expansion). You can enter a bigger number or click MAX to allocate all the rest of the space
in the disk group to the volume.

Apply

Click Apply to save the settings.

Cancel

Click Cancel to close the screen without saving any settings.

8.3.5 Disk Group
Use the Disk Group screen to configure and manage disk groups. From the Internal Storage
screen, click Disk Group to open the screen as shown.
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Figure 43 Disk Group

The following table describes the labels in this screen.
Table 16 Disk Group
LABEL

DESCRIPTION

Create

Click this to format internal hard disks and create a new disk group. All data on the disk(s)
will be lost.

Note: This button is not available while the NAS is creating, deleting, or changing the RAID
type of any volume or disk group.
Manage

Select a volume and click Manage to edit, repair, or expand the volume.

Note: This button is available only when you can repair, expand or change RAID type.
Delete

Select a disk group and click Delete to remove it.

Note: If you delete a disk group, all data in the disk group is erased.
Add Hot Spare

Select a RAID 1 or RAID 5 disk group and click Add Hot Spare to add another disk as a
hot-spare (standby) to the RAID array. See Section 8.6 on page 98 for more information.

Note: The capacity of the disk you are adding must be equal to or greater than the largest
disk in the RAID 1 or RAID 5 array.
Note: You need four hard disks installed to use RAID 5 with hotspare.
Remove Hot
Spare

Select a RAID 1 or RAID 5 disk group and click Remove Hot Spare to remove the standby
drive from the RAID array.
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Table 16 Disk Group (continued)
LABEL

DESCRIPTION

Disk Group X

This field shows the name of the disk group and whether it is normal, degraded, crashed,
Creating, Deleting, Expanding, Repairing or Changing the RAID type.
Normal: A green circle represents a healthy volume.
Degraded: An orange circle represents a degraded RAID 1 volume.
Crashed: A red circle represents a down volume.
The following status also displays the percentage of an action has been completed.
Creating: The NAS’s percentage progress in creating the volume.
Deleting: The NAS’s percentage progress in deleting the volume.
Expanding: The NAS’s percentage progress in expanding the volume. For a RAID 1
volume, this also displays the percentage of resynchronizing the NAS has finished and the
evaluated remaining time.
Repairing: The NAS’s percentage progress in repairing the volume. For a RAID 1 volume,
this also displays the percentage of resynchronizing the NAS has finished and the evaluated
remaining time.
Changing: The NAS’s percentage progress in changing the volume’s RAID type. For a
RAID 1 volume, this also displays the percentage of resynchronizing the NAS has finished
and the evaluated remaining time.

RAID Type

This field shows the type of the RAID over which this disk group is running.

Unallocated

This field shows the percentage of the disk group size that is available, the disk group size
being used, and the total disk group size.

Disk Info
Status

This field shows the status of the disk.

Disk Name

This field shows the name of the disk.

Size

This field shows the total size of the disk.

Model Name

This field shows the model of the disk.

Hot Spare
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Table 16 Disk Group (continued)
LABEL

DESCRIPTION

Status

This field shows the status of the hot-spare disk.
This field shows the name of the disk group and whether it is normal, degraded, crashed,
Creating, Deleting, Expanding, Repairing or Changing the RAID type.
Normal: A green circle represents a healthy volume.
Degraded: An orange circle represents a degraded RAID 1 volume.
Crashed: A red circle represents a down volume.
The following status also displays the percentage of an action has been completed.
Creating: The NAS’s percentage progress in creating the volume.
Deleting: The NAS’s percentage progress in deleting the volume.
Expanding: The NAS’s percentage progress in expanding the volume. For a RAID 1
volume, this also displays the percentage of resynchronizing the NAS has finished and the
evaluated remaining time.
Repairing: The NAS’s percentage progress in repairing the volume. For a RAID 1 volume,
this also displays the percentage of resynchronizing the NAS has finished and the evaluated
remaining time.
Changing: The NAS’s percentage progress in changing the volume’s RAID type. For a
RAID 1 volume, this also displays the percentage of resynchronizing the NAS has finished
and the evaluated remaining time.

Disk Name

This field shows the name of the hot-spare disk.

Size

This field shows the total size of the hot-spare disk.

Model Name

This field shows the model of the hot-spare disk.

8.3.5.1 Creating a Disk Group
Use the Create Disk Group screen to create a disk group. From the Storage > Disk Group
screen, click the Create button to open the screen as shown.
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Figure 44 Create Disk Group

Need Graphic!

The following table describes the labels in this screen.
Table 17 Create Disk Group
LABEL

DESCRIPTION

Step 1. Select Disks and RAID Type
Select disks

This section lists all available hard disks in the table and displays the disk trays the hard
disks are currently installed in the graphic on the right.
Select one or more hard disks where you want to create a disk group. Use the check box
on the top to select or unselect all entries in this column.

Disk Name

This field shows the name of the hard disk.

Size

This field shows the total disk size.

Model Name

This field shows the model of the hard disk.
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Table 17 Create Disk Group (continued)
LABEL

DESCRIPTION

Choose a RAID
type

Select a RAID type from the drop-down list box. The corresponding space allocations of
available size, data protection area, and wasted size display.
Use Basic with one disk.
Use JBOD with two or more disks for maximum capacity.
Use RAID 0 with two or four disks for maximum speed.
Use RAID 1 with two or more disks to mirror primary data to another disk(s) with high
performance.
Use RAID 5 with three or more disks to balance performance, hard disk capacity usage
with data protection in case of disk failure.
Use RAID 6 with four disks for more data protection in case of disk failure.
Use RAID 10 with four disks to get better performance than RAID 6, with slightly less
data protection.
See Table 8 on page 50 or Section 8.6 on page 98 for more information.

Note: Use the same capacity of hard disks for RAID 1, 5, 6, or 10 to avoid wasting space.
Back

Click Back to go to the previous screen.

Next

Click Next to go to the next step.

Cancel

Click Cancel to close the screen without saving any settings.

Step 2. Summary
Use this screen to review the settings you configured in the last step.
Disk Selected

This field displays the hard disk(s) on which the RAID array will be built.

RAID Type

This field displays the type of RAID on which the volume will be built.

Volume Type

This field displays the type of the volume, Multiple volumes on RAID (Disk Group X)
where Disk Group X is the disk group’s name.

Volume Capacity

This field displays the size of the volume.

Back

Click Back to go to the previous step.

Apply

Click Apply to save the settings.

Cancel

Click Cancel to close the screen without saving any settings.

8.3.6 Hard Disk
Use the Hard Disk screen to view all disk information. From the Storage screen, click Hard Disk
to open the screen as shown.
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Figure 45 Hard Disk

The following table describes the labels in this screen.
Table 18 Hard Disk
LABEL

DESCRIPTION

Status

This field shows the status of an installed hard disk.
Normal: A green circle displays. This represents the volume is functioning normally.
Crashed: A red circle displays. This represents the volume is down.

Disk Name

This field shows the name of the hard disk.

Used by

This field shows the name of a volume or disk group built on the hard disk if any. This field
also displays the RAID type the volume or disk group is using.

Size

This field shows the total size of the hard disk.

Model Name

This field shows the model of the hard disk.

Temperature

This field shows the temperature of the hard disk in degrees celsius (oC) and fahrenheit (oF).

8.3.6.1 S.M.A.R.T
Use the S.M.A.R.T screens to view hard disk health indicators. Self Monitoring, Analysis, and
Reporting Technology (S.M.A.R.T) detects and reports the reliability of hard disks using standard
indicators (called “attributes”), to help you anticipate possible disk failures.

Note: The available S.M.A.R.T information varies from one hard disk vendor to another.
From the Internal Storage > Hard Disk screen, select a disk and click S.M.A.R.T to open the
screen as shown.
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Figure 46 S.M.A.R.T Overview
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The following table describes the labels in this screen.
Table 19 S.M.A.R.T Overview
LABEL

DESCRIPTION

A

This shows the current status of the hard disk (a green circle with a check mark indicates
healthy).

B

This shows the overall health of the hard disk based on S.M.A.R.T diagnostics.

C

This shows the temperature of the hard disk in degrees celsius (oC) and fahrenheit (oF).

Performance

This shows your hard disk’s performance (Good or Bad).

Power_On_H
ours

This field shows the number of hours the hard disk has been in power-on state since it was
produced.

Spin_Retry_C
ount

This field shows the total number of spin start retry attempts. This is the number of attempts
to spin up to fully operational speed the hard drive has made when the first attempt did not
succeed. An increase in this value is an indicator of hard disk mechanical subsystem
problems.
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Table 19 S.M.A.R.T Overview (continued)
LABEL

DESCRIPTION

Reallocated_
Sector_Ct

This field shows the total number of reallocated sectors on the hard drive. When the hard
drive detects a read/write/verification error, it marks the sector as “reallocated” and transfers
the data to a specially reserved (spare) area. The process is also known as remapping with
“reallocated” sectors known as remaps. The more sectors the hard disk has to reallocate, the
slower read and write speeds become.

Command_
Timeout

This field shows the temperature of the hard disk in degrees celsius (oC) and fahrenheit (oF).

Model Family

This field shows the model family of the hard disk.

Device Model

This field shows the hard disk model number that uniquely identifies a hard disk.

Serial
Number

This field shows this individual hard disk’s serial number from the manufacturer.

LU WWN
Device Id

This field shows the hard disk’s Logical Unit World Wide Name Device Identifier.

Firmware
Version

This field shows the version number of the hard disk’s internal operating software.

User
Capacity

This field shows the hard disk’s usable size.

Sector Sizes

This field shows the sector size of the hard disk. A sector is the smallest physical storage unit
on a hard disk. Normally it is 512 bytes.

Rotation Rate

This field shows the rotational speed of the hard disk, measured in revolutions per minute
(rpm).

ATA Version

This field shows the hard disk’s Advanced Technology Attachment version number.

SATA Version

This field shows the hard disk’s Serial ATA (SATA) version number.

Local Time

This field shows the local time that the hard disk is using.

SMART
support

This field shows whether or not the hard disk is SMART-capable.

SMART
support

This field shows whether or not the hard disk has SMART monitoring turned on.

Close

Click this button to close the screen.

8.3.6.2 SMART Info
Use this screen to display more details information about the volume.
Click S.M.A.R.T Info in the S.M.A.R.T Overview screen to display the following.
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Figure 47 S.M.A.R.T Info

The following table describes the labels in this screen.
Table 20 S.M.A.R.T Info
LABEL

DESCRIPTION

ID

This is the identification number used to tag a hard disk attribute.
This is standard across all S.M.A.R.T-enabled storage devices. However it depends on the
storage vendor which attributes it will allow S.M.A.R.T to diagnose.

Attribute

This refers to an attribute of the hard disk that S.M.A.R.T can assess. Attributes describe
the hard disk’s physical state, performance, wear-and-tear, and so on.

Value

This is a value that corresponds to the Raw Data. Compare this with the Threshold.
S.M.A.R.T compresses the raw value(s) into a digit from 1 to 253, where 1 indicates the
worst scenario while 253 indicates the best scenario.
The values 100 or 200 usually represent the mean or normal value.

Worst

This is the lowest value attained by the hard disk since S.M.A.R.T started its assessment of
the hard disk.

Threshold

This is the attribute’s threshold value. If the attribute’s current normalized value is less
than or equal to the threshold, the attribute has failed. An attribute value close to or below
the threshold indicates the hard drive is no longer reliable.

Type

This shows S.M.A.R.T’s assessment of the hard disk.
Old_age indicates end-of-product life from old-age (normal wearing out) if the attribute
value is less than or equal to the threshold.
Pre-fail indicate imminent hard drive failure if the attribute value is less than or equal to
the threshold.
Note that just because an attribute is of the Pre-fail type does not mean your hard drive is
ready to fail. It only means this if the current normalized value of the attribute is less than
or equal to the threshold.
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Table 20 S.M.A.R.T Info
LABEL

DESCRIPTION

Updated

This indicates when the hard drive updates the value for this attribute.
•
•

When Failed

Always means the hard drive updates this attribute during normal operation and
during offline activities.
Offline means the hard drive only updates this attribute when no one is accessing the
hard drive.

This column indicates when (if ever) the attribute failed. An attribute has failed if the
normalized value is less than or equal to the threshold.
•
•
•

-: This displays if the attribute is not failing now and has never failed in the past.
FAILING_NOW: This displays if the attribute’s current normalized value is less than or
equal to the threshold.
In_the_past: This displays if the attribute’s current normalized value is greater than
the threshold but the worst recorded value is less than or equal to the threshold.

Raw Data

This is the attribute’s unprocessed raw data. These values show exact amounts of time or
numbers of attempts or errors. The meaning to the raw values is specific to the hard drive
manufacturer. Table 42 on page 156 has some information about whether a higher or lower
individual raw S.M.A.R.T. attribute value is better.

Close

Click this button to close the screen.

8.3.6.3 S.M.A.R.T Attributes
The following table describes some common S.M.A.R.T. attributes. If a higher or lower raw attribute
value is better, it is indicated in the BETTER column. Since S.M.A.R.T. attributes and their
definitions vary by manufacturer, refer to the hard drive manufacturer for details about the
attributes your hard drive supports.
Table 21 S.M.A.R.T. Attributes
ID

ATTRIBUTE
NAME

BETTER DESCRIPTION

01

Read Error Rate

Low

Shows the rate of hardware read errors. If this is not zero, there is a
problem with the disk surface or the read/write heads.

02

Throughput
Performance

High

This is the hard drive’s general (overall) throughput performance. A
decreasing value indicates a problem.

03

Spin-Up Time

Low

This is the average number of milliseconds the hard drive took for spindle
spin up (from zero RPM to fully operational).

04

Start/Stop Count

05

Reallocated
Sectors Count

06

Read Channel
Margin

07

Seek Error Rate

Low

This is the rate of the magnetic heads’ seek errors. A failure in the
mechanical positioning system, such as servo damage or a thermal
widening of the disk, results in seek errors. An increasing number of seek
errors indicate the condition of the disk surface and the mechanical
subsystem are worsening.

08

Seek Time
Performance

High

This is an average performance indicator for the seek operations of the
magnetic heads. Mechanical subsystem problems cause this value to
decrease.

The total number of spindle start and stop cycles.
Low

Total number of reallocated sectors on the hard drive. When the hard
drive detects a read/write/verification error, it marks the sector as
“reallocated” and transfers the data to a specially reserved (spare) area.
The process is also known as remapping with “reallocated” sectors known
as remaps. The more sectors the hard drive has to reallocate, the slower
read and write speeds become.
This is the margin of a channel when it reads data.
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Table 21 S.M.A.R.T. Attributes (continued)
ID

ATTRIBUTE
NAME

BETTER DESCRIPTION

09

Power-On Hours
(POH)

Low

This is how many hours the hard drive has been in a power-on state. The
raw value lists the total number of hours (or minutes, or seconds
depending on the manufacturer).

10

Spin Retry Count

Low

This is the total number of spin start retry attempts. This is the number of
attempts to spin up to fully operational speed the hard drive has made
when the first attempt did not succeed. An increase in this value is an
indicator of hard disk mechanical subsystem problems.

11

Recalibration
Retries

High

This is the number of times recalibration was requested when the first
attempt did not succeed. A decrease in this value is an indicator of hard
disk mechanical subsystem problems.

12

Device Power
Cycle Count

13

Soft Read Error
Rate

Low

This is the number of uncorrected read errors the hard drive has
reported. If this is not zero, back up your data.

190

Airflow
Temperature

Low

This indicates the temperature of the airflow measured by a Western
Digital hard drive.

190

Temperature
Difference from
100

High

This indicates the value of 100 - the temperature in degrees Celsius.
Manufacturers can set a minimum threshold that corresponds to a
maximum temperature.

191

G-sense error
rate

Low

This is the number of mistakes caused by impact loads.

192

Power-off Retract
Count

Low

This is how many times the heads are loaded off the media.

193

Load/Unload
Cycle

Low

This is the number of load and unload cycles into head landing zone
position.

This is the number of times the hard drive has gone through a full power
on and power off.

194

Temperature

Low

This is the hard drive’s internal temperature.

195

Hardware ECC
Recovered

High

This is the time between ECC (Error Correction Code)-corrected errors.

196

Reallocation
Event Count

Low

This is the total number of reallocation (remap) operations. The raw value
is the total attempts to move data from reallocated sectors to a spare
area. Successful and unsuccessful attempts are both included.

197

Current Pending
Sector Count

Low

This is the number of unstable sectors awaiting reallocation. If the sector
is later successfully written or read, this value decreases and reallocation
is not performed. Only failed write attempts cause a reallocation, not read
errors. This can be difficult to test since only direct I/O writes to the disk
cause reallocations, not cached writes.

198

Uncorrectable
Sector Count

Low

This is the number of errors reading or writing a sector that were not
correctable. An increase in this value is an indicator of disk surface
defects or mechanical subsystem problems.

199

UltraDMA CRC
Error Count

Low

This is the number of data transfer errors through the interface cable
according to the ICRC (Interface Cyclic Redundancy Check).

200

Write Error Rate
/ Multi-Zone
Error Rate

Low

This is the total number of errors in writing sectors.

201

Soft Read Error
Rate

Low

This is the number of read/write head off-track errors. If the value is not
zero, make a backup.

202

Data Address
Mark Errors

Low

This is the number of data address mark errors. This could also be a
different, manufacturer-specific attribute.

203

Run Out Cancel

Low

This is the number of ECC (Error Correction Code) errors.
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Table 21 S.M.A.R.T. Attributes (continued)
ATTRIBUTE
NAME

ID

BETTER DESCRIPTION

204

Soft ECC
Correction

Low

This is the number of errors corrected by software ECC (Error Correction
Code).

205

Thermal Asperity
Rate (TAR)

Low

This is the number of thermal asperity errors. Thermal asperity is a read
signal spike caused by sensor temperature rise due to touching the disk
surface or contaminant particles.

206

Flying Height

This is the height of the hard drive’s read/write heads above the disk
surface.

207

Spin High
Current

This is the quantity of high current used to spin up the drive.

208

Spin Buzz

This is the number of buzz routines to spin up the drive. When the arm
holding the read/write heads is stuck, the motor driving it tries to oscillate
the arm to free it. This causes an audible vibration.

209

Offline Seek
Performance

This is the hard drive’s seek performance during offline operations. Offline
operations are tests the drive does itself as opposed to those that an
external diagnostic tool has it do. Seek performance is how quickly the
drive moves from track to track.

220

Disk Shift

Low

This is how far the disk has moved relative to the spindle (this kind of
shift is usually due to shock).

221

G-Sense Error
Rate

Low

This is the number of errors that have resulted from external vibration
and shock.

222

Loaded Hours

This is how long the hard drive has operated under data load (this
requires movement of the magnetic head armature).

223

Load/Unload
Retry Count

This is how many time the magnetic head has changed position.

224

Load Friction

Low

This is resistance caused by friction in mechanical parts during operation.

225

Load/Unload
Cycle Count

Low

This is the total number of load cycles.

226

Load 'In'-time

227

Torque
Amplification
Count

Low

This is the number of attempts to compensate for variations in platter
speed.

228

Power-Off
Retract Cycle

Low

This is how many times the magnetic armature was automatically
retracted because the power was cut.

230

GMR Head
Amplitude

231

Temperature

240

Head Flying
Hours

250

Read Error Retry
Rate

This is the total time that the magnetic heads actuator has had a load
(not been in the parking area).

This is the amplitude of thrashing (or the distance of repetitive forward
and reverse head motion).
Low

This is the hard drive’s temperature.
This is the total time that the head has been positioning.

Low

This is the number of errors in reading from the disk.

8.4 iSCSI
The NAS supports the iSCSI (Internet Small Computer System Interface) standard and can serve as
an iSCSI target. When the iSCSI initiator is successfully connected to an iSCSI target over an IP
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network, data transmission and storage management can be processed through the network. In
other words, you can access and manage the target the same way as a locally attached drive.
In the following example, a branch office has a NAS named NAS1. You want to expand your data
storage capacity by accessing an iSCSI LUN (Logical Unit Number) volume called VOL1 on NAS1
over the Internet. Your computer is the iSCSI initiator and the NAS is the iSCSI target. When the
initiator is successfully connected to the target, your computer can use VOL1 on the NAS as its own
internal storage.
The configuration steps are as follows:
1

Create an iSCSI LUN Volume for the iSCSI target in NAS1.

2

Configure NAS1 as an iSCSI target.
Figure 48 iSCSI Connection Example

WAN

LAN
NAS1

I

T

VOL1

8.4.1 iSCSI LUNs Screens
This section enables you to create, up-map, and delete LUN volumes, as well as display the
volumes’ information. Click Storage Manager > iSCSI > iSCSI LUNs to display the following
screen.
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Figure 49 Storage Manager > iSCSI > iSCSI LUNs

The following table describes the labels in this screen.
Table 22 iSCSI > iSCSI LUNs
LABEL

DESCRIPTION

Create

Click this to create a new LUN on a volume.
See more details on Section 8.4.1.1 on page 84.

Un-map

Click this to open the following screen where you can up-map the LUN from the iSCSI target.

Key in UN-MAP and click Un-map to un-map the LUN from the iSCSI target. Click Cancel to
close this screen.
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Table 22 iSCSI > iSCSI LUNs (continued)
LABEL

DESCRIPTION

Delete

Click this to open the following screen where you can delete an existing LUN.

Key in DELETE and click Delete to remove an existing LUN. Click Cancel to close this screen.
Info

Click this item to check detailed information about the LUN.

Name - Displays the name of the LUN.
Location - Displays the name of the volume the LUN is located in.
Capacity - Displays the size of the LUN.
Allocation mode - Displays the allocation method the LUN applies.
Write Back - Displays whether the write back feature is enabled or disabled.
Mapped iSCSI Target - Displays the iSCSI target name the LUN is mapped to.

8.4.1.1 Creating a New LUN
A LUN is a unit of storage shared over iSCSI that can be mapped to an iSCSI target. You must
create an iSCSI LUN volume before you configure an iSCSI target for it. Click Create in the iSCSI
LUNs section of the Storage Manager > iSCSI screen to open the screens as shown.
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Figure 50 Creating a New LUN
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The following table describes the labels in these screens.
Table 23 Create a New LUN
LABEL

DESCRIPTION

Step 1. Set Up LUN Properties
Name

Type a LUN name in this field.

Note: Valid characters for the name are 0-9, a-z, and A-Z, and the maximum length is 30
characters. The “-” symbol is allowed as well, but cannot be the first character.
Location

Select a volume to create the LUN on.

Capacity

Type the size of the LUN in this field.

Allocation Mode

Select the method the NAS uses to allocate storage space to the LUN.
Thin provisioning - Allocate space only when an initiator writes data to it.
Instant allocation - Allocate the specified disk space to the LUN when you create the
LUN.

Enable Write Back

Select this option to increase the write performance. Write Back is a feature that collects
data in the hard disk’s cache memory first and permanently writes data into the hard
disk when the system is idle.

Note: It also creates a serious data integrity hazard. Data loss may occur if the NAS
experiences unexpected power loss before it has time to write the cached data to
the hard disk.
Next

Click Next to go to the next step.

Cancel

Click Cancel to close the screen without saving any settings.

Step 2. Summary
Use this screen to review the settings you configured in the last step.
Name

Displays the name of the LUN.

Location

Displays the name of the volume the LUN is located in.

Capacity

Displays the size of the LUN.

Allocation Mode

Displays the allocation method the LUN applies.

Write Back

Displays whether the Write Back feature is enabled or disabled.

Back

Click Back to go to the previous step.

Apply

Click Apply to save the settings.

Cancel

Click Cancel to close the screen without saving any settings.

8.4.2 iSCSI Targets Screens
The iSCSI target refers to the storage resource that is actually attached to the iSCSI storage
device. The initiator can manage the assigned disk volume on the iSCSI target over the Internet as
if it was the initiator’s internal storage volume.
iSCSI Targets allows you to create, edit, and delete an iSCSI target and map a target to an
existing LUN. Click Storage Manager > iSCSI > iSCSI Targets to show the following screen.
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Figure 51 Storage Manager > iSCSI > iSCSI Targets

The following table describes the labels in these screens.
Table 24 iSCSI > iSCSI Targets
LABEL

DESCRIPTION

Create

Click this to create a new iSCSI target.
See more details on Section 8.4.2.1 on page 88.

Edit

Click this to modify the configuration of the iSCSI target.
See more detailed on Section 8.4.2.2 on page 92.

Disable /
Enable

Disable - Click this to open the following screen where you can deactivate an existing target.

Key in DISABLE and click Disable to deactivate the target. Click Cancel to close this screen.
Enable - When the iSCSI is disabled, click Enable will activate the target.
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Table 24 iSCSI > iSCSI Targets (continued)
LABEL

DESCRIPTION

Delete

Click this to open the following screen where you can delete an existing target.

Key in DELETE and click Delete to remove an existing target. Click Cancel to close this
screen.
Info

Click this item to check detailed information about the target.

Name - Displays the created target name.
IQN - Displays the target’s iSCSI Qualified Name (IQN) format.
Allowed initiator (IQN) - Displays the allowed initiator’s iSCSI Qualified Name (IQN)
format.
Authentication - Displays the authentication method the target applies.
CRC Checksum - Displays the data transmission error detecting technique.
Maximum receive segment bytes - Displays the maximum data segment length in bytes
that the iSCSI target can receive.
Maximum send segment bytes - Displays the maximum data segment length in bytes that
the iSCSI target can send. This feature is for the NAS326 only.
Mapped iSCSI Luns - Displays the LUNs mapped with the target.

8.4.2.1 Creating a New Target
Click Create in the iSCSI Targets section of the Storage Manager > iSCSI screen to open the
screens as shown.
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Note: The NAS can create only 10 targets at maximum.
Figure 52 Creating a new LUN
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The following table describes the labels in these screens.
Table 25 Create a New Target
LABEL

DESCRIPTION

Step 1. Set Up Target Properties
Name

Enter the name of your iSCSI target.

Note: Valid characters for the name are 0-9, a-z, and A-Z, and the maximum length is 30
characters. The “-” symbol is allowed as well, but cannot be the first character.
IQN

The iSCSI Qualified Name (IQN) of the target is automatically generated after you enter
the target name.

Allowed initiator
(IQN)

The allowed initiator name is in the iSCSI Qualified Name (IQN) format.
To check the initiator name, open the iSCSI Initiator program on your computer. Select
the Configuration tab and you can see the initiator name as shown in the following
screen.

Note: If you use your computer as the iSCSI initiator, download and install the iSCSI
Initiator first. For example, use Microsoft iSCSI Software Initiator with a Microsoft
OS or globalSAN iSCSI Initiator with MAC OS.
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Table 25 Create a New Target (continued)
LABEL

DESCRIPTION

CHAP

If the iSCSI target has configured Challenge Handshake Authentication Protocol (CHAP)
here, the initiator needs to enter the secret before the initiator connects to the target.
The target will authenticate the initiator with the username and password (shared
secret). The connection fails if the username and password are not entered correctly.
Username - The user name is for the initiator to authenticate the initiator when
attempting connection.
Password - The password is for the target to authenticate the initiator when attempting
connection.
Confirm password - Re-type the password to make sure you entered it correctly.

Note: Valid characters for password are 0-9, a-z, and A-Z.
Enable mutual
CHAP

Mutual CHAP is a two-way authentication between the iSCSI initiator and the target. If
the initiator has configured CHAP authentication, the target must enter the secret that’s
set up by the initiator when attempting connection.
Select this check box to perform mutual CHAP on the target.
Username - The user name is for the initiator to authenticate the initiator when
attempting connection.
Password - The password is for the target to authenticate the initiator when attempting
connection.
Confirm password - Re-type the password to make sure you entered it correctly.

Note: Valid characters for password are 0-9, a-z, and A-Z.
Next

Click Next to go to the next step.

Cancel

Click Cancel to close the screen without saving any settings.

Step 2. Map iSCSI LUNs
Use this screen to map the iSCSI target to an existing LUN.

Note: One iSCSI target can map to several LUN, but one LUN can only map to one target.
Status

Displays the status of the iSCSI LUN(s).

LUN Name

Displays the LUN name.

Capacity

Displays the size of the iSCSI LUN(s).

Back

Click Back to go to the previous step.

Next

Click Next to go to the next step.

Cancel

Click Cancel to close the screen without saving any settings.

Step 3. Summary
Use this screen to review the settings you configured in the last step.
Name

Displays the iSCSI target name.

IQN

Displays the IQN of the target.

Allowed initiator
(IQN)

Displays the IQN of the allowed initiator.

Authentication

Displays the CHAP authentication method the target applies.

Mapped iSCSI
LUNs

Displays the iSCSI LUN the target maps to.

Back

Click Back to go to the previous step.
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Table 25 Create a New Target (continued)
LABEL

DESCRIPTION

Apply

Click Apply to save the settings.

Cancel

Click Cancel to close the screen without saving any settings.

8.4.2.2 Editing a Created Target
You can edit iSCSI target settings such as allowed initiator (IQN), CHAP, and CRC checksum after
you create a target. Click Storage Manager > iSCSI Targets and select Edit to open the
following screens.

Properties
The Properties screen allows you to edit the allowed initiator (IQN), CHAP authentication features
as shown in the following screen.
Figure 53 iSCSI Targets > Edit > Properties

Table 26 iSCSI Targets > Edit > Properties
LABEL

DESCRIPTION

Name

Displays the name of your iSCSI target.

IQN

Displays the iSCSI Qualified Name (IQN) of the target.

Allowed initiator
(IQN)

The allowed initiator name is in the iSCSI Qualified Name (IQN) format. You can connect
with another initiator by changing the allowed initiator IQN.
The system will display a prompt if you enter an invalid character or username of
unacceptable length in this field.
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Table 26 iSCSI Targets > Edit > Properties (continued)
LABEL

DESCRIPTION

CHAP

Username - The user name is for the initiator to authenticate the initiator when
attempting connection.
Password - The password is for the target to authenticate the initiator when attempting
connection.
Confirm password - Re-type the password to make sure you entered it correctly.

Note: Valid characters for password are 0-9, a-z, and A-Z, and the valid length is 12-14
characters.
Enable mutual
CHAP

Select this check box to perform mutual CHAP on the target.
Username - The user name is for the target to authenticate the initiator when
attempting connection.
Password - The password is for the target to authenticate the initiator when attempting
connection.
Confirm password - Re-type the password to make sure you entered it correctly.

Note: Valid characters for password are 0-9, a-z, and A-Z, and the valid length is 12-14
characters.
Apply

Click Apply to save your changes.

Cancel

Click Cancel to close the screen without saving any settings.

Map iSCSI LUNs
If the existing iSCSI target doesn’t map to any iSCSI LUN, go to Map iSCSI LUNs to configure the
mapping.
Figure 54 iSCSI Targets > Edit > Map iSCSI LUNs
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Table 27 iSCSI Targets > Edit > Map iSCSI LUNs
LABEL

DESCRIPTION

Status

Displays the status of the iSCSI LUN.

LUN Name

Displays the iSCSI LUN name.

Capacity

Displays the size of the iSCSI LUN.

Apply

Select the check to choose a LUN, and click Apply to save your changes.

Cancel

Click Cancel to close the screen without saving any settings.

Advanced
Go to Advanced screen for other configurations such as CRC checksum and maximum receive/
send segments.
Figure 55 iSCSI Targets > Edit > Advanced

Table 28 iSCSI Targets > Edit > Advanced
LABEL

DESCRIPTION

CRC checksum

Cyclic Redundancy Check (CRC) checksum is a technique for detecting data transmission
errors. It ensures correct data transmissions between the initiator and the target. If you
select the Data/Header Digest, the iSCSI initiator will be verified by these parameters
when transmitting data.

Data digest

Select the check box to enable data digest. The data digest protects the integrity of the
data.

Header digest

Select the check box to enable header digest. The header digest protects the integrity of
the header.

Maximum receive
segment bytes

Select the maximum receive segments allowed in bytes.
Four options are applied: 262144, 65536, 9182, 4092.
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Table 28 iSCSI Targets > Edit > Advanced (continued)
LABEL

DESCRIPTION

Maximum send
segment bytes

Select the maximum send segments allowed in bytes.
Four options are applied: 262144, 65536, 9182, 4092.

Note: This feature is for the NAS326 only.
Apply

Click Apply to save your changes.

Cancel

Click Cancel to close the screen without saving any settings.

8.5 External Storage
This chapter covers the management of external volumes and disks.
Use the External Storage screen (Section 8.5.2 on page 95) to display information on all external
volumes, configure volumes’ name and format volumes.

8.5.1 What You Need to Know About External Storage
Disk
USB-attached storage disks and SD cards are treated as external disks/volumes.

Volume
A volume is a storage area on a disk or disks. You can create volumes on SD cards or external disks
attached to the USB ports. You cannot spread a volume across external disks like you can with
internal disks.

8.5.2 External Storage Screen
Click Storage Manager > External Storage in the navigation panel to display the following
screen. Use this screen to format and edit external volumes on USB-connected storage and SD
cards.
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Figure 56 Storage Manager > External Storage

The following table describes the labels in this screen.
Table 29 Storage Manager > External Storage
LABEL

DESCRIPTION

Format

Click this to format the connected USB disk.
See Section 8.5.3 on page 97 for more information.

Edit

Click this to modify the volume name.

Volume name •
•
•
•

Type a volume name from 1 to 31 characters.
Acceptable characters are all alphanumeric characters and " " [spaces], "_"
[underscores], and "." [periods].
The first character must be alphanumeric (A-Z 0-9).
The last character cannot be a space " ".

Apply - Click this to save your change and rename the volume.
Cancel - Click this to exit this screen without saving changes.
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Table 29 Storage Manager > External Storage (continued)
LABEL

DESCRIPTION

Eject

Click this to eject the external volume.

Click Yes to eject the volume or No to exit this screen without saving changes.
Status

This field shows whether the volume is Normal, Unsupported, or Unformatted.
Normal means the USB connected device is functioning properly.
Unsupported means the USB connected device uses a file system the NAS does not
support.
Unformatted means the USB connected device is not formatted with a file system.

Note: There is no explicit message from CIFS that tells users their volume is degraded or
down.
Volume Name

This field displays the volume name. If the status is Unsupported or Unformatted, the
volume name displays “--”.

File System

This field displays the file system that an external (USB or SD) volume is using.

Disk(s)

This field shows to which USB port the disk is connected.

Capacity

This field shows total disk size, the percentage of the volume being used and the
percentage that is available. If the status is Unsupported, the capacity displays
“Unknown”. If the status is Unformatted, the capacity displays “--”.

Shared Folder

This field displays the folder that shares files. Roll your mouse over the link and click it to
display the files in the File Browser.

8.5.3 Format the Volume
This allows you to format the connected USB disk. Click External Storage > Format to show the
following screen.

Note: Formatting the disk will also delete all your data in the USB drive. If the connected
external volume has more than one partition, you can choose which partition you
want to format.
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Figure 57 External Storage > Format

The following table describes the labels in this screen.
Table 30 External Storage > Format
LABEL

DESCRIPTION

Volume Name

Type a volume name from 1 to 31 characters.
Acceptable characters are all alphanumeric characters and " " [spaces], "_" [underscores],
and "." [periods].
The first character must be alphanumeric (A-Z 0-9).
The last character cannot be a space " ".

File System

Select the file system you want the new volume to use.
Windows file systems
NTFS: Recommended.
FAT32: Newer, and more efficient than FAT16. Supports a volume size of up to 2 TB
(Tera Bytes) and individual file sizes of up to 4 GB.
exFAT: Designed to bridge the gap between the NTFS file system and the older FAT32
file system. It is a 64-bit file system that can store files over 4 GB.
Linux file systems
EXT2: Older file system.
EXT3: The same as EXT2, but adds a journaled file system and is more robust.
EXT4: Supports larger files and better performance than EXT3.

Apply

Click this to save your changes and format the disk.

Cancel

Click this to exit this screen without saving changes.

8.6 Technical Reference
This section contains background on JBOD and the RAID levels used on the NAS.

JBOD
• Minimum number of disks: 1
• Total capacity: Sum of the member disks
• Advantages: Maximum storage capacity, especially for disks of mixed sizes. Flexibility (you can
add disks to the JBOD
• Disadvantages: Not as fast or reliable as RAID.
JBOD allows you to combine multiple physical disk drives into a single virtual one, so they appear
as a single large disk. JBOD can be used to turn several different-sized drives into one big drive. For
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example, JBOD could convert 100 GB, 200 GB, 250 GB, and 500 GB drives into one large logical
drive of 1050 GB. Since data isn’t striped across disks, if one disk fails, you should just lose the
data on that disk (but you may lose data in the whole array depending on the nature of the disk
failure). You can add disks to the JBOD array later (using the Add disk to JBOD feature) and even
remove them so JBOD offers a lot of flexibility. However JBOD read performance is not as good as
RAID as only one disk can be read at a time and they must be read sequentially. The following
figure shows three disks in a single JBOD array. Data is not written across disks but written
sequentially to each disk until it’s full.
Table 31 JBOD
A1

B1

C1

A2

B2

C2

A3

B3

C3

A4

B4

C4

DISK 1

DISK 2

DISK 3

RAID 0
RAID 0 spreads data across two or more disks (data striping) with no mirroring nor parity for data
redundancy, so if one disk fails the entire array will be lost. The major benefit of RAID 0 is
performance. The following figure shows two disks in a single RAID 0 array. Data can be written and
read across disks simultaneously for faster performance.
Table 32 RAID 0
A1

A2

A3

A4

A5

A6

A7

A8

DISK 1

DISK 2

RAID 0 capacity is the size of the sum of the capacities of the disks in the RAID 0. For example, if
you have four disks of sizes 1 TB, 2 TB, 3 TB and 2 TB respectively in one RAID 0 array, then the
maximum capacity is 8 TB.
Typical applications for RAID 0 are non-critical data (or data that changes infrequently and is
backed up regularly) requiring high write speed such as audio, video, graphics, games and so on.

RAID 1
RAID 1 creates an exact copy (or mirror) of a set of data on another disk. This is useful when data
backup is more important than data capacity. The following figure shows two disks in a single RAID
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1 array with mirrored data. Data is duplicated across two disks, so if one disk fails, there is still a
copy of the data.
Table 33 RAID 1
A1

A1

A2

A2

A3

A3

A4

A4

DISK 1

DISK 2

As RAID 1 uses mirroring and duplexing, a RAID 1 array needs an even number of disks (two or
four for the NAS).
RAID 1 capacity is limited to the size of the smallest disk in the RAID array. For example, if you
have two disks of sizes 150 GB and 200 GB respectively in one RAID 1 array, then the maximum
capacity is 150 GB and the remaining space (50 GB) is unused.
Typical applications for RAID 1 are those requiring high fault tolerance without need of large
amounts of storage capacity or top performance, for example, accounting and financial data, small
database systems, and enterprise servers.

RAID 6
RAID 6 can tolerate two simultaneous drive failures by calculating dual distributed parity data on
striped data across disks. Dual parity provides extra data protection, however, it is slower to write
than most other RAID levels.
RAID 6 uses parity to store redundant data on space equal to the size of two disks for later data
recovery. Therefore, on a RAID 6 array, only 50% of the space is available as usable capacity. If you
have four disks of sizes 1TB, 1TB, 2TB, 2TB respectively in one RAID 6 array, then the maximum
capacity of the array is the capacity of the smallest drive (1TB, 1TB, 2TB, 2TB) * (Number of disks
- 2) = 1TB * (4-2) = 2TB. The remaining space (2 TB) is unused.
Table 34 RAID 6
RAID 6
A1

A2

AP

AQ

B1

BP

BQ

B2

CP

CQ

C1

C2

DQ

D1

D2

DP

DISK 1

DISK 2

DISK 3

DISK 4

Cloud Storage User’s Guide

100

Chapter 8 Storage Manager

RAID 10
RAID 10 (RAID 1+0) is a nested RAID where two RAID 1 arrays are stored on the physical disks
with a RAID 0 array on top. It is a stripe of mirrors. RAID 1 provides redundancy while RAID 0
boosts performance. The following figure shows two disks in two RAID 1 arrays. Data is duplicated
across two disks, so if one disk fails, there is still a copy of the data. These two arrays are
configured as a single RAID 0 array for faster performance.
Table 35 RAID 10
RAID 0
RAID 1

RAID 1

A1

A1

A2

A2

A3

A3

A4

A4

A5

A5

A6

A6

A7

A7

A8

A8

DISK 1

DISK 2

DISK 3

DISK 4

Typical applications for RAID 10 are those requiring both high performance and reliability such as
enterprise servers and high-end moderate-sized database systems. RAID 10 is often used in place
of RAID 1 or RAID 5 by those requiring higher performance. It may be used instead of RAID 1 for
applications requiring more capacity.

RAID 5
RAID 5 provides the best balance of capacity and performance while providing data redundancy. It
provides redundancy by striping data across three disks and keeps the parity information (AP) on
the fourth disk (in each stripe). In case of disk failure, data can be recovered from the surviving
disks using the parity information. When you replace the failed disk, the reconstructed data is
written onto the new disk. Re-synchronize the array to have it return to its original state. The
following example shows data stripped across three disks (A1 to A3 in the first strip for example)
with parity information (AP) on the fourth disk.
Table 36 RAID 5
A1

A2

A3

AP

B1

B2

BP

B3

C1

CP

C2

C3

DP

D1

D2

D3

DISK 1

DISK 2

DISK 3

DISK 4

The capacity of a RAID 5 array is the smallest disk in the RAID set multiplied by one less than the
number of disks in the RAID set. For example, if you have four disks of sizes 150 GB, 150 GB, 200
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GB and 250 GB respectively in one RAID 5 array, then the maximum capacity is 450 GB (3 * 150
GB, the smallest disk size) and the remaining space (300 GB) is unused.
Typical applications for RAID 10 are transaction processing, relational database applications,
enterprise resource planning and other business systems. For write-intensive applications, RAID 1
or RAID 1+0 are probably better choices, as the performance of RAID 5 will begin to substantially
decrease in a write-heavy environment.

Hot-spare
A RAID 1 or RAID 5 array with a hot-spare operates as a three-disk RAID 1 or RAID 5 array with the
fourth disk on standby. The standby disk automatically comes into play if a disk in the array fails.
The advantage of a hot-spare is that if a disk fails, then the array resynchronizes automatically with
the standby disk and operates at healthy array speed after the resynchronization.

Note: You need four hard disks installed to use RAID 10, RAID 5 or RAID 5 with hotspare.

RAID and Data Protection
If a hard disk fails and you’re using a RAID 1, RAID 10, or RAID 5 array then your data will still be
available (but at degraded speeds until you replace the hard disk that failed and re-synchronize the
array). However, RAID cannot protect against file corruption, virus attacks, files incorrectly deleted
or modified, or the NAS malfunctioning.
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Status Center
9.1 Overview
Status Center displays the system information or network connection status.

9.1.1 System Information
In the Desktop screen, click Status Center to display System Information for detailed NAS
status information.
Figure 58 Status Center > System Information

The following table describes the labels in this screen.
Table 37 Status Center > System Information
LABEL

DESCRIPTION

Refresh

Click the Refresh icon to update this display.

Status

The circular icon displays the health state of the NAS. A green circle with a check
mark indicates healthy.

Server Name

This displays the name which helps you find the NAS on the network.

Model Name

This displays which model this NAS device is.

Firmware Version

This is the NAS firmware version.
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Table 37 Status Center > System Information (continued)
LABEL

DESCRIPTION

LAN1 MAC Address

This displays the NAS’s unique physical hardware address (MAC) for the LAN1
Ethernet port. You need the MAC address to register the product at myZyXEL.com.
Customer support may also request it for troubleshooting purposes.

LAN2 MAC Address

This displays the NAS’s unique physical hardware address (MAC) for the LAN2
Ethernet port.

CPU

This displays a summary of CPU usage by all current processes.

Note: If too many users are using the NAS then the NAS may appear sluggish.
Memory

This shows how much of the NAS's total memory is being used.

Process Name

This displays the top 10 processes that occupy the most CPU usage.

CPU Usage

This displays a summary of CPU usage by all current processes.

Memory Usage

This shows how much of the NAS's total memory is being used.

CPU Temperature

This displays the temperature near the NAS’s CPU. The NAS generates an
emergency log if the temperature goes out of the normal operating range. If the
temperature goes even higher, the NAS shuts down automatically to avoid
damage from overheating. If the NAS overheats, make sure the fans are working
and it is in a well ventilated place.

Fan Speed

This is the RPM (Rotations Per Minute) of the NAS’s fans.

9.1.2 Network
The Network screen display the NAS connection status. From Status Center screen, click
Network to open the screen as shown.
Figure 59 Status Center > System Information
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The following table describes the labels in this screen.
Table 38 Status Center > Network
LABEL

DESCRIPTION

Type

Displays the type of the user account.

User

Displays the user name.

Groups

Displays the group the current user belongs to.

WAN/LAN

Displays whether the connection is from the WAN or the LAN.

Service Name

Displays the service name.

IP Address

Displays the IP address of the user.

Time

Displays the connection time.

Delete

Click this to disconnect the user.
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Control Panel
10.1 Overview
This chapter discusses the Control Panel screens. Use the Control Panel screens to configure
network settings and upload firmware.

10.2 What You Can Do
• Use the TCP/IP screen (Section 10.4 on page 107) to configure the NAS’s TCP/IP network
connection settings such as the teaming mode and IP addresses.
• Use the PPPoE screen (Section 10.4.2.2 on page 111) to configure PPPoE settings for a direct
Internet connection.
• Use the UPnP Port Mapping screen (Section 10.5 on page 113) to automatically configure your
Internet gateway’s firewall and Network Address Translation (NAT) to allow access to the NAS
from the Internet.
• Use the Terminal screen (Section 10.6 on page 119) to enable or disable Telnet and SSH access.
• Use the DyDNS screen (Section 10.7 on page 120) to configure the domain name settings of
your NAS.
• Use the FW Upgrade screen (Section 10.8 on page 122) to upload new firmware.

10.3 What You Need to Know
IP Address
The NAS needs an IP address to communicate with other devices on your network. The NAS can get
an IP address automatically if you have a device on your network that gives them out. Or you can
assign the NAS a static (fixed) IP address.

DNS Server Address
A DNS (Domain Name System) server maps domain names (like www.zyxel.com) to their
corresponding numerical IP addresses. This lets you use domain names to access web sites without
having to know their IP addresses. The NAS can receive the IP address of a DNS server
automatically (along with the NAS’s own IP address). You can also manually enter a DNS server IP
address in the NAS.
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PPPoE
Point-to-Point Protocol over Ethernet (PPPoE) allows the NAS to establish a direct Internet
connection if you do not have a router. PPPoE is a dial-up connection. You need a username and
password from your Internet Service Provider (ISP) to set up the connection.

10.4 TCP/IP Screens
Use the TCP/IP screens to have the NAS use a dynamic or static IP address, subnet mask, default
gateway, PPPoE and DNS servers, and to test the network connection.

10.4.1 Configuring General TCP/IP Settings
Click Control Panel > Network > TCP/IP > General Settings in the navigation panel to open
the following screen. This screen allows you to configure the default gateway and DNS server.

Note: If you change the NAS’s IP address, you need to log in again after you apply
changes.
Figure 60 Control Panel > Network > TCP/IP > General Settings
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The following table describes the labels in this screen
Table 39 Control Panel > Network > TCP/IP > General Settings
LABEL

DESCRIPTION

Default Gateway

Select the LAN interface to use as the default gateway.

DNS Server

DNS (Domain Name System) is for mapping a domain name to its corresponding IP
address and vice versa. If you have the IP address(es) of the DNS server(s), enter
them.

Automatically

Select the option to have the NAS get a DNS server address automatically.

Manually

Select this option to choose a static DNS server address. Type the DNS server IP
address(es) into the fields below.

Primary DNS
Server

Type a primary DNS server IP address.

Secondary DNS
Server

Type a secondary DNS server IP address.

Apply

Click this to save your TCP/IP configurations. After you click Apply, the NAS restarts.
Wait until you see the Login screen or until the NAS fully boots and then use the NAS
Starter Utility to rediscover it.

Reset

Click this to restore your previously saved settings.

10.4.2 Configuring Network Interface
Use the Network Interface screen to edit the IPv4 or IPv6 settings of LAN 1 and LAN 2, set up
port trunking, and configure PPPoE settings. Click Control Panel > Network > TCP/IP >
Network Interface in the navigation panel to open the following screen.
Figure 61 Control Panel > Network > TCP/IP > Network Interface
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The following table describes the labels in this screen.
Table 40 Control Panel > Network > TCP/IP > Network Interface
LABEL

DESCRIPTION

Status

Display data transmission rate and transmission system.

Interface

Display the interface name.

IP Settings

Display the IP settings (automatically or manually) of an interface.

IP Address

Display the IP address of an interface.

Subnet Mask

Display the subnet mask of an interface.

Create

Click it to open the following screen to set up a port trunking.
For adding a port trunking, see Section 10.4.2.1 on page 110.

Automatically

Select this option to have the interface get IP address information automatically.
If no IP address information is assigned, the NAS uses Auto-IP to assign itself an IP
address and subnet mask. For example, you could connect the NAS directly to your
computer. If the computer is also set to get an IP address automatically, the computer
and the NAS will choose addresses for themselves and be able to communicate.

Manually

Select this option for the interface to use fixed TCP/IP information. You must fill in the
following fields.
IP Address - Type an IP address in this field.
Subnet Mask - Type an IP subnet mask in this field.
Default Gateway - Type a default gateway address in this field.

Create
Cancel
Edit

Click this to save the settings and create a port trunk.
Click this to return to the previous screen without saving.
Click this to modify the IPv4 or IPv6 settings of LAN 1 and LAN 2.
For editing the PPPoE settings, see Section 10.4.2.2 on page 111.

IPv4 Settings

Click this to configure the following IPv4 settings.
Automatically - Select this option to have the interface get IP address information
automatically.
Manually - Select this option for the interface to use fixed TCP/IP information.
•
•
•

IPv6 Settings

IP Address - Type an IP address in this field.
Subnet Mask - Type an IP subnet mask in this field.
Default Gateway - Type a default gateway address in this field.

Click this to configure the following IPv6 settings.
Mode •
•
•

Select Auto to have the Device use the IPv6 prefix from the connected router’s
Router Advertisement (RA) to generate an IPv6 address.
Select Manual if you have a fixed IPv6 address assigned by your ISP.
Select Disable to not assign any IPv6 address for the NAS.

Address - Enter the IPv6 address assigned by your ISP.
Subnet prefix length - Enter the address prefix length to specify how many most
significant bits in an IPv6 address compose the network address. The range is 0 to 128
Default Gateway - Enter the IP address of the next-hop gateway. The gateway is a
router or switch on the same segment as your Device's interface(s). The gateway helps
forward packets to their destinations.
Apply

Click this to save your TCP/IP configurations. After you click Apply, the NAS restarts.
Wait until you see the Login screen or until the NAS fully boots and then use the NAS
Starter Utility to rediscover it.
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Table 40 Control Panel > Network > TCP/IP > Network Interface (continued)
LABEL

DESCRIPTION

Cancel

Click this to return to the previous screen without saving.

Remove

Click this to remove the port trunking.

Note: This button is available only when the port trunking is created.

10.4.2.1 Creating a Port Trunking
Link Aggregation: Link aggregation combines LAN1 and LAN2 into a single logical link with
greater bandwidth. Both interfaces use the same IP address and MAC address. It also includes fault
tolerance and load balancing. Connect LAN1 and LAN2 to the same Ethernet switch.
Figure 62 Link Aggregation

LAN1
LAN2

Use this screen to set up port trunking. Click Control Panel > Network > TCP/IP > Network
Interface, and then click Create.
Figure 63 Creating a Port Trunking
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The following table describes the labels in this screen.
Table 41 Control Panel > Network > TCP/IP > Network Interface > Create
LABEL

DESCRIPTION

Automatically

Select this option to have the interface get IP address information automatically.
If no IP address information is assigned, the NAS uses Auto-IP to assign itself an IP
address and subnet mask. For example, you could connect the NAS directly to your
computer. If the computer is also set to get an IP address automatically, the computer
and the NAS will choose addresses for themselves and be able to communicate.

Manually

Select this option for the interface to use fixed TCP/IP information. You must fill in the
following fields.
IP Address - Type an IP address in this field.
Subnet Mask - Type an IP subnet mask in this field.
Default Gateway - Type a default gateway address in this field.

Create

Click this to save the settings and create a port trunking.

Cancel

Click this to return to the previous screen without saving.

10.4.2.2 Configuring PPPoE Settings
Use this screen to configure PPPoE settings for a direct Internet connection. Select the ppp0
interface and then click Edit.
Figure 64 Control Panel > Network > TCP/IP > Network Interface > PPPoE

The following table describes the labels in this screen.
Table 42 Control Panel > Network > TCP/IP > Network Interface > PPPoE
LABEL

DESCRIPTION

Enable PPPoE to
directly connect
to the Internet

Select or clear this field to enable or disable PPPoE.

Username

Enter the username exactly as your ISP assigned. If assigned a name in the form
user@domain where domain identifies a service name, then enter both components
exactly as given.

Password

Enter the password associated with the username above.

Show password

Select this field to reveal the password hidden behind asterisks or clear this field to hide
the password.
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Table 42 Control Panel > Network > TCP/IP > Network Interface > PPPoE (continued)
LABEL

DESCRIPTION

Apply

Click this to save your changes.

Cancel

Click this to return to the previous screen without saving.

10.4.3 Configuring Web Configurator
Click Control Panel > Network > TCP/IP > Web Configurator to configure the port number of
HTTP and HTTPs.
Figure 65 Control Panel > Network > TCP/IP > Web Configurator

The following table describes the labels in this screen.
Table 43 Control Panel > Network > TCP/IP > Web Configurator
LABEL

DESCRIPTION

Port Number

Specify the port number of HTTP connection.

Note: The port number 8082 is reserved for media streaming.
Enable HTTPS
connection

Select or clear this field to enable or disable HTTPS connection.

Port Number

Specify the port number of HTTPS connection.

Allow only
HTTPS
connection

Select this field to allow connection to the Web Configurator via HTTPS only. Clear this
field to allow connection to the Web Configurator via both HTTP and HTTPS.

Apply

Click this to save your changes.

Cancel

Click this to return to the previous screen without saving.
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10.4.4 Configuring Network Diagnosis
Click Control Panel > Network > TCP/IP > Network Diagnosis to test the network connection
to a particular IP address or domain name.
Figure 66 Control Panel > Network > TCP/IP > Network Diagnosis

The following table describes the labels in this screen.
Table 44 Control Panel > Network > TCP/IP > Network Diagnosis
LABEL

DESCRIPTION

Host

Select a specific host to perform the diagnosis.

Ping

Click this to test the network connection.

Result

Displays whether or not the test received a response from the host.

10.5 UPnP Port Mapping Screen
Use UPnP (Universal Plug and Play) port mapping to allow access from the WAN to services you
select on the NAS. It is recommended that you place the NAS behind an Internet gateway firewall
device to protect the NAS from attacks from the Internet. Many such Internet gateways use UPnP
to simplify peer-to-peer network connectivity between devices. UPnP can automatically configure
the Internet gateway’s firewall and Network Address Translation (NAT) to allow access to the NAS
from the Internet.
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Figure 67 UPnP for FTP Access

192.168.1.20
a.b.c.d
TCP: 21

TCP: 21

In the above example, UPnP creates a firewall rule and NAT port forwarding mapping to send FTP
traffic (using TCP port number 21) from the public IP address a.b.c.d to the NAS’s private IP
address of 192.168.1.20.
Use the NAS’s UPnP Port Mapping screen to configure the UPnP settings your Internet gateway
uses to allow access from the WAN (Internet) to services you select on the NAS. You can also set
which port Internet users need to use in order to access a specific service on the NAS.

Note: To use UPnP port mapping, your Internet gateway must have UPnP enabled.
If your Internet gateway supports Port Address Translation (PAT is sometimes included with a port
forwarding feature), you can have the Internet users use a different TCP port number from the one
the NAS uses for the service.
Figure 68 UPnP Port Address Translation for FTP Example

192.168.1.20
a.b.c.d
TCP: 21

TCP: 2100

In the above example, the Internet gateway uses PAT to accept Internet user FTP sessions on port
2100, translate them to port 21, and forward them to the NAS.

10.5.1 UPnP and the NAS’s IP Address
It is recommended that the NAS use a static IP address (or a static DHCP IP address) if you will
allow access to the NAS from the Internet. The UPnP-created NAT mappings keep the IP address
the NAS had when you applied your settings in the UPnP Port Mapping screen. They do not
automatically update if the NAS’s IP address changes.

Note: WAN access stops working if the NAS’s IP address changes.
For example, if the NAS’s IP address was 192.168.1.33 when you applied the UPnP Port Mapping
screen’s settings and the NAS later gets a new IP address of 192.168.1.34 through DHCP, WAN
access stops working because the Internet gateway still tries to forward traffic to IP address
192.168.1.33. Since you can no longer access the NAS from the WAN, you would have to access
the NAS from the LAN and re-apply your UPnP Port Mapping screen settings to update the
Internet gateway’s UPnP port mappings.
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Figure 69 UPnP Using the Wrong IP Address

192.168.1.34
a.b.c.d

192.168.1.33

10.5.2 UPnP and Security
UPnP’s automated nature makes it easier to use than manually configuring firewall and NAT rules,
but it is also less secure. Using UPnP may make your network more susceptible to snooping and
hacking attacks.

10.5.3 The NAS’s Services and UPnP
This section introduces the NAS’s services which an Internet gateway can use UPnP to allow access
to and from the Internet.

CIFS (Windows File Sharing)
Common Internet File System (CIFS) is a standard protocol supported by most operating systems
in order to share files across the network. Using UPnP port mapping for CIFS allows users to
connect from the Internet and use programs like Windows Explorer to access the NAS’s shares to
copy files from the NAS, delete files on the NAS, or upload files to the NAS from the Internet.
If you configure UPnP port mapping to allow CIFS access from the WAN but cannot get it to work,
you may also have to configure the Internet gateway to also allow NetBIOS traffic. See Section 16.3
on page 205 for more on CIFS.

FTP
File Transfer Protocol is a standard file transfer service used on the Internet. Using UPnP port
mapping for FTP allows remote users to use FTP from the Internet to access the NAS’s shares. A
user with read and write access to a share can copy files from the share, delete files from the share,
or upload files to the share. See Section 17.4 on page 215 for more on FTP. If you use UPnP to allow
FTP access from the WAN, you may want to use a different WAN port number (instead of the default
of port 21) to make it more secure. Remember to tell the remote users to use the custom port
number when using FTP to access the NAS.

HTTP (Web Configurator)
You can use UPnP port mapping to allow access to the NAS’s management screens. If you use UPnP
to allow web configurator access from the WAN, you may want to use a different WAN port number
(instead of the default of port 80) to make it more secure. Remember to use the custom port
number when accessing the NAS’s web configurator from the Internet.
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HTTP (Web Published Shares)
This is the NAS’s web publishing feature that lets people access files using a web browser without
having to log into the Web Configurator. Use UPnP port mapping to allow access to these files from
the Internet without having to enter a user name or password. See Section 17.8 on page 230 for
more on web publishing.

10.5.4 UPnP Router
UPnP allows access to your NAS through a UPnP router. Click Network > UPnP Port Mapping >
UPnP Router to check if the NAS has found a UPnP router on the network.
Figure 70 Network > UPnP Port Mapping > UPnP Router

The following table describes the labels in this screen.
Table 45 Network > UPnP Port Mapping > UPnP Router
LABEL

DESCRIPTION

Status

Displays whether a UPnP router is found.

IP address

Displays the IP address of the UPnP router.

10.5.5 Configuring UPnP Port Mapping
Click Network > UPnP Port Mapping > UPnP Port Mapping to display the UPnP Port Mapping
screen.
Use this screen to set how the Internet gateway’s UPnP feature configure’s the Internet gateway’s
NAT IP address mapping and port mapping settings. These settings allow Internet users connected
to the Internet gateway’s WAN interface to access services on the NAS. You can set which port
Internet users need to use to access a specific service on the NAS.
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Figure 71 Network > UPnP Port Mapping > UPnP Port Mapping

The following table describes the labels in this screen.
Table 46 Network > UPnP Port Mapping > UPnP Port Mapping
LABEL

DESCRIPTION

Add

Click this to add a service and create a port mapping rule.
See more details on Section 10.5.5.1 on page 118.

Remove

Click this to open the following screen where you can remove a port mapping rule.

Click Yes to remove the selected port mapping rule or No to close this screen.
Enabled/Disabled

Use this to enable or disable a selected port mapping rule.

Status

Displays the status of the port mapping rule. A green circle indicates the port mapping rule
is enabled and you can access the service. A grey circle indicates the port mapping rule is
disabled. A red circle indicates the router’s settings failed to be changed. “-” indicates a
new mapping rule.

Service

This read-only field identifies a service on the NAS.

LAN Port

Displays the NAS’s internal port number for the service.
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Table 46 Network > UPnP Port Mapping > UPnP Port Mapping (continued)
LABEL

DESCRIPTION

WAN Port

When you enable one of the NAS’s services, specify the port number (1~65,535) Internet
uses need to use to connect to the Internet gateway’s WAN port in order to access the
service on the NAS. Whoever wants to access a service on the NAS from the Internet must
use this port number.
Make sure there is not another service using TCP protocol with the same port number.
If another device is using the same port (the Internet gateway has the same port number
mapped to another LAN IP address), the NAS overwrites it when you apply the setting and
WAN users can no longer access the other device.

Apply

Click Apply to save your changes back to the NAS.

Reset

Click Reset to begin configuring this screen afresh.

10.5.5.1 Adding a Port Mapping Rule
Some Internet gateways will delete all UPnP mappings after reboot. So if the Internet gateway
reboots, you may need to re-apply the UPnP port mapping again. Click UPnP Port Mapping > Add
to add NAS services and create port mapping rules.

Select the services you want to create port mapping rules for, and click Apply to add the services.
Click Cancel to close the screen without saving any setting.
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Note: The default of the WAN port for the newly created service displays -1. Specify the
port number from 1 to 65,535, or you cannot access that service from the Internet.

10.6 Terminal Screen
Use this screen to enable or disable Telnet and SSH (Secure SHell) access to the NAS.
Telnet or SSH access lets you use line commands to configure the NAS. Use these commands at
your own risk. The vendor takes no responsibility for any changes you make using the commands.
Click Control Panel > Network > Terminal in the navigation panel to open the following screen.
Figure 72 Control Panel > Network > Terminal
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The following table describes the labels in this screen.
Table 47 Control Panel > Network > Terminal
LABEL

DESCRIPTION

Enable Telnet
Service

Select this to enable Telnet access to the NAS. Clear it to not allow Telnet access to the
NAS.
To use Telnet, log in as “admin” or “root” and use the admin password.

Enable SSH
Service

Select this to enable SSH access to the NAS. Clear it to not allow SSH access to the NAS.

Apply

Click this to save your changes.

Reset

Click this to restore previously saved settings.

To use SSH, log in as “admin” or “root” and use the admin password.

10.7 DyDNS Screen
Use this to enable and configure Dynamic DNS.
Dynamic DNS (DyDNS) allows you to update your current dynamic IP address with a dynamic DNS
service so that anyone can contact you (such as through NetMeeting or CUSeeMe). You can also
access your FTP server or Web site on your own computer using a domain name (for instance
myhost.dhs.org, where myhost is a name of your choice) that will never change instead of using an
IP address that changes each time you reconnect. Your friends or relatives will always be able to
call you even if they don't know your IP address.
Click Control Panel > Network > DyDNS to open the following screen.
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Figure 73 Control Panel > Network > DyDNS

The following table describes the labels in this screen.
Table 48 Control Panel > Network > DyDNS
LABEL

DESCRIPTION

Enable DyDNS

Select this to use dynamic DNS.
You need to have registered a dynamic DNS account with a service provider such as
www.dyndns.org. The Dynamic DNS service provider will give you a password or key.

Service Provider

Select your Dynamic DNS service provider.

Hostname

Enter your host name provided by the Dynamic DNS service.

Username

Enter your user name for your DNS account.

Password

Enter the password assigned to your DNS account.

Status

This shows the DyDNS update result:
Disabled – You have manually disabled the DyDNS feature.
Error – An unrecoverable error (such as authentication error) occurred caused the NAS
to disable the DyDNS feature automatically.
Fail to update – A recoverable error (such as a temporary Internet disconnect)
occurred. The NAS will retry later.
Updated - The NAS updated the DyDNS server with the NAS’s public IP address.

Default Gateway

This shows with which public IP of interface the NAS updated the DyDNS server.

External Address

This shows the IP address of the NAS that can be accessed in the Wide Area Network
(WAN). Note that this is not assigned by the DyDNS server.

Apply

Click this to save your changes.

Reset

Click this to clear the fields.
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10.8 FW Upgrade Screen
Use this screen to upgrade the NAS firmware. You should first have downloaded the latest firmware
files from the ZyXEL website.

Do not turn off the NAS while it is upgrading the firmware or you may
render it unusable.
Click Control Panel > System > FW Upgrade to open the following screen. Latest Firmware
Check allows you to check the latest firmware version and perform the upgrade.
Figure 74 Control Panel > System > FW Upgrade > Latest Firmware Check

The following table describes the labels in this screen.
Table 49 Control Panel > System > FW Upgrade > Latest Firmware Check
LABEL

DESCRIPTION

Model Name

Displays the model name of you NAS

Current Firmware
Version

Displays the current firmware version of your NAS

Last Check

Displays the last checking time. If no, it is blank.

Check Now

Click this to check ZyXEL’s server for updated firmware.

Periodically Check for
Latest Firmware
Automatically

Select this to have the NAS regularly check ZyXEL’s server for updated firmware. The
NAS notifies you at login if a new firmware is available.

Status

Displays the firmware checking status or error messages. If there is no previous
checking information, it displays --.

Click Apply to save this field’s setting.
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Table 49 Control Panel > System > FW Upgrade > Latest Firmware Check (continued)
LABEL
Upgrade Now

Reset

DESCRIPTION
Click this to upload the new firmware. The NAS automatically restarts after you
upgrade. Wait until the restart completes before accessing the NAS again. If you
interrupt the upgrade, then the NAS may become unusable. See page 354 for your
model’s LED behavior during firmware upgrade.

Click this to refresh the screen.

You can also download the firmware from the ZyXEL website and upgrade the firmware manually.
Click Control Panel > System > Manual Firmware Upgrade to show the following screen.
Figure 75 Control Panel > System > FW Upgrade > Manual Firmware Upgrade

The following table describes the labels in this screen.
Table 50 Control Panel > System> Firmware > Manual Firmware Upgrade
LABEL

DESCRIPTION

Browse

Click this to find the file on your computer.

Note: You cannot choose a downgraded firmware. If you do, the screen will show: The
NAS firmware cannot be downgraded, please select a newer version of binary
(BIN) upgrade file from your computer.
Upgrade

Click this to upgrade the firmware after you find the file.
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Videos, Photos, Music, & File Browser
11.1 Overview
This chapter introduces the File Browser, Photo, Music, Video, Media Server and the iTunes
Server for sharing media files.

11.2 File Browser
Click File Browser on the Desktop to open the following screen in a new tab. Use the file browsing
screens to play, open, upload, and download files. A share is a set of user access permissions for a
specific folder on a volume (gives someone access to a folder). It is equivalent to the Windows
concept of a shared folder, but the access rights are independent of the folder (you configure the
share and the folder separately). You can map a share to a network drive for easy and familiar file
transfer for Windows users.
• A folder icon with a hand indicates a share.
• The administrator owns and manages the public shares.
• Double-click a media file to open it. Double-click other types of files to be able to save them.
• Click to the right of a file or folder name to select it.
• Use the [SHIFT] key to select a range of entries. Hold down the [CTRL] key to select multiple
individual entries.
• Drag and drop files to open a screen that lets you choose whether to copy or move them.
• You can upload files of up to 2 GB in size.
• You can download individual files of up to 4 GB in size with Mozilla Firefox and Internet Explorer 7
and later or up to 2 GB in size with Internet Explorer 6.
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Figure 76 File Browser

The following table describes the labels in this screen.
Table 51 File Browser
LABEL

DESCRIPTION

Up

Click this to go to the next higher layer in the share’s folder tree.

Name

This column identifies the names of folders and files in the share. Click a file’s file name to
open the file or save it to your computer. Click a folder’s name to display the folder’s contents.

Size

This column displays a file’s size in bytes.

Last Modified

This column displays the last time the file or folder was changed (in year-month-day
hour:minute:second format).

Create New
Folder

Click this to open the following screen where you can create a new folder within the share.

Specify a name to identify the folder. See Section 11.2.2 on page 128 for more information
on folder names. Click Apply to create a folder or click Cancel to exit this screen.
Configure
Share

Select a share and click this link to open a screen where you can see and configure share
management details.

Delete

Select a file or folder and click this to delete it from the NAS.

Rename

Select a file or folder and click this to change its name.
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Table 51 File Browser (continued)
LABEL

DESCRIPTION

Upload

Click this to open the following screen where you can add files to the share.

Use the Browse button to locate your file/s and click Apply to upload the file. Click Cancel to
close this screen.

Note: Do not refresh the screen while an upload is going on.
Download

Select a file and click this to save the file to your computer.

Note: Do not refresh the screen while a download is going on.
Compress

Select files or folders and click this to compress them into a zip file.

Decompress

Select a zipped file and click this to create a folder named after the zip file and save the
decompressed files into the folder.

Restore

When you are in a recycle bin folder, select a folder or file and click this to restore it.

Refresh

Click this to update the information displayed in the screen.

Note: Do not refresh the screen while an upload or download is in progress.

11.2.1 Configure Share Screen
In the File Browser screen, select a share and click Configure Share to open the following screen
where you can see and configure share management details.
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Figure 77 File Browser > Configure Share

The following table describes the labels in the this screen.
Table 52 File Browser > Configure Share
LABEL

DESCRIPTION

Share Name

Configure a name to identify this share. Type a share name from 1 to 239 single-byte (no
Chinese characters allowed for example) ASCII characters. The name cannot be the
same as another existing local share. See Section 11.2.2 on page 128 for more
information on share names. This is not configurable for the NAS’s default admin, music,
photo, public, and video shares.

Volume

This shows the volume the share is on. It is read-only.

Make this share
owned by

Select the administrator or user account that is to own (manage) this share. The share
owner controls access rights to the share. This is not configurable for the NAS’s default
admin and public shares.

Enable This Share

Select this option to allow users to access this share. When this option is not selected,
you cannot see and access this share.

Enable Recycle Bin

Select this option to keep deleted items in a recycle bin. When you delete an item, a
recycle folder is created within the share, and the deleted item is stored in the recycle
bin. Later if you want to retrieve a deleted item, you can select the item from the recycle
folder and move/copy the item to another share.

Publish this share
to Media Server

Select this option to make the share’s files available to media clients. When you publish a
share, you can also select whether or not to publish music tracks, photos, and videos.

Publish this share
to Web

Select this option to let people use a web browser to access this share’s files without
logging into the Web Configurator screens.

Share Access

Select who can access the files in the share and how much access they are to be given. If
you publish the share to the media server or the web, all users will have at least readonly access to the share, regardless of what you configure here.
Select Keep it private to owner to allow only the share owner to read files in the share,
delete files in the share and save files to the share.
Select Make it public to allow anyone (with or without a user account on the NAS) to
read files in the share, delete files in the share and save files to the share.
Select Advanced to select which individual users can read the share’s files, which users
can delete the share’s files, and which users are blocked from doing either.

Apply

Click this to save your changes.

Cancel

Click this to return to the previous screen without saving.
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11.2.2 Share and Folder Names
The name can only contain the following characters:
• Alphanumeric (A-z, 0-9) and Unicode.
The NAS allows FTP access to shares, folders or files with names encoded in the UTF-8 (8-bit
UCS/Unicode Transformation Format) format. So your FTP client must support UTF-8 in order to
access shares, folders or files on the NAS with Unicode names.
• Spaces
• _ [underscores]
• . [periods]
• - [dashes]
Other limitations include:
• All leading and trailing spaces are removed automatically.
• Multiple spaces within names are converted to a single space.
• Share names must be unique (they cannot be the same as other share names).
• The NAS creates automatic volume names for external (USB) disk volumes. These are a type of
share, so the share name you configure cannot conflict with the external (USB) disk volume
names. “ExtVol1” or “ExtVol2” are examples of external (USB) disk volume names.
• Folder names must be unique (they cannot be the same as other folder names).
• The minimum character length of a name is one character, that is a name cannot be blank.
• The maximum character length of share name is 239 characters.
• Unicode is supported for share names, although your FTP client must support UTF-8. Full support
should be available in all Windows versions after Windows 2000.

11.3 Photo
Click the Photo icon on the Desktop to open the photo folder in a new tab. Double-click the photo
folder to view photos in the shares that publish photos. The following figures show the files as
thumbnail and list views of files.
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Figure 78 Photo (Thumbnail)

A

C
Figure 79 Photo (List)

B

Cloud Storage User’s Guide

129

Chapter 11 Videos, Photos, Music, & File Browser

The following table describes the labels in this screen.
Table 53 Photo Screen
LABEL

DESCRIPTION

ZyXEL

The path of the current view.
Click an underlined link to go to that location in the path.
Music, Photo, or Video indicates the category of files.

Search

Use this to look for a file by name.

A

View files. Double-click an item to play it. You can also select check boxes for multiple items
when you display the files as a list.

B

The current page and total number of pages displays when a category has multiple pages of
entries. Click an arrow or type a number to go to another page of entries.

C

Select a view type for displaying folders and files:
Date - Sort photos by date.
All - Display all of the category’s files.
Folder - List the folders containing files.

Thumbnail

Click this to view the files as thumbnails.

List

Click this to view the files as a list.

Slideshow

Click this to display files as a slideshow.

Refresh

Click this to update the display in the screen.

11.3.1 Exif and Google Maps (Photos)
Double-click a photo file to display it. Thumbnails of all photos in the view display across the bottom
of the screen. Click a photo’s EXIF button to display or hide the photo’s Exchangeable image file
format (Exif) data.
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Figure 80 Exif Information

If a photo’s Exif data includes GPS location data, click the latitude or longitude link to display the
location in Google Maps. Click Clear to delete the markers of other photos and only display the
current photo’s marker.
Figure 81 Google Maps

11.3.2 Slideshow (Photos)
In a Photo menu click the SlideShow button to display the menu’s files as a slideshow. Move your
cursor over the slideshow’s screen to display full screen, previous, pause, and next buttons for
controlling the slideshow.
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Note: Your browser must have the Flash Player plug-in installed to view slideshows.
Figure 82 Slideshow

11.4 Music
Click the Music icon on the Desktop to open the music folder in a new tab. Double-click the music
folder to view and play music files in the shares that publish photos. The following figures show
thumbnail and list views of files.
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Figure 83 Music (Thumbnail)

A

C
Figure 84 Music (List)

A

B
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This table describes common labels in the Playzone media server screens. Not every item displays
in every screen.
Table 54 Music Screen
LABEL

DESCRIPTION

ZyXEL

The path of the current view.
Click an underlined link to go to that location in the path.
Music, Photo, or Video indicates the category of files.

Search

Use this to look for a file by name.

A

View files. Double-click an item to play it. You can also select check boxes for multiple items
when you display the files as a list.

B

The current page and total number of pages displays when a category has multiple pages of
entries. Click an arrow or type a number to go to another page of entries.

C

Select a view type for displaying folders and files:
Artist - Sort music by artist.
All - Display all of the category’s files.
Folder - List the folders containing music files.
Current Playlist - Show the playing and queued songs.

Thumbnail

Click this to view the files as thumbnails.

List

Click this to view the files as a list.

Play

Click this to play the currently selected file. You can also double-click a file to play it.

Add to Current
Playlist

Click this to add the selected music file to the currently playing playlist.

Refresh

Click this to update the display in the screen.

Now Playing

This link is available when a song is playing. Click it to see details about the song that is
currently playing.

11.4.1 Now Playing (Music)
A Now Playing link displays when a song is playing. Click it to display a panel like the following.
This screen displays the name of the current song and it’s play progress and lets you control the
playback.
Figure 85 Now Playing

11.5 Video
Click the Video icon on the Desktop to open the video folder in a new tab. Double-click the video
folder to view and play video files in the shares that publish videos. The following figures show the
thumbnail and list views of files.
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Figure 86 Video (Thumbnail)

A

C
Figure 87 Video (List)

A

B
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The following table describes the labels in this screen.
Table 55 Video Screen
LABEL

DESCRIPTION

ZyXEL

The path of the current view.
Click an underlined link to go to that location in the path.
Music, Photo, or Video indicates the category of files.

Search

Use this to look for a file by name.

A

View files. Double-click an item to play it. You can also select check boxes for multiple items
when you display the files as a list.

B

The current page and total number of pages displays when a category has multiple pages of
entries. Click an arrow or type a number to go to another page of entries.

C

Select a view type for displaying folders and files:
All - Display all of the category’s files.
Folder - List the folders containing music files.

Thumbnail

Click this to view the files as thumbnails.

List

Click this to view the files as a list.

Play

Click this to play the currently selected file. You can also double-click a file to play it.

Refresh

Click this to update the display in the screen.

11.6 Playzone Settings
The Playzone Settings screen is only available with user accounts. Click Playzone Settings to
open the following screen. Use this screen to change general Playzone screen settings and account
passwords.
Figure 88 Playzone Settings
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The following table describes the labels in this screen.
Table 56 Playzone Settings
LABEL

DESCRIPTION

VLC

This field displays you already have VLC player installed.

Quicktime

This field displays you already have Quicktime installed.

Double Click Behavior
Setting

Select Replace current playlist and start to play to have double clicking a song
cause the NAS to immediately stop any currently playing song and start playing the
double-clicked song.
Select Append to current playlist to have double clicking a song add a song to the
end of the current playlist.

Slide Effect

Enable the Ken Burns effect to have the NAS automatically pan and zoom photos in
slideshows. Disable it to display photos in slideshows normally.

Slide Interval

Select how long to display each image in a slideshow before changing to the next.

Video Playback

Select Play Next to play the rest of the video files in a folder. So for example, a folder
has video files 1~10 and you play video 3. When video 3 finishes the device continues
playing the rest of the videos in the folder (4~10). It does not loop back and play
videos 1 and 2.

Account Name

Type the user name of the account for which you want to change the password.

Old Password

Type the user’s current password.

New Password

Create a new password for the user. You can type from one to 14 single-byte (no
Chinese characters allowed for example) ASCII characters.

Password (Confirm)

You must type the exact same password that you just typed in the above field.

Language

Select the web configurator language from the drop-down list box.

Apply

Click this to save your changes.

Reset

Click this to refresh the screen.

Cancel

Click this to exit the screen without saving your changes.
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11.7 Application Zone
Normal users can click Application Zone to go to the management page of installed, non-built-in
packages.
Figure 89 Application Zone

The following table describes the labels in the this screen.
Table 57 Application Zone
LABEL

DESCRIPTION

Name

This is the name of the application.

Version

This is the version number of the item.

Description

This is a brief description of the application.

Management
Page

Click this link to go the application’s management page where you can configure settings for
it.

Refresh

Update the list of applications in the screen.

11.8 Media Server
Use the Media Server screens to enable or disable the sharing of media files with media clients
and select which shares to share. See Section 17.5 on page 216 for details.

11.9 iTunes Server
Use the iTunes server to share media files with iTunes users on your network. See Section 17.6 on
page 218 for details.
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Administrator
12.1 Overview
This chapter describes how to access the administrator screens and provides an overview of its
screens.

12.2 Administrator Screens
The Desktop screen displays an Administrator icon when you log in with an administrator
account. Click it to open the administrator configuration screens in a new tab. The Status screen
displays first. See Chapter 15 on page 203 for more information about the Status screen.
Figure 90 Status

1

2

3

4
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12.2.1 Global Administrator Icons
The icons and language label at the top-right of the screen (1) are visible from most of the
administrator screens. The following table describes the ‘global’ icons and labels.
Table 58 Global Labels and Icons
LABEL/ICON

DESCRIPTION

Language

Select the web configurator language from the drop-down list box.

Help

Click this to open Web Help for the current screen.

Home

Click this to go to the Desktop screen.

12.2.2 Navigation Panel
The navigation panel on the left of the Web Configurator screen (2) contains screen links. Click a
link to display sub-links. There are no sub-links for the Status screen. Certain screens also contain
hyper links that allow you to jump to another screen.
The following table describes the navigation panel screens.
Table 59 Screens Summary
LINK

SCREEN

Status
System
Setting

FUNCTION
This screen shows system information, the status of the volumes, and the
users who are currently using the NAS.

Packages

The NAS can download multiple packages/files at once and automatically goes
through all the installation steps.

Server Name

Specify the NAS’s server name and workgroup name.

Date / Time

Chose a time zone and/or allow the NAS to synchronize with a time server.
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Table 59 Screens Summary (continued)
LINK

SCREEN

FUNCTION

Applications

FTP Server

Enable FTP file transfer to/from the NAS, set the number of FTP connections
allowed, an FTP idle timeout, and the character set.

Media Server

Enable or disable the sharing of media files and select which shares to share.

iTunes Server

Use the iTunes server to share media files with iTunes users on your network.

Download
Service

Have the NAS handle large file downloads.

Web
Publishing

Let people use a web browser to access files in shares without logging into the
Web Configurator.

Print Server

View and manage the NAS’s list of printers and print jobs.

Copy/Sync
Button

Copy or synchronize files between a USB device and the NAS.

Auto Upload Flickr/YouTube

Upload files in selected shares to your Flickr and/or YouTube accounts.

Auto Upload FTP Uploadr

Upload files in selected shares to FTP servers.

Dropbox

Use your Dropbox account to easily move files to your NAS and have the NAS
download *.torrent files.

Time Machine

Use Time Machine in OS X to use your NAS as a backup volume.

Memopal

Back up files from the NAS to your Memopal account.

GoogleDriveCli
ent

Use GoogleDriveClient to synchronize local user folders on the NAS with
Google Drive cloud storage accounts.

Syslog Server

Enable the syslog server and select the categories to include in the log report.

TFTP Server

Configure the NAS to accept log files from TFTP clients.

pyLoad

Configure the NAS to use pyLoad to manage your downloads, including those
from one-click hosting sites.

Users

View, create and edit administrator and user accounts to let people use the
NAS.

Groups

View, create and edit groups. Groups allow you to organize users into specific
groups. You can create shares accessible only by the group members.

Shares

View, create and edit shares. Shares are shared folders to which you can allow
specific users read/write access rights.

WebDAV

Allow remote users to use client programs that support WebDAV to edit and
manage files stored on the NAS

Power

Configure power saving settings for the NAS and have the NAS turn itself off
and on or reboot according to the schedules you configure.

Log

View the NAS’s logs and configure how you want to receive the log reports.

Configuration

Back up and/or restore the NAS configuration file.

SSL

Configure HTTPS and the NAS’s SSL certificate.

Shutdown

Restart the NAS or shut it down.

Unpair
myZyXELcloud

Remove the pairing between the NAS and the myZyXELcloud account.

Backup

Create and customize backup jobs.

Restore

Restore previous backups made with the NAS.

NFS

Install the NFS package to display this screen where you can configure NFS
(Network File System) file-sharing.

Sharing

Maintenance

Protect

Network
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12.2.3 Main Window
The main window (3) shows the screen you select in the navigation panel. It is discussed in the
rest of this document.

12.2.4 Status Messages
The Message text box at the bottom of the screen (4) displays status messages as you configure
the NAS.

12.2.5 Common Administrator Screen Icons
The following table explains some icons that appear in several administrator configuration screens.
Table 60 Common Administrator Screen Icons
ICON

DESCRIPTION
Edit
Click this to go to a screen where you can change the configuration settings of an entry.
Delete
Click this to delete an entry from the list.
Edit
Click this to jump to related item’s configuration screen.
Refresh
Click this to refresh the data for the field or value with which it is associated.
User
See the chapter on user accounts for detailed information on variants of this icon.
Share
See the chapter on shares for detailed information on variants of this icon.
Healthy
This represents a healthy volume.
Down
This represents a down volume.
Scan Disk
Click this to scan a hard disk for file system errors.

Note: It is recommended to scan the volume every three months or 32 reboots.
Eject
Click this before you remove an external hard drive so that you do not lose data that is being
transferred to or from that hard drive.

12.2.6 Session Example (Windows)
Open Windows Explorer and type two back slashes followed by the NAS name or IP address.
Initially you can only read and write to the Public, Video, Music, and Photo folders until you
create other shares on the NAS. This session is then displayed as shown in the following figure.
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Session Example (Windows)
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13

Managing Packages
13.1 About Packages
Packages enhance the functions of your NAS. Your NAS supports various packages that let you do
more. Your NAS comes with some packages pre-installed. The Packages screen also includes a list
of packages to add.

Note: Check what packages do before you install them. Only install packages you actually
plan to use.
Note: Get support for each package through its individual vendor.

13.2 Managing Packages
In the administrator screens, click System Setting > Packages to install, remove, or upgrade
packages. See Section 16.4 on page 207 for details.
Figure 91 System Setting > Packages
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13.3 Available Packages
Use packages to add the following applications to the NAS.
• Use the NFS screen (Section 18.3 on page 247) to configure the Network File System (NFS)
settings of your NAS.
• Use the TFTP Server screen (Section 18.4 on page 250) to configure the NAS to accept log files
from TFTP clients.
• Use the pyLoad screen (Section 18.5 on page 251) to use pyLoad manage your downloads
including those from one-click hosting sites.
• Use ownCloud (Section 18.6 on page 251) to store, synchronize, and share files, photos,
calendars, and more with computers and mobile devices using an ownCloud client.
• Use Memopal (Section 18.3 on page 247) to back up files on the NAS to your Memopal online
backup and storage account.
• Use the GoogleDriveClient screens (Section 18.8 on page 256) to synchronize local NAS shares
or folders and Google Drive accounts.
Access the following applications’ configuration screens through the Package Management
screen. Refer to the applications’ own documentation for further information.
• Gallery - This web-based application allows your NAS to host pictures. You can upload images in
your local computer or shares to this application. Use the Gallery administrator account (default
username admin, password 1234) to log into the Gallery console. There you can create accounts
for other users.
• Use Logitech® Media Server (Section 17.5.2 on page 218) to manage a Logitech Squeezebox
device connected to the NAS.
• The NZBGet news grabber helps download files from UseNet.
• PHP-MySQL-phpMyAdmin can be used to manage MySQL through the web. Enter 'root' as the
username and '1234' as the password to log in. This includes MySQL, PHP, and phpMyAdmin.
• Transmission - This Bit Torrent client supports adding tasks through torrent files and magnet
links.
• WordPress - This allows you to create and manage a blog. Use the WordPress administrator
account (default username admin, password 1234) to log in. You can then create accounts for
other users.
• myZyXELcloud-Agent - Use this to go to mycloud.zyxel.com to set up a free DDNS hostname
for the NAS so you can connect to it easily from the Internet.
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Tutorials
14.1 Overview
This chapter provides tutorials that show how to use the NAS.
• Windows 7 Network, see page 146
• Windows 7 Network Map, see page 150
• Playing Media Files in Windows 7, see page 152
• Windows 7 Devices and Printers, see page 152
• File Sharing Tutorials, see page 155
• Download Service Tutorial, see page 162
• Copy and Flickr Auto Upload Tutorial, see page 173
• FTP Uploadr Tutorial, see page 174
• Web Configurator’s Security Sessions, see page 177
• Using FTPES to Connect to the NAS, see page 188
• Using a Mac to Access the NAS, see page 189
• How to Use the BackupPlanner, see page 191

14.2 Windows 7 Network
To see your NAS in a Windows 7 home or work network:
1

Click Start > Control Panel. Set View by to Category and click Network and Internet.
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2

Click View network computers and devices.

3

The NAS icon displays twice because the NAS is both a media server and a storage device. Doubleclick either NAS icon to open the Web Configurator login screen.
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14.2.1 If the NAS Icon Does Not Display
The network containing the NAS must be set as a home or work network in order for the NAS icons
to display. If the network containing the NAS displays as “Public”:
1

Click Network and Sharing Center and then the network’s link (circled in the figure).

2

Use the Set Network Location screen to set the network’s location to home or work.
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14.2.2 NAS Icon Right-click Options
Right-click the NAS’s icon to see these options:

• Install/Uninstall: Click Install to add the NAS as a device in your computer. After you install
the NAS you can see it in the computer’s list of devices (see Section 14.5 on page 152. Click
Uninstall to remove the NAS from the list of devices installed in your computer.
• View device web page opens the Web Configurator login screen.
• Open Media Player opens the computer’s default media player.
• Create shortcut adds a desktop shortcut to the Web Configurator login screen.
• Properties opens a window of NAS details and troubleshooting information.
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• Manufacturer identifies the company that produced the NAS.
• Model identifies the NAS model.
•

Model number identifies the NAS model number.

• Device webpage shows the IP address for accessing the Web Configurator.
• Serial number is unavailable because the NAS does not have one.
• MAC address is the NAS’s unique physical hardware address (MAC). You need the MAC
address to register the product at myZyXEL.com. Customer support may also request it for
troubleshooting purposes.
• Unique identifier is a unique UPnP ID that the NAS generated.
• IP address is the NAS’s IP address. It is also the IP address for accessing the Web
Configurator.

14.3 Windows 7 Network Map
To see your NAS in a Windows 7 home or work network map:
1

Click Start > Control Panel > View network status and tasks (or Network and Sharing
Center if you view the Control Panel by icons).
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2

Click See full map (1 in the figure).
The network containing the NAS must be set as a home or work network in order to use the full
map feature. If the network containing the NAS displays as “Public”, click the network’s link (2 in
the figure, although it is already set to home here) and use the Set Network Location screen to
set the network’s location to home or work (see page 148).

1
2

AM

PL

E

Double-click the NAS’s icon to open the Web Configurator login screen. See Section 14.2.2 on page
149 for the NAS icon’s right-click options.

EX

3
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14.4 Playing Media Files in Windows 7
In Windows 7, the NAS automatically displays as a library in Windows Media Player.
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Figure 92 NAS in Windows Media Player

14.5 Windows 7 Devices and Printers
After you use the NAS’s network icon’s install option you can manage the NAS from the Windows 7
Devices and Printers folder.
Click Start > Control Panel > Hardware and Sound > Devices and Printers. Select the NAS
icon to display information about the NAS. Double-click the NAS icon to open a properties window
(see page 149). Right-click the icon to display these options:
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• Open Media Player opens the computer’s default media player.
• Create shortcut has Windows make a desktop shortcut to this screen.
• Troubleshoot opens Windows’ device troubleshooting wizard.
• Remove device removes the NAS from the Windows 7 Devices and Printers folder.
• Properties opens a window of NAS details and troubleshooting information (see page 149).

14.5.1 Windows 7 Desktop Shortcut
This is the NAS’s desktop shortcut. Double-click it to open a properties window (see page 149).
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1

Right-click the NAS’s desktop shortcut icon to see these options:

• Open Media Player opens the computer’s default media player.
• Open file location takes you to the Windows 7 Devices and Printers folder.
• Download NAS Starter Utility downloads the NAS’s Starter Utility. It lets you find, set up, and
manage the NAS as well as copy files to it and access the files on it. See Chapter 2 on page 19 for
details.
• Restore previous versions is the Windows 7 option for restoring a file or folder. It does not
apply to this shortcut.
• Send to give you options for copying the shortcut to another location.
• Cut removes this shortcut so you can paste it somewhere else.
• Copy copies the shortcut so you can paste it somewhere else.
• Create shortcut has Windows make a desktop shortcut to this icon.
• Delete sends the shortcut to the recycle bin.
• Rename lets you change the name of the shortcut.
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• Troubleshoot opens Windows’ device troubleshooting wizard.
• Remove device removes the NAS from the Windows 7 Devices and Printers folder.
• Properties opens a window of details about the shortcut.

14.6 File Sharing Tutorials
The following sections cover using the NAS for file sharing. This chapter assumes you have already
followed the Quick Start Guide instructions to perform initial setup and configuration (so you have a
working volume). See the rest of this User’s Guide for details on configuring the NAS’s various
screens.

14.6.1 Creating a User Account
Jimmy wants to create accounts for his sons Bob and Kevin. This is how he would do it.
1
2

3

Go to the advanced administration screens.
Click Sharing > Users to open the Users screen. Then click Add User.

Configure the screen as follows and write down the username and password to give to Bob. If the
username and password are the same as Bob’s Windows login, Bob will not need to enter a
username and password when he logs into his share from his computer. Set the Account Type to
User so Bob doesn’t get to configure the whole NAS. Click Apply to create the account.
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4

The account now displays in the Users screen.

Now that Jimmy has created Bob’s account, he can go through the steps again to create another
account for Kevin. After both accounts are created, he can go to Section 14.6.2 on page 156 to
create shares for Bob and Kevin.

14.6.2 Creating a Share
Suppose Jimmy has already created separate accounts for his sons Bob and Kevin. Now Jimmy
wants to create a share for each son. He also wants to make sure that each son can only access his
own share (to keep them from deleting each other’s files). This is how he would do it.
1

In the NAS’s administration web configurator screens, click Shares > Add Share. Click Add Share
to create a new share.

2

Specify a name for the share and select which volume it should be on. Configure the screen as
follows. Then click Edit.
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3

Configure the screen as follows to give Bob full access right to the share. Then click Apply to create
the share.

Now that Jimmy has created Bob’s share, he can go through the steps again to create another
share for Kevin.

14.6.3 Creating a Group
After creating user accounts for Bob and Kevin, Jimmy wants to create a group for his sons and
another one for the parents. Jimmy can assign access rights to his sons’ group for certain shares
such as a cartoons share and allow only the parents’ group to access the scary movie share. This is
how he would create the group.
1

In the NAS’s administration web configurator screen, click Groups > Add Group.

2

Specify a name for the group. Select the user(s) you want to add to the group from the Available
User(s) list and click Add Selected User(s). Configure the screen as follows. Then click Apply to
create the group.
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Now that Jimmy has created a group for Bob and Kevin, he can go through the steps again to
create another group for the parents. Then he can see the rest of the tutorials for how to use the
groups in assigning access rights to shares.

14.6.4 Accessing a Share From Windows Explorer
If you map a NAS share (where data is stored) to a Windows network drive, you can use Windows
Explorer to transfer files to and from the NAS as if it was another folder on your computer. Here he
maps Jimmy’s share to Jimmy’s computer.
1

Start Windows Explorer and go to the NAS’s server name. The default is ‘nas’ followed by the
number of your model (‘nas540’ for example).

2

Click Tools > Map Network Drive.

3

Select the network drive that you want to map the NAS to from the Drive list box. This example
uses I. Then browse to and select the share on the NAS. Click Finish.
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4

Enter the username and password for Jimmy’s account and click OK. You do not need to do this if
the username and password are the same as Jimmy’s Windows login.

5

After the mapping is done, you can then simply copy and paste or drag and drop files from/to your
local computer’s drives to or from this network folder. Just like the NAS’s share was another folder
on your computer.
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Now that Bob has mapped Jimmy’s share to Jimmy’s computer, he can go through the steps again
to map Kevin’s share to Kevin’s computer.

14.6.5 Accessing a Share Using FTP
You can also use FTP to access the NAS. Suppose Jimmy is temporarily using a different computer
and wants to access his share without mapping it to the computer. This is how he would do it.
Open the FTP client (Windows Explorer is used here) and type “ftp://username@server” where
“username” is the account’s username and “server” is the NAS’s IP address or server name.

2

Enter your password and click Login.
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Now you can access files and copy files from/to your local computer’s drives to or from this network
folder.
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3

14.6.6 Accessing a Share Through the Web Configurator
You can browse and access files through the web configurator.
1

Log into the NAS web configurator (see Section 7.2 on page 38) using the appropriate user name
and password (this example uses Jimmy’s) and click File Browser. Click a share (the admin share
in this example) to see the top level of the share’s contents.
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2

Click a folder’s file name to browse the folder. You can open files or copy them to your computer.
You can also create new folders and upload additional files to the share.

3

Click the logout icon when your are done.

14.7 Download Service Tutorial
This tutorial covers using the NAS to download a file from the Internet. Use this same procedure for
P2P downloads as well as regular HTTP (web) and FTP downloads. See Section 17.11.2 on page 235
for more on the download service.

14.7.1 Copying/Pasting a Download Link
1

Open your Internet browser (this example uses Internet Explorer).

2

Find a download link for the file you want. In this example, www.zyxel.com has a Server 1 link for
downloading a datasheet for ZyXEL’s NSA325 v2.
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Note: Make sure the link opens either the file you want or a pop-up window about how to
handle the file.
Note: It is also OK for the link to open a .torrent file. If you are redirected to a screen that
says the download should start in a few seconds, there may be a link to click if the
download does not start automatically. See if that link opens the file or the pop-up
window.
3

Right-click the download link and select Copy Shortcut in Internet Explorer (or Copy Link
Location in Firefox).

4

Log into the NAS web configurator (see Section 7.2 on page 38) using the administrator account
and click Application Zone and the Application Zone > Download Service link.
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5

Click Add.

6

Right-click the URL field and select Paste.

7

The URL displays in the URL field. Click Apply.
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8

After a few moments, the download task appears in the Download Service screen’s Active tab.
The download appears in the Completed tab when it is done. By default the NAS stores all
downloads in the admin share’s download folder. See Section 14.6.4 on page 158, Section 14.6.5
on page 160, or Section 14.6.6 on page 161 for how to access a share.

14.7.2 Configuring the Download Service Preferences
Once you added a list of download tasks to the NAS (see Section 14.7.1 on page 162), you can
have the NAS download files during a specific time period of the day. You can also configure the P2P
download settings to control bandwidth and optimize download efficiency.
Say you have the NAS turned on all the time, but you only want the NAS download files at night.
Here is how you use the download period control feature to set the time range.
1

Click Applications > Download Service > Preferences to open the General Settings screen.

2

Select Enable Download Period Control and use the arrows to adjust the time period from 23:30
to 09:00. Click Apply to save your changes. The NAS only downloads files within this 9.5-hour
period every day.
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Note: If you configure the Power On/Off Schedule feature in the Power Management
screen, make sure your active download period does not conflict with the power-off
period.
Note: If power failure occurs during the active download period, the NAS will verify
whether the downloaded files were damaged. If a file is corrupted, the NAS will
download the file again. If the file is intact but not completely downloaded, the NAS
will resume the download task after it restarts.
3

When it is not the download time, you see a message in the Download Service screen, indicating
the active download period.
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Click Applications > Download Service > Preferences > P2P download to open the following
screen. Enter the information below and then click Apply.

Here is a list of P2P download settings you want to configure for your NAS:
• Limit the maximum upload rate to 20 KB/s.
Enter this value in the Max. upload rate field.
• Actively download three torrent files but only upload one at a time.
Enter 3 in the Maximum Number of Active Torrents field and enter 1 in the Maximum
Number of Seeding Jobs field.
• Keep sharing until the NAS has shared equal or greater amount of the downloaded files.
Select the check box and enter 100 in the Upload/Download Ratio field.
• Scroll down and click Edit IP Filter. Use an online IP filter table from http://www.bluetack.co.uk/
config/level1.gz for example to protect P2P downloads.
Enter the URL in the Update IP Filter from the Internet Every Week field.
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14.7.3 Using Download Service Notification
Use an RSS feed reader on your computer to keep track of files the NAS has downloaded. The
following examples show how to subscribe to the NAS’s download service notifications. See Section
17.11.3 on page 236 for more on download service notifications.
Some RSS readers may not support the NAS’s download service notifications. For example, Google
Reader cannot support this feature if the NAS has a private IP address.

Note: It is recommended to subscribe to the download service notifications using the
built-in reader in Internet Explorer 7 or higher, or Firefox.
You have to activate this feature in the Download Service screen. Click Applications >
Download Service to open the following screen. Select Enable Download Notify and click
Apply.

Internet Explorer 7 Example
1

After you activate download service notification, click the RSS feed icon.

2

The following screen displays. Select Subscribe to this feed.
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3

The following screen displays. Click Subscribe.

4

Click the Favorite icon on your browser and select the Feeds tab to check the updates of your
NAS’s download list.

Firefox Example
1

After you activate download service notification, click the RSS feed icon.
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2

The following screen displays. Select Live Bookmarks from the drop-down list and click
Subscribe Now.

3

The following screen displays. Select Bookmarks Menu and click Add.

4

From the Firefox’s Bookmarks Menu, select Download Notify to check the updates of your NAS’s
download list.
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14.8 Printer Server Tutorial
Do the following to have the NAS let computers on your network share a printer. See
www.zyxel.com for a list of compatible printers.
1

Make sure the NAS is on and the SYS light is on steady (not blinking).

2

Use a USB cable to connect the printer’s USB port to one of the NAS’s USB ports. Make sure the
printer is also connected to an appropriate power source.

NAS
3

Turn on the printer.

4

The NAS detects the printer after a few moments.

5

On your computer, open your CIFS file sharing program (Windows Explorer for example) and
browse to the NAS. Double-click the printer’s icon.

6

If you get a warning screen, click the option that lets you continue (Yes in this example).
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7

If your computer does not already have the printer’s driver installed, you will need to install it. In
this example, click OK.

8

Use the wizard screens to install the printer driver on the computer. You may need to get the file
from the printer’s CD or the printer manufacturer’s website (the driver is not installed on the NAS).

Note: You must install the printer driver on each computer that will use the printer.

After the driver installation finishes, the computer is ready to use the printer. Select the printer in
an application to use it to print. Browse to the NAS using a CIFS program (like Windows Explorer)
and double-click the printer’s icon to open the printer’s queue of print jobs.

Note: Repeat steps 5 to 8 on your other computers so they can also use the printer.
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14.9 Copy and Flickr Auto Upload Tutorial
Amy received some photos taken during her best friend’s wedding and saved the files on a USB
disk. She wants to save a copy of the photos in the NAS and upload the photos to her Flickr
account.
Amy has to activate the NAS’s auto upload feature. See Section 19.4 on page 262 for more details
on setting up a Flickr account for auto upload. In this example Amy select the NAS’s photo share for
auto upload.
This is how Amy would transfer the files from her USB disk to the NAS.
1

Click Applications > Copy/Sync Button in the navigation panel to open the screen.

2

Configure the copy settings as shown and click Apply.

3

Press and release the COPY/SYNC button on the NAS’s front panel to start copying files.

4

The copied files can be found in a new folder in the photo share. The name of this folder is the date
(yyyy-mm-dd) and time (hh-mm-ss) when the folder is created.
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5

The NAS also automatically uploads the copied files to Flickr.
r

14.10 FTP Uploadr Tutorial
FTP Uploadr can automatically upload files saved on the NAS to a remote FTP server. Amy wants to
share files on her NAS with Susan. They each have an NAS at home, so Susan has to set her NAS
as an FTP server for Amy to automatically send files using FTP Uploadr.
l

Susan’s NAS

Amy’s NAS

To set the NAS as an FTP server, click Applications > FTP to open the FTP screen. Select Enable
FTP and click Apply.
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Susan also has to create a user account and share on her NAS for Amy to upload files. The share is
used for files uploaded from Amy’s NAS. Amy will then use the following information to configure
FTP Uploadr on her NAS.
Table 61 FTP Uploadr Tutorial: FTP Server Information
FTP Domain Name or IP Address

example2.com

FTP User Name

Amy

FTP Password

xxxxx

Share (Remote Path)

Amy

This is how Amy would set up the NAS’s FTP Uploadr.
1

Click Applications > Auto Upload > FTP Uploadr to open the FTP Uploadr screen. Select
Enable FTP Uploadr and click Apply to turn on FTP Uploadr.

2

Click Add Server.

3

Enter the information as describe in Table 61 on page 175. Click Apply to add the server.
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4

In the FTP Uploadr screen, click Preferences to configure the auto upload settings.

5

Amy wants to share video files with Susan. In the Preferences screen, click the Add button and
select video from the Shares drop-down list box, enter a forward slash in the Path field and click
Apply to add the share to the Folder Watch List.
t

6

Amy also set the Bandwidth Limit to 20 KB/s so that the upload doesn’t slow down her Internet
connection.
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Now Amy has set up FTP Uploadr to send files to Susan’s NAS. Every time Amy adds new files or
renames files in the video share, these new or modified files will be uploaded automatically to the
Amy share on Susan’s NAS.
Similarly, Susan can go through the steps described above to configure FTP Uploadr on her NAS.
Once Susan completes the setup, Amy can also receive files from Susan’s NAS.

Susan’s NAS

Amy’s NAS

14.11 Web Configurator’s Security Sessions
These tutorials show you how to configure security for the NAS’s Web Configurator sessions. You
will customize the NAS’s self-signed SSL certificate and distribute it to your users.

14.11.1 Customizing the NAS’s Certificate
1

Click Maintenance > SSL and then select Edit a self-signed CA certificate and click Edit.
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2

Next, let’s modify the certificate by changing the Common Name to this NAS’s host name of “nsa”,
the Organization to “ZyXEL” and the Key Length to 2048.

3

The NAS restarts its network services and returns you to the login screen.
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14.11.2 Downloading and Installing Customized Certificate
1

Log in and return to Maintenance > SSL. Under Modify the Existing Certificate, click
Download.

2

Save the file to your computer.

3

Find the certificate file on your computer and double-click it.
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Install the certificate. The rest of the steps in this section are an example of installing a certificate
in Windows. In the Certificate dialog box, click Install Certificate.

5

In the Certificate Import Wizard, click Next.

EX
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4
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6

Leave Automatically select certificate store based on the type of certificate selected and
click Next.

7

In the Completing the Certificate Import Wizard screen, click Finish.
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If you are presented with another Security Warning, click Yes.

9

Finally, click OK when presented with the successful certificate installation message.
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8

14.11.3 Turn on the NAS’s Web Security
Now that you have customized the NAS’s certificate and installed it in your computer, you can turn
on security for your Web Configurator sessions. This example uses Firefox 3.0.
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1

Close your web browser and open it again to reset its session with the NAS. Log in and click
Control Panel > TCP/IP > Web Configurator. Select Enable HTTPS connection and click
Apply.

2

A warning screen pops up if applying your change may disconnect some users. Click Yes to
continue.
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The NAS logs you out and automatically redirects your formerly non-secure (HTTP) connection to a
secure (HTTPS) connection. Your browser may give you a warning about the device’s public key
certificate. Add an exception to allow your browser to bypass the warning.

4

Click Add Exception.

5

Click Get Certificate.
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6

Before you add an exception, verify that the device to which you are trying to connect is providing
the correct certificate. Click View.

Cloud Storage User’s Guide

185

Chapter 14 Tutorials

7

The SHA1 fingerprint must match the NAS’s certificate you downloaded from the NAS to your
computer. (Double-click the NAS’s certificate file and then click Details and look at the
Thumbprint). Click Close.
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8

If the certificate fingerprints match, click Confirm Security Exception, otherwise click Cancel.
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9

The login screen displays.

Now, anyone who connects to the NAS’s Web Configurator screens will automatically do so by
HTTPs. Use a secure method to let your users know the correct fingerprint for the NAS’s certificate
so they can check it before adding a security exception (as in steps 6 to 7 on pages 185 to 186).
See the next section for how to use FTPES with the NAS for secure FTP transfers.

14.12 Using FTPES to Connect to the NAS
This section covers how to use FTP over Explicit TLS/SSL with the NAS for secure FTP transfers.
Before you go through this section, read Section 14.11 on page 177 to configure HTTPS. This
example uses FileZilla.
1

Open FileZilla and click File > Site Manager > New Site.
• Configure the Host field with the NAS’s address.
• Set the Servertype to FTPES - FTP over explicit TLS/SSL.
• Configure the account name and password.
• Click Connect.
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A security warning screen displays. The SHA1 fingerprint must match the NAS’s certificate you
downloaded from the NAS to your computer. (Double-click the NAS’s certificate file and then click
Details and look at the Thumbprint). If they match, click OK.
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2

The shares and folders to which Gonzo has access display. Now you can use FTP to securely transfer
files to or from the NAS. Use a secure method to let your users know the correct fingerprint for the
NAS’s certificate so they can check it before adding a security exception.

14.13 Using a Mac to Access the NAS
This tutorial shows you how to find the NAS on Mac OS X 10.5 (Leopard).
You can access the NAS in two ways:
• Use the Finder to browse for the NAS, or
• Use the Finder > Go option to connect to the NAS.

14.13.1 Finder
1

Open a new Finder window.
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Select All under the SHARED sidebar. Look for the NAS from the Network list.

3

Expand the NAS to display the shares you may access.
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2
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14.13.2 Go Menu
4

In the Finder, click Go > Connect to Server.

5

When the Connect to Server dialog box opens, enter smb:// and the NAS’s IP address in the
Server Address field. You may also click Browse to have the Mac search for the NAS. Click
Connect.

6

Once you establish the connection, you can access the NAS from the Finder or directly from the
desktop.

14.14 How to Use the BackupPlanner
Note: The screens and links in this section appear only after you have installed and
enabled BackupPlanner. BackupPlanner is an application that you can install using
Package Management (see Chapter 18 on page 246.)
Use the NAS’s BackupPlanner to have a backup of your files and folders.
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Schedule backups for times when the network is not busy (like at night or on weekends). For
example, you might do daily backups of important individual files or folders and a weekly general
archive. You can save backups to another location so your files can survive even if the original RAID
or NAS fails.

14.14.1 Creating an Archive Backup
To backup the NAS every week to a remote NAS:
1

Click Protect > Backup > Add Job.
Figure 93 Protect > Backup

2

Identify the backup job and select Archive.
New files are often added to the shares that you need to back up and existing files are not
frequently changed so select Incremental. The NAS does a full backup first and later only copies
source files that are new and/or modified since the last backup. This example sets the NAS to do
another full backup after every four incremental backups.
Figure 94 Protect > Backup > Add Job: Step 1
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3

Select the volume1 check box to select all the folders and files.
Select Remote and enter the other NAS’s address, username, password, and share name.
If you want to make sure the remote NAS is reachable, click Test Connection.
Figure 95 Protect > Backup > Add Job: Step 2

4

In this example, the target NAS is on the LAN so leave the compression off.
Security is already configured on the target NAS so you can leave the encryption off, too.
Have the NAS keep 3 backups.
Figure 96 Protect > Backup > Add Job: Step 3

5

Set the frequency to Weekly. Schedule the backup for 5:00 every Saturday morning.
Protect > Backup > Add Job: Step 4
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14.14.2 Creating a Synchronization Backup
To create a synchronization backup:
1

Click Protect > Backup > Add Job.
Figure 97 Protect > Backup

Name the backup job and select Synchronization.
You want only your current set of files in the Backup Photo folder of your External storage , so you
select Mirror to make the target folder identical to the source folder. The NAS deletes any other
files in the target folder.
Figure 98 Protect > Backup > Add Job: Step 1

2

Select the folder that needs to be mirrored (your Photo folder in this example) and External.
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• Select the destination on the External (Backup Photo in this example).
• Click Next.
Figure 99 Protect > Backup > Add Job: Step 2

3

Click OK in the warning dialog box.
Figure 100 Protect > Backup > Add Job: Step 3

4

For this example, assume not many files need to be backed up so leave the compression off.
• Turn on the encryption to protect these sensitive files during the transfer. The final files stored
on the remote NAS will be unencrypted (usable).
• Restrict the bandwidth usage to 256 KB/s to stop the archives from using all of your network
connection’s available bandwidth.
• You don’t have to configure a purge policy for a synchronization backup.
• Click Next.
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Figure 101 Protect > Backup > Add Job: Step 3

5

Schedule the backup to occur every morning at 3:00 and click Done.
Figure 102 Protect > Backup > Add Job: Step 4

You do not need to use a special restore process to use the files a synchronization backup creates.
The copy of files that the NAS creates on the other NAS’s Backups share can be used directly by
anyone with access to that share.

14.14.3 Restoring Archived Files by Backup Job
If you have backup jobs for which the NAS has already performed backups, you can restore the files
based on the backup job. Do the following:
1

Click Protect > Backup screen, select a backup job and click Restore Archive.
Figure 103 Protect > Backup
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2

Select which backup to use and click Next.
Figure 104 Protect > Backup > Restore Archive: Step 1

3

Select the files and folders you want to restore and click Next.
Figure 105 Protect > Backup > Restore Archive: Step 2

4

Select the original location and click Done.
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Figure 106 Protect > Backup > Restore Archive: Step 3

5

The NAS restores the files into the share. When it finishes you can access the files.
Figure 107 Protect > Backup > Restore Archive: Progress

14.14.4 Restoring by Backup Files
If you deleted an archive backup job or the NAS or the RAID array containing the backup job failed
you cannot restore archived files by the backup job. In this example, the NAS’s RAID array failed.
You’ve replaced the hard drives and re-configured the RAID. To restore by backup files:
Click Protect > Restore. Specify where the archive files are located. In this example, enter
“192.168.3.2” as the IP address, “admin” as the account name, “1234” as the password, and
“Backups” as the share name. Click Test Connection. Click Next.
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Figure 108 Protect > Restore: Step 1

EX
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2

Select the backup job and backup time and click Next.
Figure 109 Protect > Restore: Step 2

3

Select everything in the share except the recycle folder. Click Next.
Figure 110 Protect > Restore: Step 3

4

Browse to the folder where you want to put the files. Click Done.
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Figure 111 Protect > Restore: Step 4

5

The NAS restores the files and you can use them again.
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15

Status Screen
15.1 Overview
This chapter describes the Status screen, which is the first advanced administration screen that
displays.

15.2 Status Screen
Click the Administration button in the Desktop screen (Chapter 12 on page 139) to open the
Web Configurator. From within the Web Configurator screens, you can also click Status on the topleft of the navigation panel to display the status screen.
Figure 112 Status

The following table describes the labels in this screen.
Table 62 Status
LABEL

DESCRIPTION

Status

Click Status in the navigation panel to refresh the status screen statistics.

System Information
Server Name

This displays the name which helps you find the NAS on the network. Click the
Edit icon to go to the screen where you can configure this.

Model Name

This displays which model this NAS device is.

Firmware Version

This is the NAS firmware version. Click the Edit icon to go to the Maintenance >
FW Upgrade screen from which you can upload/upgrade new firmware.

Media Server Status

This shows whether the media server function is enabled or disabled. It must be
enabled for media clients to play content files stored on the NAS. Click the Edit
icon to go to the screen where you can configure this.

FTP Server Status

This shows whether the FTP server function is enabled or disabled. It must be
enabled to use FTP file transfer to/from the NAS. Click the edit icon to go to the
screen where you can configure this.
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Table 62 Status (continued)
LABEL

DESCRIPTION

Web Publishing Status

This shows whether the Web server function is enabled or disabled. It must be
enabled to use HTTP to access shares on the NAS. Click the Edit icon to go to the
screen where you can configure this.

UPS

This shows the Uninterruptible Power Supply (UPS) capacity. Click the Edit icon to
go to the screen where you can configure this.

Active Sessions

This shows how many users are currently connected to the NAS.

Type

This shows whether it’s a Windows/CIFS, web (web configurator), or FTP
connection to the NAS.

Share Name

This displays the shared folder name on the NAS that the user is connected to for
CIFS sessions and is blank for FTP and web sessions.

Username

This displays the name of the user connected to the NAS if one is defined.
ANONYMOUS FTP displays if a username is not defined for the user’s connection.

Connected At

This displays the date and time the user last connected to the NAS in year, month,
day, hour, minute, second format.

IP Address

This displays the IP address of the computer connected to the NAS.
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System Setting
16.1 Overview
This chapter gives an overview of the various features included in the system setting screens.
Upgrade the NAS firmware. Use package management to add more useful applications in your NAS.
Identify your NAS on the network and set the time that the NAS follows for its scheduled tasks/logs.

16.2 What You Can Do
• Use the Packages screens (Section 16.4 on page 207) to upload new firmware and download
and install applications from the web.
• Use the Server Name screen (Section 16.5 on page 209) to specify the NAS’s server and
workgroup names.
• Use the Date/Time screen (Section 16.6 on page 210) to set up date/time and choose a time
zone for the NAS.

16.3 What You Need to Know
Package Management
This feature enables you to install and use the following applications.
• Gallery - This web-based application allows your NAS to host pictures. You can upload images in
your local computer or shares to this application. Use the Gallery administrator account (default
username admin, password 1234) to log into the Gallery console. There you can create accounts
for other users.
• NFS - NFS (Network File System) is a file-sharing protocol most commonly implemented on
Unix-like systems.
• NZBGet - This news grabber helps download files from UseNet.
• PHP-MySQL-phpMyAdmin - This tool can be used to manage MySQL through the web. Enter
'root' as the username and '1234' as the password to log in. This includes MySQL, PHP, and
phpMyAdmin.
• Logitech® Media Server - This enables you to manage a Logitech's Squeezebox device
connected to the NAS.
• TFTP - Use this to configure the NAS to accept log files from TFTP clients.
• Transmission - This Bit Torrent client supports adding tasks through torrent files and magnet
links.
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• WordPress - This allows you to create and manage a blog. Use the WordPress administrator
account (default username admin, password 1234) to log in. You can then create accounts for
other users.
• pyLoad - Use this to have the NAS manage your downloads including those from one-click
hosting sites. One-click hosting sites allow Internet users to easily upload files to the one-click
host's server so others can download them.
• Memopal - Use this to back up files on the NAS to your Memopal online backup and storage
account.
• ownCloud - Use this to store, synchronize, and share files, photos, calendars, and more with
computers and mobile devices.
• myZyXELcloud-Agent - Use this to go to mycloud.zyxel.com to set up a free DDNS hostname
for the NAS so you can connect to it easily from the Internet.
The following applications come with their own configuration screens and documentation:
• Gallery
• NZBGet
• PHP-MySQL-phpMyAdmin
• Logitech® Media Server
• Transmission
• WordPress
• myZyXELcloud-Agent
• ownCould

Windows/CIFS
Common Internet File System (CIFS) is a standard protocol supported by most operating systems
in order to share files across the network.
• CIFS is included by default in Windows operating systems.
• You can use Samba with Linux to use CIFS.
• CIFS transfers use security.

Time Lag
Time lag occurs when the time on the NAS falls behind the time on the time server. This may
happen if:
• the time server is no longer reachable
• if the NAS is shut down often (the NAS internal battery keeps time when the NAS is shut down
and this may cause possible variance)
• power surges occur.
The NAS gives no warning if time lag occurs. You should resynchronize the time after a power surge
or after you have shut down the NAS several times.
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16.4 Package Management Screen
Use this screen to download and install applications from the web. See Chapter 18 on page 246 for
more about the features you can add to the NAS by installing packages.
Click System Setting > Packages to open the following screen.
Figure 113 System Setting > Packages

The following table describes the labels in this screen.
Table 63 System Setting > Packages
LABEL

DESCRIPTION

Package Management
Retrieve List From
Internet

Click this to retrieve a list of available packages from the ZyXEL website.

Install/Upgrade

Choose the item(s) on the list and click this to install the selected application(s) on your
system or upgrade to the latest version if you have previously installed the application.

Uninstall/Cancel
Installation

Choose the item(s) on the list and click this to uninstall the selected application(s) from
your system or cancel their active download(s) or install process/es.
This is only available if you have previously installed the package.

Enable

This option is only for non built-in packages.
Choose the item(s) on the list and click this to enable the application(s) on your
system.
This is only available if you have previously installed the package.

Disable

This option is only for non built-in packages.
Choose the item(s) on the list and click this to disable the application on your system.
You have to enable the application again in order to use it.
This is only available if you have previously installed the package.

Package Info

Select an item on the list and click this to display information about the package. See
Section 16.4.1 on page 208 for more details.
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Table 63 System Setting > Packages
LABEL
Status

DESCRIPTION
This is the current status of the application. It shows:
•
•
•
•
•
•

Not Installed - This displays for applications that have not been installed by the
NAS.
Installing (%) - This displays when the application is being installed. It also shows
the percent of the package already installed.
Built-in - This displays for applications installed by the NAS that you can configure
in the NAS Web Configurator.
Enabled - This displays for applications installed and enabled by the NAS that have
their own web configurators.
Disabled - This displays for applications installed and disabled by the NAS that
have their own web configurators.
Unknown - It is possible to get this status if the web location for the application is
unavailable.

Package Name

This is the name of the application.

Requires

This shows the other packages required in order to run this application.

Note: A package would be disabled/enabled simultaneously if its prerequisite package(s)
has been disabled/enabled. For example, when you enable WordPress, this also
enables PHP-MySQL-phpMyAdmin automatically. However when you enable
PHP-MySQL-phpMyAdmin, this does not automatically enable WordPress.
Version

This is the version number of the item.
The
icon indicates that the application has a newer version available. Move your
mouse over this icon to see the latest version number. Choose this item and click
Install/Upgrade.

Description

This shows a brief description of the application.

Management
Page

This shows the location of the screens or web configurator where you can manage the
application (after the package has been installed on the system).

Note: Once you install an application and enable it, additional links show up in the
navigation panel. This applies to NFS, TFTP Server, pyLoad, and Memopal.
Access the Gallery, NZBGet, PHP-MySQL-phpMyAdmin, Logitech® Media
Server, Transmission, WordPress, OwnCloud, and myZyXELcloud-Agent
applications’ web configurators through the Package Management screen.

16.4.1 Displaying the Package Information
Select an item on the list and click Package Info. Use this screen to check detailed information
about the application.
Figure 114 System Setting > Packages > Package Info
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The following table describes the labels in this screen.
Table 64 System Setting > Packages > Package Info
LABEL

DESCRIPTION

Status

This is the current status of the application. It shows:
•
•
•
•
•

Not Installed - This displays for applications that have not been installed by the NAS.
Installing (%) - This displays when the application is being installed. It also shows
the percent of the package already installed.
Built-in - This displays for applications installed by the NAS that you can configure in
the NAS Web Configurator.
Enabled - This displays for applications installed and enabled by the NAS that have
their own web configurators.
Disabled - This displays for applications installed and disabled by the NAS that have
their own web configurators.

Name

This is the name of the application.

Size

This is the size of the application at initial download.

Needed Space

This is the needed space to complete the installation of the application.

Version

This is the version number of the application.

Requires

This shows other package/s required to run this application.

Required By

This shows which other packages require this application in order to be usable.

Management Page

This shows the location of the screens, console or web configurator where you can
manage the application (after the package has been installed on the system).

Source

This shows the location of the installed files of the application.

Description

This shows a brief description of the item.

Close

Click this to close the screen.

16.5 Server Name Screen
Click System Setting > Server Name to open the following screen. Use this screen to configure
your CIFS settings. In this screen you can set your server name and specify if your NAS is a part of
a workgroup.

Note: CIFS cannot be disabled on the NAS.
Figure 115 System Setting > Server Name
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The following table describes the labels in these screens.
Table 65 System Setting > Server Name
LABEL

DESCRIPTION

Server Name

Enter a name to identify your NAS on the network in this field.
You can enter up to 15 alphanumeric characters with minus signs allowed but not as the
last character. The name must begin with an alphabet (a-z) and is NOT case sensitive.

Description

Add text here to describe the NAS if the Server Name field is not enough. Use up to 61
characters. You can use all characters except the following: /\:|[]<>+;,?=*"~.

Workgroup Name

Type your workgroup name in this field. A workgroup is a group of computers on a
network that can share files. These user accounts are maintained on the NAS.
You can enter up to 15 alphanumeric characters with minus signs allowed but not as the
last character. The name must begin with an alphabet (a-z) and is NOT case sensitive.

Prevent NAS From
Being Master
Browser

Select this option if computers in your workgroup are named with non-English characters
(such as Chinese and Russian). When you perform a search in the workgroup, this option
allows you to locate computers named with non-English characters.

Apply

Click this to save your changes.

Reset

Click this to restore previously saved settings.

16.6 Date/Time Screen
Use this screen to select a time zone and a time server from which your NAS can get the time and
date. This time is then used in NAS logs and alerts.
Click the System Setting link in the navigation panel and then click the Date/Time link to access
the Date/Time screen.
Figure 116 System Setting > Date/Time
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The following table describes the labels in this screen.
Table 66 System Setting > Date/Time
LABEL

DESCRIPTION

Current System Date Time Setting
Current Time

This field displays the time used by your NAS for its logs and alerts.

Current Date

This field displays the date used by your NAS for its logs and alerts.

Date Time Setup
Manual

Select this radio button to enter the time and date manually.
When you enter the time settings manually, the NAS uses the new setting once you click
Apply.

Note: If you enter time settings manually, they revert to their defaults when power is lost.
New Date
(yyyy-mm-dd)

This field displays the last updated date from the time server or the last date configured
manually.
When you set Time and Date Setup to Manual, enter the new date in this field and
then click Apply.

New Time
(hh:mm:ss)

This field displays the last updated time from the time server or the last time configured
manually.
When you set Time and Date Setup to Manual, enter the new time in this field and
then click Apply.

Get from Time
Server

Select this check box to have the NAS get the time and date from the time server you
select in the Time Server Address field.

Time Server
Address

Select a time server from the drop-down list box or select Specify my own time server
and enter the time server you wish to use in the field below. Check with your ISP/network
administrator if you are unsure of this information.

Synchronize
Now

Click this for the NAS to retrieve the correct time from the configured time server right
away.

Time Zone
Time Zone

Choose the time zone of your location. This will set the time difference between your time
zone and Greenwich Mean Time (GMT).

Manual Daylight
Saving

Daylight saving is a period from late spring to fall when many countries set their clocks
ahead of normal local time by one hour to give more daytime light in the evening.
Select this option to manually enter Daylight Saving Time settings. Clear this option to
have the NAS automatically retrieve Daylight Saving Time settings from the Internet. The
NAS will download a new daylight saving resource file from the Internet every month.

Start Date

Configure the day and time when Daylight Saving Time starts if you selected Enable
Daylight Saving. The hour field uses the 24 hour format. Here are a couple of
examples:
Daylight Saving Time starts in most parts of the United States on the second Sunday of
March. Each time zone in the United States starts using Daylight Saving Time at 2 A.M.
local time. So in the United States you would use March, Second, Sunday, at 2:00.
Daylight Saving Time starts in the European Union on the last Sunday of March. All of the
time zones in the European Union start using Daylight Saving Time at the same moment
(1 A.M. GMT or UTC). So in the European Union you would select March, Last, Sunday.
The time you specify depends on your time zone. In Germany for instance, you would
type 2 because Germany's time zone is one hour ahead of GMT or UTC (GMT+1).
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Table 66 System Setting > Date/Time (continued)
LABEL

DESCRIPTION

End Date

Configure the day and time when Daylight Saving Time ends if you selected Enable
Daylight Saving. The o'clock field uses the 24 hour format. Here are a couple of
examples:
Daylight Saving Time ends in the United States on the first Sunday of November. Each
time zone in the United States stops using Daylight Saving Time at 2 A.M. local time. So
in the United States you would select November, First, Sunday, at 2:00.
Daylight Saving Time ends in the European Union on the last Sunday of October. All of the
time zones in the European Union stop using Daylight Saving Time at the same moment
(1 A.M. GMT or UTC). So in the European Union you would select October, Last,
Sunday. The time you specify depends on your time zone. In Germany for instance, you
would type 2 because Germany's time zone is one hour ahead of GMT or UTC (GMT+1).

Offset

Specify by how many hours to change the time for Daylight Saving Time.

Apply

Click this to save your changes. If you configured a new time and date, Time Zone and
Daylight Saving at the same time, all of the settings take affect.

Cancel

Click this to restore your previously saved settings.
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17

Applications
17.1 Overview
This chapter discusses the features in the Application screens. The NAS contains various
applications for file sharing and downloading.

17.2 What You Can Do
• Use the FTP Server screen (Section 17.4 on page 215) to configure settings for FTP file transfers
to/from the NAS.
• Use the Media Server screens (Section 17.5 on page 216) to share files with media clients.
• Use the iTunes Server screens (Section 17.6 on page 218) to share files with iTunes users on
your network.
• Use the Download Service screen (Section 17.7 on page 219) to download files from the
Internet.
• Use the Web Publishing screen (Section 17.8 on page 230) to publish shares for people to
access files using a web browser.
• Use the Print Server screen (Section 17.9 on page 231) to share a printer.
• Use the Copy/Sync Button screen (Section 17.10 on page 232) to transfer files between a USB
device and the NAS.
• Use the Auto Upload screens (Chapter 19 on page 262) to upload files in selected shares to
your Flickr and/or YouTube accounts.
• Use the Syslog Server screen (Section 17.12 on page 243) to configure the NAS to accept
syslog logs from syslog clients.
• Use the Dropbox screen (Chapter 20 on page 274) to log the NAS into your Dropbox account.
• Use the Time Machine screen (Chapter 21 on page 278) to turn Time Machine support on or off,
and designate the share for Time Machine backups.

17.3 What You Need to Know
FTP
File Transfer Protocol (FTP) is a file transfer service that operates on the Internet. A system running
the FTP server accepts commands from a system running an FTP client. FTP is not a secure
protocol. Your file transfers could be subject to snooping.
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FTPES (File Transfer Protocol over Explicit TLS/SSL)
File Transfer Protocol over Explicit TLS/SSL (FTPES) is a file transfer service that uses either TLS
(Transport Layer Security) or SSL (Secure Sockets Layer) for secure transfers across the Internet.
It requests for a mutual method of encryption from the FTP server for its file transfer sessions. Your
FTP client must be set to use FTPES as in the following example.
Figure 117 FTP Client Example

Media Server
The media server feature lets anyone on your network play video, music, and photos from the NAS
(without having to copy them to another computer). The NAS can function as a DLNA-compliant
media server and/or an iTunes server. The NAS streams files to DLNA-compliant media clients or
computers using iTunes. The Digital Living Network Alliance (DLNA) is a group of personal computer
and electronics companies that works to make products compatible in a home network.

iTunes Server
The NAS iTunes server feature lets you use Apple’s iTunes software on a computer to play music
and video files stored on the NAS. You can download iTunes from www.apple.com.

Download Service
The NAS’s download service downloads files from the Internet directly to the NAS. You do not have
to download to your computer and then copy to the NAS. This can free up your computer’s system
resources.
The NAS can download using these protocols.
• HTTP: The standard protocol for web pages.
• FTP: A standard Internet file transfer service.
• P2P download: Peer-to-peer files sharing protocol.
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Web Publishing
Web publishing lets you “publish” shares (containing folders and files) on the NAS so people can
access the files using a web browser without having to log into the Web Configurator. This way you
can share files with others without them having to know and enter a username and password.
For example, if you want to share photos in a FamilyPhotos share, you could “web publish” it and
others could use a web browser to access the photos at http://my-NAS’s-IP-Address/MyWeb/
FamilyPhotos.

RSS
RSS (Really Simple Syndication) is a format for delivering frequently updated digital content. A
channel uses a feed to deliver its contents (items). Subscribe the NAS to a feed to be able to
download the contents.

17.4 FTP Server Screen
Use FTP or FTPES (FTP over Explicit TTL/SSL) to upload files to the NAS and download files from the
NAS. Click Applications > FTP Server to open the following screen.
Figure 118 Applications > FTP Server

Cloud Storage User’s Guide

215

Chapter 17 Applications

The following table describes the labels in this screen.
Table 67 Applications > FTP Server
LABEL

DESCRIPTION

FTP
Enable FTP

You can use FTP to send files to the NAS or get files from the NAS. Select this check box
to allow users to connect to the NAS via FTP; otherwise clear the check box.

Connection Limit

Enter the maximum number of concurrent FTP connections allowed on the NAS in this
field. See your screen for your model’s connection limit.

Idle Timeout

Enter the length of time that an FTP connection can be idle before timing out. The
timeout limit is 300 minutes.

Port Number

This is the port number used by the NAS for FTP traffic.

Enable Anonymous
FTP Access

Select this check box to allow any user to log into the NAS using ‘FTP’ or ‘anonymous’
as a username and no password. Any other name is considered a username, so must be
valid and have a corresponding correct password.

Customize the port
range for data
transfer

Select this check box to assign a port range for FTP clients to use when downloading
files from the NAS using passive mode.
The connection limit is restricted to half of the port numbers within the range if this
value is smaller than the one configured in the Connection Limit field. For example,
you specified a port range from 1024 to 1029 and configured 10 in the Connection
Limit field. The FTP connection limit will only be 3 (6 ports in the range divided by 2)
because it is the smaller value.

Starting Port

Enter the first port number in the range. Choose from 1024 to 65535.

Ending Port

Enter the last port number in the range. Choose from 1024 to 65535.

Download/Upload
Rate For All Users
(include admin)

Select this if you want to limit the download/upload bandwidth for all users who are
logged into the NAS, including the administrator.
•
•

Download/Upload
Rate For
Anonymous Users

Select this if you want to limit the download/upload bandwidth for users who log into
the NAS using ‘FTP’ or ‘anonymous’ as a username and no password.
•
•

Character Set

Max. Download Rate - Enter the download speed (in kilobytes/s) that the NAS
allows for users who are logged into the NAS.
Max. Upload Rate - Enter the upload speed (in kilobytes/s) that the NAS allows for
users who are logged into the NAS.

Max. Download Rate - Enter the download speed (in kilobytes/s) that the NAS
allows for users who are logged into the NAS.
Max. Upload Rate - Enter the upload speed (in kilobytes/s) that the NAS allows for
users who are logged into the NAS.

The NAS uses UTF-8 (8-bit UCS/Unicode Transformation Format) format for FTP by
default. If the NAS’s folders, or file names do not display correctly in your FTP client,
select the appropriate language encoding here.
This setting applies to all FTP client connections to the NAS. It does not affect your
Windows/CIFS connections (it will not correct the character display in Windows
Explorer).

Apply

Click this to save your changes.

Reset

Click this to restore your previously saved settings.

17.5 Media Server Screens
The media server application allows you to share media files with media clients.
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Click Applications > Media Server to open the following screen. Use this screen to view the
media server’s status and rebuild the media server database.
Figure 119 Applications > Media Server > Media Server

The following table describes the labels in this screen.
Table 68 Applications > Media Server > Media Server
LABEL

DESCRIPTION

Enable Twonky
Media Server

Select this to have the NAS share the media files in the shares selected in the Share
Publish tab. Clear it to stop the NAS from sharing media files through the Playzone
screens or media players.
Click the hyper link to open the Twonky media server configuration screens to check
media server status or modify media server settings. See the help center in the Twonky
screens for details.

Apply

Click this to save your changes.

Reset

Click this to restore your previously saved settings.

17.5.1 Media Server Share Publish Screen
Click Applications > Media Server > Share Publish to open the following screen. Use this
screen to select shares to publish (share with media clients like a media player or iTunes).
Figure 120 Applications > Media Server > Share Publish

The following table describes the labels in this screen.
Table 69 Applications > Media Server > Share Publish
LABEL

DESCRIPTION

Publish

Select this to have the media server share a share’s media files with media clients.

Share Name

This column lists names of shares on the NAS.

Publish Music Tracks

Select this to give media clients access to the share’s music files.

Publish Photos

Select this to give media clients access to the share’s photo files.

Publish Videos

Select this to give media clients access to the share’s video files.

Cloud Storage User’s Guide

217

Chapter 17 Applications

Table 69 Applications > Media Server > Share Publish
LABEL

DESCRIPTION

Apply

Click this to save your changes.

Reset

Click this to restore your previously saved settings.

17.5.2 Media Server Logitech® Media Server Screen
Logitech® Media Server enables you to manage a Logitech Squeezebox device connected to the
NAS.
Click Applications > Media Server > Logitech® Media Server to open the following screen.
This screen is available when the Logitech® Media Server application is installed using Package
Management (see Section 17.5.2 on page 218). Use this screen to turn the Logitech® Media Server
application on or off.
Figure 121 Applications > Media Server > Logitech® Media Server

The following table describes the labels in this screen.
Table 70 Applications > Media Server > Logitech® Media Server
LABEL

DESCRIPTION

Enable Logitech®
Media Server

Check this to enable Logitech® Media Server.

Apply

Click this to save your changes.

Reset

Click this to restore your previously saved settings.

Click the hyper link to open the Logitech media server screens where you can play files
and change settings See the help center in the Logitech media server screens for
details.

17.6 iTunes Server Screen
Click Applications > iTunes Server to open the following screen. Use this screen to turn the
iTunes server on or off.
Figure 122 Applications > iTunes Server
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The following table describes the labels in this screen.
Table 71 Applications > iTunes Server
LABEL

DESCRIPTION

Enable iTunes
Server

Check this to let anyone on your network use iTunes to play music files in the published
shares.

Apply

Click this to save your changes.

Reset

Click this to restore your previously saved settings.

17.7 Download Service Screen
The Download Service screen allows you to download files from the Internet.
Click Applications > Download Service to open the following screen. Use this screen to manage
the NAS’s file downloads.

Note: By default, the NAS saves downloads in the admin share’s download folder.
Figure 123 Applications > Download Service

The following table describes the labels in this screen.
Table 72 Applications > Download Service
LABEL

DESCRIPTION

Enable Download
Service

Use this option (and click the Apply button) to turn the download service off or on. If you
turn off the service, all downloads are paused. Files currently downloading are queued.
Turning on the download service resumes downloads (or restarts them if they are not able
to resume).

Enable Download
Notify

Use this option (and click the Apply button) to turn the download service notification off
or on. See Section 17.11.3 on page 236 for more details about this feature.
At the time of writing, the NAS supports RSS 2.0 feeds.
Click this to get and subscribe to the NAS channel feed. This enables you to keep track and
download the NAS’s new contents (items).

Add

After you find a file to download, copy the file’s URL. Then log into the NAS web
configurator and go to the Applications > Download Server screen and click this
button. A screen opens where you create a new download task. You can paste the file’s
URL or use a P2P download file.

Cloud Storage User’s Guide

219

Chapter 17 Applications

Table 72 Applications > Download Service (continued)
LABEL

DESCRIPTION

Preferences

Click this to open a screen where you can set the default location for saving downloads
and configure your P2P download settings.

Refresh

Click this to update the information displayed on the screen.

Select Files

A single P2P download torrent file is often for multiple files. If you do not need all of the
files the torrent file specifies, click this to select which files to download.

Delete

To delete download tasks (or manually clear out completed download tasks), select a
download task and click this to remove it from the list. A pop-up screen asks you to
confirm. Click Apply to delete or Cancel to quit. When you delete a download task, you
are given the option to delete the associated files. Selecting this option deletes a
downloaded file and in the case of a P2P download task, also deletes the related .torrent
file.
Use your keyboard’s [SHIFT] key to select a range of download tasks. Use the [CTRL] key
and click individual download tasks to select multiple individual download tasks.

Pause

Select a downloading item and click this to temporarily stop the download. Paused
downloads appear in the Download Service screen’s Inactive tab.
Use your keyboard’s [SHIFT] key to select a range of download tasks. Use the [CTRL] key
and click individual download tasks to select multiple individual download tasks.

Resume

Select a paused item and click this to continue downloading the file.
Select a completed item and click this to re-seed a P2P file or download a file again. If you
want to re-seed a P2P task, keep the P2P file and the completed file in their original
locations.

Task Info

Select an item on the list and click this to display information about the download task.
See Section 17.7.6 on page 229 for more details.

The table lists your downloads. Click a column’s heading to sort the entries by that criteria.
Active

Click this to see the list of files the NAS is currently downloading or sharing with other P2P
users. The NAS handles a maximum of 10 active tasks at a time (or fewer depending on
how much of the NAS’s system memory is available). If you add more, they appear in the
Inactive tab.
P2P downloads may appear in the Inactive tab for a while before showing in the
Downloading tab. The NAS automatically moves completed tasks to the Completed tab.

Inactive

Click this to see the list of files that are queued (waiting in line) for the NAS to download or
the downloads that have been manually paused.

Completed

Click this to see the list of files that the NAS has finished downloading.
The Location column shows where a downloaded file is saved on the NAS. Click on the
location link to open the share browser and access the file.

Error

Click this to see the list of files that the NAS was not able to download. The NAS
automatically retries unsuccessful download attempts. The download displays in the error
tab when the re-attempts are also unsuccessful and the NAS stops trying to download the
file. To try the download again, use the Add button to create a new download task.
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Table 72 Applications > Download Service (continued)
LABEL
Status

DESCRIPTION
The following icons show the download’s status.

Completed: The NAS has downloaded the whole file.
Seeding: The download is finished and the NAS is allowing other P2P users to download
it.
Downloading: The NAS is getting the file.
Queued: The download is waiting in line for the NAS to download it.
Pause: The download has been manually stopped. Select it and click Resume to continue
it.
Error: The NAS was not able to complete the download. Select it and click Resume to
reattempt the download.
Name

This identifies the download file. A “...” indicates an abbreviated name. Hold your cursor
over the name to display the full name.

Complete
(%)

This is the percentage of the file that the NAS has downloaded.

Location

This appears in the Completed tab.
It displays the path for where the file is saved. Click on the location link to open the share
browser and access the file.

Seeds

Seeds apply to P2P downloads. This is the number of computers that are sharing the
complete file that you are downloading.
This value is in the format “Leeches(Seeds)” where Leeches refer to peers that do not
have a complete copy of the file yet and are still downloading; Seeds refer to peers that
have the complete file.

Peers

Peers apply to P2P downloads. This is the number of other computers that are also
downloading (and sharing) the file you are downloading.
This value is in the format “ConnectedPeers(AllPeers)[Health]” where Connected Peers is
the number of computers to which the NAS is connected in order to download the file;
AllPeers refer to the total number of computers to which the NAS can connect in order to
download the file; Health indicates the availability of the file.

Download
Speed

This is how fast the NAS is getting the file.

Upload Speed

This is how fast the NAS is sending the file to other P2P users.

Time Left

This is how much longer (in hours, minutes, and seconds) it should take to finish the
download at the current download speed.

Priority

This is the download’s priority on the NAS. You can set a currently downloading or queued
download to high or automatic priority. You can set a download to high priority to have the
NAS try to download it before the other files. However the actual download speed depends
more on factors like the speed of you Internet connection, the speed of the download
source’s Internet connection, how many others are trying to download at the same time,
the peers and seeds available and general network conditions.

Error Code

This appears in the Error tab.

It is normal for a P2P download to start out with a slow download speed since it has to set
up numerous connections. The speed should increase as the download progresses and
decrease near the end of the download.

This shows the tag for the error that occurred.
Error
Message

This appears in the Error tab.
This message states what went wrong with the download.
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17.7.1 Adding a Download Task
Click Applications > Download Service > Add to open the following screen. Use this screen to
specify a file for the NAS to download. Section 14.7 on page 162 provides a tutorial on adding a
download task.
Figure 124 Applications > Download Service > Add

The following table describes the labels in this screen.
Table 73 Applications > Download Service > Add
LABEL

DESCRIPTION

Source
URL

Paste the URL or magnet link of the file you want to download into this field. The URL can
be for an HTTP, FTP, or P2P download. A magnet link is for a P2P download.
For a P2P download using a magnet link the NAS automatically downloads the file related
to the magnet link.
For a P2P download using a .torrent file, you can copy and paste the URL of the .torrent
file. The NAS will automatically download the .torrent file and use it. You do not have to
manually download the .torrent file or save it to your computer.

Note: Make sure the link opens either the file you want or a pop-up window about how to
handle the file.
It is also OK for the link to open a .torrent file. If you are redirected to a screen that says
the download should start in a few seconds, there may be a link to click if the download
does not start automatically. See if that link opens the file or the pop-up window.
Torrent File

A “torrent” file has information the NAS uses to do a P2P download. A torrent file uses a
.torrent extension. If you already have a torrent file saved on your computer, select the
Torrent File option and specify its path or click Browse and look for its location.
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Table 73 Applications > Download Service > Add (continued)
LABEL

DESCRIPTION

Location of
Downloaded Files

This shows where the NAS stores new downloads (Put incomplete downloads in) and
where the NAS moves completed downloads (Move completed downloads to).
The Share column shows the name of the share where the file is downloaded.
The Path column points to the location in the share where the NAS will save the
downloaded files.
•
•
•

Edit

P2P download jobs are stored in /*/incoming (where ‘*’ is a folder that you have set.)
HTTP/FTP jobs are stored in /* (where ‘*’ is a folder that you have set.)
All jobs triggered by RSS channels create the subfolder in /* using the channel name
where it store all files downloaded from that channel (where ‘*’ is a folder that you
have set.)

Click this to open the following screen where you can set the default folder location where
you “Put incomplete downloads in” and “Move complete downloads to”:.

•
•

Share - Select the share from the list.
Path - Type the folder location in the share directly or click Browse to open the
following screen and navigate to the file’s location.

•
•
•
•

Current Location - This is the location of the selected folder.
Folder Name - Enter a new folder name and click
to create it.
Type - This identifies the item as a folder or file.
Name - This is the name of the folder/file.

Select a folder. If you don’t select a folder, a forward slash (/) displays in the Path field.
All contents within the specified share are automatically selected.
Click Apply to save your settings and Cancel to close the screen.
Apply

Click this to save your changes.

Cancel

Click this to return to the previous screen without saving.

17.7.2 Configuring General Download Settings
Click Applications > Download Service > Preferences to open the following screen. Use this
screen to set the default location for saving downloads and configure the download period.
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Figure 125 Applications > Download Service > Preferences > General Settings

The following table describes the labels in this screen.
Table 74 Applications > Download Service > Preferences > General Settings
LABEL

DESCRIPTION

Location of
Downloaded Files

This shows where the NAS stores new downloads (Put incomplete downloads in) and
where the NAS moves completed downloads (Move completed downloads to).
The Share column shows the name of the share where the file is downloaded.
The Path column points to the location in the share where the NAS will save the
downloaded files.
•
•
•

Edit

P2P download jobs are stored in /*/incoming (where ‘*’ is a folder that you have set.)
HTTP/FTP jobs are stored in /* (where ‘*’ is a folder that you have set.)
All jobs triggered by RSS channels create the subfolder in /* using the channel name
where it store all files downloaded from that channel (where ‘*’ is a folder that you
have set.)

Click this to open the following screen where you can set the default folder location where
you “Put incomplete downloads in” and “Move complete downloads to”:.

•
•

Share - Select the share from the list.
Path - Type the folder location in the share directly or click Browse to open the
following screen and navigate to the file’s location.
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Table 74 Applications > Download Service > Preferences > General Settings (continued)
LABEL

DESCRIPTION

•
•
•
•

Current Location - This is the location of the selected folder.
Folder Name - Enter a new folder name and click
to create it.
Type - This identifies the item as a file or folder.
Name - This is the name of the folder/file.

Select a folder. If you don’t select a folder, a forward slash (/) displays in the Path field.
All contents within the specified share are automatically selected.
Click Apply to save your settings and Cancel to close the screen.
Download Period
Control

This feature sets the NAS to download files only within a specified time period.

Enable Download
Period Control

Use the check box to turn the download period control on or off.

Download Service
is active in the
time period
(hh:mm hh:mm)

Specify the time period for the NAS to download files.

Apply

Click this to save your changes.

Reset

Click this to restore your previously saved settings.

Cancel

Click this to return to the previous screen without saving.

Note: If you also configured the Power On/Off Schedule feature in the Power
Management screen, make sure your active download period does not conflict with
the power-off period.

17.7.3 Configuring the P2P Download Settings
Click Applications > Download Service > Preferences > P2P download to open the following
screen. Use this screen to configure P2P download settings.
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Figure 126 Applications > Download Service > Preferences > P2P download

The following table describes the labels in this screen.
Table 75 Applications > Download Service > Preferences > P2P download
LABEL

DESCRIPTION

Port Number

Assign a port number for P2P downloads. You can select a number from 2 to 65536. It
is recommended to use a port number greater than 1025.

DHT

Select Enable or Disable to use Distributed Hash Table (DHT) or not.

Note: When you use DHT, the NAS will also attempt to open a UDP port one number
smaller than the P2P download port number. So if the P2P download port number
is 9090, the NAS uses UDP port 9089.
Max. download rate

You may need to limit the bandwidth the NAS uses for P2P downloads if your network’s
other Internet applications are not getting enough downstream bandwidth. 0 has the
NAS impose no restriction.

Max. upload rate

You may need to limit the bandwidth the NAS uses to share files through P2P download
if your network’s other Internet applications are not getting enough upstream
bandwidth. 0 has the NAS impose no restriction.
If you do not allow any uploads, (for example, you set a limit of 1 KB/s) you will not
have a good standing in the P2P download community.

Note: The settings for maximum download/upload rates would not affect peers accessing
the NAS from the same LAN.
Maximum Number
of Active Torrents

Specify how many simultaneous P2P downloads are allowed on the NAS. You can enter
a number from 1 to 10.

Maximum Number
of Seeding Jobs

Specify how many simultaneous seeds are allowed on the NAS. Enter a number from 1
to 10. This value cannot exceed the one you configured in the Maximum Number of
Active Torrents field.

Maximum Number
of Active
Connections

Specify how many active connections are allowed on the NAS. Enter a number from 1 to
500. This specifies the number of computers that can connect to the NAS to download
files being shared by the NAS.
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Table 75 Applications > Download Service > Preferences > P2P download (continued)
LABEL

DESCRIPTION

Keep Sharing While

With P2P download, the NAS starts sharing a file while you are downloading it. Set how
long to continue sharing a file after the NAS finishes the download.
Select Upload/Download Ratio to keep sharing a file until the NAS has uploaded a
specific percent compared to the download.
Select Seeding Time to keep sharing a file for a specific number of minutes after the
download finishes.
Continuing to share a file helps other P2P download users finish downloading it. Sharing
out at least as much as you download helps keep you in good standing in the P2P
download community.
Enter -1 to share a file indefinitely. Leave both check boxes blank to have the NAS stop
sharing the file as soon as the download finishes.
If you select both options, the NAS keeps sharing a file until both conditions exceed the
values you configure. For example, you entered 150% in the Upload/Download Ratio
field and 120 minutes in the Seeding Time field. The NAS keeps sharing a file until it
has shared 1.5 times the size of the file and has passed 120 minutes.

Email notifications

Select whether or not to send emails to the email address configured for emailing log
reports (see Section 26.4.2 on page 308) when the NAS starts downloading the file,
seeding the file, and/or finishes downloading the file.

Edit IP Filter

Click this to enable or disable IP filtering for P2P downloads.
Refer to Section 17.7.4 on page 227 for information about the fields in this screen.

Apply

Click this to save your changes.

Reset

Click this to restore your previously saved settings.

Cancel

Click this to return to the previous screen without saving.

17.7.4 Edit IP Filter
Use this screen to enable or disable IP filtering for P2P downloads. IP filtering blocks IP addresses
known to share fake files. You can either get an IP filter table from a website or use your own table.
Click Edit IP Filter in the Applications > Download Service > Preferences > P2P download
screen.
Figure 127 Applications > Download Service > Preferences > P2P download > Edit IP Filter
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The following table describes the labels in this screen.
Table 76 Applications > Download Service > Preferences > P2P download > Edit IP Filter
LABEL

DESCRIPTION

Enable IP Filter

Click this to enable or disable IP filtering for P2P downloads.

Update IP Filter
Table File from
the Internet
Every Week

Select this option and enter a URL to use an online IP filter table. You can find an online
IP filter table in websites such as http://www.bluetack.co.uk/config/level1.gz.

Upload IP Filter
Table

Select this option to upload your own IP filter table. Use the Browse button to locate
the file and click Upload to save it on the NAS.

When you change the URL of the online IP filter table, the NAS also performs an update
after you click Apply.

The NAS supports .txt, .dat, .gz, .tgz, and .tar.gz file extensions. The NAS saves the IP
filter table as /admin/download/ipfilter.dat.
Download Current
IP Filter Table

Click this to save a copy of the IP filter table on your computer.

Apply

Click Apply to update the IP filter table from the specified URL.

Cancel

Click this to return to the previous screen without saving.

17.7.5 Selecting Files to Download
Select an item in the Applications > Download Service screen’s list and click Select Files to
open the following screen. Use this screen to select which of the torrent’s files to download. Section
14.7 on page 162 provides a tutorial on adding a download task.
Figure 128 Applications > Download Service > Select Files

The following table describes the labels in this screen.
Table 77 Applications > Download Service > Select Files
LABEL

DESCRIPTION

Select Files
File Name

This is the name of a file specified in the torrent file. Select the check boxes of the files you
want to download.

Size

This is the size of the file to be downloaded.
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Table 77 Applications > Download Service > Select Files (continued)
LABEL

DESCRIPTION

Apply

Click this to save your changes.

Cancel

Click this to return to the previous screen without saving.

17.7.6 Displaying the Task Information
Select an item on the list and click Task Info. Use this screen to check detailed information about
the task.
Figure 129 Applications > Download Service > Task Info

The following table describes the labels in this screen.
Table 78 Applications > Download Service > Task Info
LABEL

DESCRIPTION

Status

This is the current status of the task.

Name

This is the name of the task.

Size

This is the size of the file to be downloaded.

Uploaded/
Downloaded Ratio

This is the ratio of total uploaded data to downloaded data.

Complete(%)

This field displays how much has been downloaded to the NAS.

Seeds

This is the number of computers that are sharing the complete file that you are
downloading.

Peers

This is the number of other computers that are also downloading (and sharing) the file
you are downloading.

Download Speed

This field displays how fast the NAS downloads the file.

Upload Speed

This field displays how fast the NAS uploads the file.
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Table 78 Applications > Download Service > Task Info (continued)
LABEL

DESCRIPTION

Health

This field displays how many full copies of the file are available for this task. The NAS
can download a file with a higher health value more efficiently. If the health value is less
than 1 (0.65 for example), there is no full copy of the file, and the NAS may not be able
to complete downloading the file.

Time Left

This is the time remaining to complete the task.

Priority

Use this field to set the priority for downloading the task.
Select Auto to have the NAS automatically determine the task’s priority.
Select High to have the NAS download this file before the other files.

Comment

Enter a description for this task. Click Apply to save the description.

Start Time

This field displays when the NAS started to download files.

Completed on

This field displays when the file was successfully downloaded to the NAS.

Info-Hash

This information is used to verify the torrent file.

Tracker

This field displays the tracker that NAS is currently connected to. A tracker is a server
used for finding peers sharing the file.

Close

Click this to close the screen.

17.8 Web Publishing Screen
Use this screen to turn web publishing on or off and select shares to publish. Click Applications >
Web Publishing to open the following screen.
Figure 130 Applications > Web Publishing

The following table describes the labels in this screen.
Table 79 Applications > Web Publishing
LABEL

DESCRIPTION

Web Publishing
Disable / Enable
Web Publishing

Turn on web publishing to let people access files in the published shares using a web
browser, without having to log into the Web Configurator.
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Table 79 Applications > Web Publishing (continued)
LABEL

DESCRIPTION

Support HTTPS

Select this to allow users to use web browser security for connections to the webpublished shares. In order to use secured connections users must use “https://” in the
NAS’s web address and install the NAS’s public key certificate.

Port Number

Specify a port number for accessing the published share websites hosted on the NAS. If
you enter a number other than 80, make sure you include it when telling others how to
access the web-published share. For example, say you specified port 8080, the NAS’s IP
address is 192.168.1.23, and the name of the web-published share is FamilyPhotos. You
would have to enter “http://192.168.1.23:8080/MyWeb/FamilyPhotos/” in your
browser’s address bar to access the share’s web page.

Unpublished Shares

This list box displays the shares that the NAS does not publish for web browser access.

Publish Selected
Share(s)

Select shares in the Unpublished Shares box and click this to let people access files in
the published shares using a web browser, without logging into the Web Configurator.
Use the [SHIFT] key to select a range of entries. Hold down the [CTRL] key to select
multiple individual entries.

Published Shares

This list box displays the shares people can access using a web browser, without logging
into the Web Configurator.

Unpublish Selected
Share(s)

Select shares in the Published Shares box and click this to not let people access using
a web browser without logging into the Web Configurator. Use the [SHIFT] key to select
a range of entries. Hold down the [CTRL] key to select multiple individual entries.

Apply

Click this to save your changes.

Reset

Click this to restore your previously saved settings.

Note: If you installed php-MySQL-phpMyAdmin through the Package Management
screen (Section 18.6 on page 251) and enable it, you can use PHP and MySQL in
your published web page.

17.9 Print Server Screen
Use the Print Server screen to view and manage the NAS’s list of printers and print jobs.
Click Applications > Print Server to open the following screen.
Figure 131 Applications > Print Server

The following table describes the labels in this screen.
Table 80 Applications > Print Server
LABEL

DESCRIPTION

Refresh

Click this to update the list of printers and print jobs.
The table lists printers and their queued print jobs. Click a column’s heading to sort the entries
by that criteria.

Status

This fields shows whether the printer is connected and turned on (on-line) or not (off-line).
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Table 80 Applications > Print Server (continued)
LABEL

DESCRIPTION

Name

This identifies the printer. Each printer connected to the NAS must use a unique name.

Actions

Rename: Click this to change the name the NAS uses for the printer.
Cancel Job: Click this to remove all print jobs from the NAS queue for a particular printer.
However, since the NAS sends print jobs to the printer as soon as it can, this button may only
have an effect if there are very large or many print jobs in the queue. To stop a print job that
has already started, you may have to turn off the printer.
Delete: Click this to remove a printer from the NAS’s printer list. To add the printer back into
the list, disconnect the printer from the NAS’s USB port and reconnect it. If that does not work,
disconnect the USB port and turn off the printer’s power. Then reconnect the printer and turn it
back on.

17.9.1 Print Server Rename
Click Applications > Print Server and a printer’s Rename icon to open the following screen. Use
this screen to change the name the NAS uses for the printer.
Figure 132 Applications > Print Server > Rename

The following table describes the labels in this screen.
Table 81 Applications > Print Server > Rename
LABEL

DESCRIPTION

Name

Type a new name to identify the printer. The name must be unique from all the other names of
printers connected to the NAS.

Apply

Click this to save your changes.

Cancel

Click this to return to the previous screen without saving.

17.10 Copy/Sync Button Screen
The Copy/Sync button on the front panel allows you to copy or synchronize files between a
connected USB or SD device and the NAS.
Click Applications > Copy/Sync Button to open the following screen.
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Figure 133 Applications > Copy/Sync Button

The following table describes the labels in this screen.
Table 82 Applications > Copy/Sync Button
LABEL

DESCRIPTION

Copy Settings
NAS Copy Target

Select the NAS share to use with the copy function.

USB Volume

If your USB or SD device has multiple partitions, select which partition to use with the
copy function.

Copy Direction

Select USB -> NAS to copy files from your USB or SD device to the NAS.
Select NAS -> USB to copy files from the NAS to your USB or SD device.

Create a New Folder
for Copied Files

Select this option to place the copied files in a new folder.

Backup Files to be
Replaced

This option is only available if you do not select Create a New Folder for Copied
Files. Select this option to save the files that will be replaced by the source files.

Backup Target

The name of the folder created for the copied files consists of the date and time of the
copy in year_month_day_hour_minute_second format.

Select a share in which to save the backup files.

Note: The NAS will not create a new folder to store the backup files. It is recommended to
create a specific share (such as “backup”) for backup purposes.
Sync Settings
NAS Sync Target

Select the NAS share to use with the synchronization function.

USB Volume

If your USB device has multiple partitions, select which partition to use with the
synchronization function.

Sync Direction

Select USB -> NAS to synchronize files from your USB or SD device to the NAS.
Select NAS -> USB to synchronize files from the NAS to your USB or SD device.
Select NAS <-> USB to synchronize files in both directions simultaneously.
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Table 82 Applications > Copy/Sync Button (continued)
LABEL

DESCRIPTION

Backup Files to be
Replaced or
Removed

Select this option to save the files that will be replaced by the source files.

Backup Target

Select a share in which to save the backup files.

Note: The NAS will not create a new folder to store the backup files. It is recommended to
create a specific share (such as “backup”) for backup purposes.
Apply

Click this to save your changes.
The configuration file is saved on the USB device.

Reset

Click this to restore your previously saved settings.

17.11 Technical Reference
This section provides technical background information on the topics discussed in this chapter.

17.11.1 Sharing Media Files on Your Network
The media server feature lets anyone on your network play video, music, and photos from the NAS
(without having to copy them to another computer). The NAS can function as a DLNA-compliant
media server and/or an iTunes server. The NAS streams files to DLNA-compliant media clients or
computers using iTunes. The Digital Living Network Alliance (DLNA) is a group of personal computer
and electronics companies that works to make products compatible in a home network.
• Publish shares to let others play the contained media files.
• The media server is a convenient way to share files you download.
• Hardware-based media players can also play the files. See page 354 for the supported
multimedia file formats.

Note: Anyone on your network can play the media files in the published shares. No user
name and password or other form of security is used. The media server is enabled
by default with the video, photo, and music shares published.

Songs from the iTunes Store
After using iTunes on your computer to download songs from Apple’s iTunes Store, you can copy
them to the NAS. Many of these songs have DRM (Digital Rights Management). At the time of
writing, you can use your Apple account ID and password to authorize up to a total of five
computers to play the files. To authorize a computer, open iTunes and click Store > Authorize
Computer.
A link for the NAS in iTunes under SHARED. Click it to display the NAS’s published media files as
shown next.
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Figure 134 NAS link in iTunes

17.11.2 Download Service
The NAS’s download service downloads files from the Internet directly to the NAS. You do not have
to download to your computer and then copy to the NAS. This can free up your computer’s system
resources.
The NAS can download using these protocols.
• HTTP: The standard protocol for web pages.
• FTP: A standard Internet file transfer service.
• P2P download: Peer-to-peer files sharing protocol.

Note: Do not use the NAS for illegal purposes. Illegal downloading or sharing of files can
result in severe civil and criminal penalties. You are subject to the restrictions of
copyright laws and any other applicable laws and will bear the consequences of any
infringements thereof. ZyXEL bears NO responsibility or liability for your use of the
download service feature.

Torrent Files
The NAS needs a “.torrent” file for P2P download to download a file. The torrent file gives the NAS
information about the file to be downloaded (and shared) and the tracker(s) (computers) that
coordinates the distribution of the file.
When you add a P2P download task in the NAS’s web configurator screens, you can copy and paste
the URL of the torrent file. The NAS automatically downloads the torrent file and saves it in a
torrent folder within the folder where the NAS stores downloaded files (the admin share’s
download folder by default).
If you already have the torrent file saved on your computer, you can just specify its location when
adding a download task through the web configurator. Another method is to use FTP or a CIFS
program (Windows Explorer for example) to copy the torrent file into the torrent folder. The NAS
automatically uses the torrent file.
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After your P2P download and sharing are finished, you can go to the incoming folder within the
destination share or folder and delete the .torrent file if you need to free up hard disk space.

17.11.3 Download Service Notification
Use the download service notification to keep track of downloaded files on the NAS. You can
subscribe to the NAS’s download list on your computer. When the NAS finishes downloading new
files, your RSS reader displays the information and links for the files. You can also download the
files from the RSS reader to your computer.
See Section 14.7.3 on page 168 for a tutorial about using the download service notification.
In the Download Service screen, select Enable Download Notify and click Apply. An RSS feed
icon appears. Click the icon to subscribe to the NAS’s download list.

Note: The download service notification only keeps track of files downloaded via P2P
download.
Figure 135 Download Service Notification

17.11.4 P2P Download Security
When you download using P2P, you reveal your IP address. This increases the risk of hacking
attacks, which can be protected against by a good firewall.

Use a Hardware-based Firewall
Place a hardware-based firewall between your network and the Internet (a software-based firewall
on your computer would just protect the computer itself, not the NAS since your computer is not
between your NAS and the Internet).
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Figure 136 Firewall

Ideally your firewall should have the following:
• Stateful packet inspection to control access between the Internet and your network and protect
your NAS (and computers) from hacking attacks.
• IDP (Intrusion Detection and Prevention) to detect malicious packets within normal network
traffic and take immediate action against them.
• Anti-virus to check files you download for computer viruses.

P2P Download and Your Firewall
The anti-virus feature on a firewall probably cannot check P2P downloads for viruses, so use antivirus software on your computer to scan the NAS for viruses.
When you download using P2P download, many other P2P download users are also trying to
download the file from you. The firewall slows this down because by default, it only allows traffic
from the Internet in response to a request that originated on the LAN (it lets you get files from the
Internet and blocks those on the Internet from getting files from you).
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Figure 137 Firewall Blocking Incoming P2P Download Requests

To speed up P2P download file transfers, configure your firewall’s port forwarding to send incoming
TCP port 9090 and UDP port 9089 connections to the NAS. You probably need to use your firewall’s
HTML (web-based) configuration interface to set this up (see the firewall’s manual for details). You
may also have to configure a corresponding firewall rule.
Figure 138 Firewall Configured to Allow Incoming P2P Download Requests

17.11.5 Web Publishing Example
This example covers how to configure the Web Publishing screen to let people use a web browser
to access a share named FamilyPhotos without logging into the Web Configurator and shows how to
access the share through the Internet.
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1

Click Applications > Web Publishing and configure the screen as shown (enable the web
publishing and move FamilyPhotos over to Published Shares) and click Apply.
Figure 139 Applications > Web Publishing (Example)

2

Now open your web browser and type in the address of the NAS’s FamilyPhotos web page. In this
example, the NAS’s IP address is 192.168.1.33, and the name of the web-published share is
FamilyPhotos. So you would enter “http://192.168.1.33/MyWeb/FamilyPhotos/” in your browser’s
address bar. Then press [ENTER] or click Go. A screen displays listing the share’s files.
Figure 140 Browsing to an NAS Share Example

• Click a file’s link to open the file.
• Right-click a file’s link and select Save Target As.. (in Internet Explorer) to save a copy of the
file.
• Click a label in the heading row to sort the files by that criteria.
• To customize how the page looks and works, create an index.html or index.htm file and store it in
the share.
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17.11.6 Web Publishing
Web publishing lets you “publish” shares (containing folders and files) on the NAS so people can
access the files using a web browser without having to log into the Web Configurator. This way you
can share files with others without them having to know and enter a user name and password.
For example, if you want to share photos in a FamilyPhotos share, you could “web publish” it and
others could use a web browser to access the photos at http://my-NAS’s-IP-Address/MyWeb/
FamilyPhotos.

Note: The NAS does not use any security for the files in the published folders. It is not
recommended to publish shares if you do not have the NAS behind a good
hardware-based firewall. See page 236 for more on firewalls.
Additionally, you can use HTML editing software (not included) to create an index.html or index.htm
file to define and customize how your website works and looks.

Accessing Web-published Shares from the Internet
You need to use a public address to access the NAS’s web-published shares from the Internet. If
your NAS uses a private IP address, you may need to use the public IP address of your Internet
gateway and configure NAT or port forwarding on your Internet gateway and possibly firewall rules
in order to let people access the NAS’s web-published shares from the Internet.

Web Publishing Port Number
If the web-published shares use a port number other than 80 (the normal port for web traffic),
users must include it after the NAS’s IP address in order to access the NAS’s web-published shares.
For example, say you specified port 8080, the NAS’s IP address is 192.168.1.23, and the name of
the web-published share is FamilyPhotos. You would have to enter “http://192.168.1.23:8080/
MyWeb/FamilyPhotos/” in your browser’s address bar to access the share’s web page.
The NAS’s web configurator uses port 80. To make the web configurator more secure, you can have
the web-published shares use another port number. Then you can configure one set of firewall rules
and NAT or port forwarding settings on your Internet gateway specifically for allowing access to the
web-published shares and another separate set of rules for accessing the NAS’s web configurator.

17.11.7 Printer Sharing
The NAS can act as a print server. A print server lets multiple computers share a printer. Connect a
printer to the NAS’s USB port to let multiple computers on your network use it. See www.zyxel.com
for a list of compatible printers.
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Figure 141 Printer Sharing

17.11.8 Copying Files
You can copy files from a USB device to the NAS or from the NAS to a USB device. Simply press and
release the COPY/SYNC button to start copying files. See Section 17.10 on page 232 for details
about configuring the copy settings.
The following figure illustrates how copying files works when you copy files from a USB device to
the NAS. The same concept applies when you copy files from the NAS to a USB device.
Figure 142 Copying Files Example
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Both storage devices contain file A.
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• A copy of files A and B from the USB device is transferred to the NAS.
• File A from the USB device replaces file A on the NAS.

17.11.9 Synchronizing Files
Synchronization makes the contents on the target device identical to the ones on the source device.
You can synchronize files from a USB device to the NAS or from the NAS to a USB device. In
addition, you may also synchronize files in both directions simultaneously.
Press and hold the COPY/SYNC button until you hear a beep to synchronize files. See Section
17.10 on page 232 for details about configuring the synchronization settings.

USB -> NAS or USB <- NAS
When you synchronize files in one direction, contents on the source device replace the files on the
target device.
The following figure illustrates how synchronization works when you synchronize files from a USB
device to the NAS. The same concept applies when you synchronize files from the NAS to a USB
device.
Figure 143 Synchronizing Files Example 1
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Both storage devices contain A.
• A copy of files A and B from the USB device is transferred to the NAS.
• File A from the USB device replaces file A on the NAS.
• File C on the NAS is deleted.
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USB <-> NAS
When you synchronize files in both directions simultaneously, both storage devices transfer unique
files to one another. Files with the same file name are synchronized according to their modification
date/time. The difference in modification time between the two files has to be greater than five
minutes. More recently modified files overwrite the older ones during synchronization.
The following figure illustrates how synchronization works when you synchronize files in both
directions simultaneously.
Figure 144 Synchronizing Files Example 2
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A on the USB device and B on the NAS are modified more recently.
• File A from the USB device replaces file A on the NAS.
• File B from the NAS replaces file B on the USB device.
• A copy of file C from the USB device is transferred to the NAS.
• A copy of file D from the NAS is transferred to the USB device.

17.12 Syslog Server Screen
Use this screen to configure the NAS to accept syslog logs from syslog clients such as ZyXEL’s G4100 v2.

Note: You may need to configure any firewalls between the NAS and the syslog clients in
order to let the syslog traffic go to the NAS.
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Click Applications > Syslog Server to open the following screen.
Figure 145 Applications > Syslog Server

The following table describes the labels in this screen.
Table 83 Applications > Syslog Server
LABEL

DESCRIPTION

Enable Syslog
Server

Select this to have the NAS accept syslog logs from syslog clients. Clear it to
stop the NAS from accepting syslog logs from syslog clients.

Log Location

Click View Files to browse to where you want to store the syslog logs on the
NAS.

Shares

Select the share in which to store the syslog logs.

Path

Use this if you want to further specify a folder within the share. This field
displays the share folder’s path. Type the location of the folder using forward
slashes as branch separators or use Browse to find or create a folder on the
NAS.

After you click Apply in the Syslog Server screen the NAS creates a folder
for the current month’s logs. The folder’s name uses the year and month in
YYYYMM format.
Purge Policy

Select Enable Purge Policy and set a number of months in the Log
Deletion Interval field that displays to have the NAS delete the syslog
messages after keeping them for the specified period of time.
Regardless of how you set the purge policy, to save hard disk space the NAS
archives the syslog logs in a .tgz file on the second day of each month and
deletes the original folder and syslog files. The NAS creates a new folder for
the syslog logs it receives after that. You can use a zip program such as 7-zip
to open the archives.
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Table 83 Applications > Syslog Server (continued)
LABEL

DESCRIPTION

Log Format

Select the format you want to use for recording the received logs.
The Example item below the drop-down list boxes displays how the selected
custom format looks. For example, if you select Full Date, the individual log
entries would display with something like 2009 May 13 17:15:51 in front of
them.

Apply

Click this to save your changes.

Reset

Click this to restore the screen’s last-saved settings.
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Packages
18.1 Overview
This chapter describes screens for features you can add to the NAS by installing packages. See
Section 16.4 on page 207 for how to manage packages.

18.2 What You Can Do
• Use the NFS screen (Section 18.3 on page 247) to configure the Network File System (NFS)
settings of your NAS.
• Use the TFTP Server screen (Section 18.4 on page 250) to configure the NAS to accept log files
from TFTP clients.
• Use the pyLoad screen (Section 18.5 on page 251) to configure the NAS so you can have it
manage your downloads including those from one-click hosting sites.
• Use ownCloud (Section 18.6 on page 251) to store, synchronize, and share files, photos,
calendars, and more with computers and mobile devices using an ownCloud client.
• Use Memopal (Section 18.7 on page 254) to back up files on the NAS to your Memopal online
backup and storage account.
• Use the GoogleDriveClient screens (Section 18.8 on page 256) to synchronize local NAS shares
or folders and Google Drive accounts.
Access the following applications’ configuration screens through the Package Management
screen. Refer to the applications’ own documentation for further information.
• Gallery - This web-based application allows your NAS to host pictures. You can upload images in
your local computer or shares to this application. Use the Gallery administrator account (default
username admin, password 1234) to log into the Gallery console. There you can create accounts
for other users.
• Use Logitech® Media Server (Section 17.5.2 on page 218) to manage a Logitech Squeezebox
device connected to the NAS.
• The NZBGet news grabber helps download files from UseNet.
• PHP-MySQL-phpMyAdmin can be used to manage MySQL through the web. Enter 'root' as the
username and '1234' as the password to log in. This includes MySQL, PHP, and phpMyAdmin.
• Transmission - This Bit Torrent client supports adding tasks through torrent files and magnet
links.
• WordPress - This allows you to create and manage a blog. Use the WordPress administrator
account (default username admin, password 1234) to log in. You can then create accounts for
other users.
• myZyXELcloud-Agent - Use this to go to mycloud.zyxel.com to set up a free DDNS hostname
for the NAS so you can connect to it easily from the Internet.
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18.3 NFS Screen
Use this screen to enable and configure Network File System (NFS) settings on your NAS.
NFS is a client/server distributed file service that provides transparent file sharing for network
environments. This allows shared folders in your NAS to be accessible like a local folder in a user’s
computer.
Click Network > NFS to open the following screen.
Figure 146 Network > NFS

The following table describes the labels in this screen.
Table 84 Network > NFS
LABEL

DESCRIPTION

NFS Service
Enable NFS Server

Click this to employ NFS in your NAS.

Disable NFS Server

Click this to stop using NFS.
This makes all NFS shares unavailable.

Add NFS Share

Click this to add an NFS share.
Refer to Section 18.3.1 on page 248 for the Add NFS Share screen.

NFS Session

Click this to view active NFS sessions. You can see the list of users who have access to
the NFS shares.
Refer to Section 18.3.2 on page 249 for the NFS Session screen.

Edit NFS Share

Select an NFS share from the list and click this to edit it.
Refer to Section 18.3.1 on page 248 for the Edit NFS Share screen.

Delete NFS Share
(s)

Select an NFS share from the list and click this to delete it.

The table lists your NFS shares. Click a column’s heading to sort the entries by that criteria.
Status

This shows whether the share is active or not.

NFS Share Path

This shows the location of the share in the NAS.

Volume Name

This shows the volume where the NFS share is located.

DN/IP Filter

This shows which domain name(s) or IP address(es) have read/write access to the NFS
shares.
Refer to Section 18.3.1 on page 248 for the screen where you can configure this.

Comment

This shows a short description of the share.

You see a warning screen before you delete a volume.
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Figure 147 Delete an NFS Share

18.3.1 Add/Edit NFS Share
Use this screen to add or edit an NFS share.

Note: Some attributes of the NFS share cannot be edited.
Click Add or Edit in the Network > NFS screen to open the following:
Figure 148 Network > NFS: Add/Edit

The following table describes the labels in this screen.
Table 85 Network > NFS: Add/Edit
LABEL

DESCRIPTION

Volume Name

Select the volume where the folder you want to add as an NFS share is located.

NFS Share Name

Enter the name you want to give to the NFS share.

Full Path

This shows the location of the NFS share in the NAS.
The NFS server assigns this path to the share folder you input.

Comment

Enter a short description for the share.
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Table 85 Network > NFS: Add/Edit (continued)
LABEL

DESCRIPTION

DN/IP Filter

Enter the domain name(s) or IP address(es) that can have access to the NFS share.
Enter ‘*’ to make the share available to all users in the network. You can also enter a
wildcard, such as ‘*.domain.com’ to indicate that all users within that network have
access to the share.
Select the access rights you want to grant to each domain name or IP address you
enter and click Add.
•
•

Read Only - Users with this access right can only view and copy files in the NFS
share but cannot modify or delete them.
Read/Write - Users with this access right can view, edit or delete files in the NFS
share.

Note: NFS v4 supports Read/Write only, and NFS v3 supports both Read Only and
Read/Write.
Apply

Click this to save your changes.

Cancel

Click this to return to the previous screen without saving.

18.3.2 NFS Session
Use this screen to view a list of active NFS sessions. You can see which users are connected the NFS
shares.
Click NFS Session in the Network > NFS screen to open the following.
Figure 149 Network > NFS: NFS Session

The following table describes the labels in this screen.
Table 86 Network > NFS: NFS Session
LABEL

DESCRIPTION

Type

This shows if the NFS share is active or not.

NFS Share Path

This shows the location of the share in the NAS.

Username

This shows the username of the active user connected to the NFS share.

Connected At

This displays the date and time the user last connected to the NAS in year, month, day,
hour, minute, second format.

IP Address

This shows the IP address of the user accessing the NFS share.

OK

Click this to close the window.
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18.4 TFTP Server Screen
Trivial File Transfer Protocol (TFTP) is an Internet file transfer protocol similar to FTP and often used
for transmitting large numbers of small files. Use this screen to configure the NAS to accept log files
from TFTP clients such as ZyXEL’s G-4100 v2.

Note: You may need to configure any firewalls between the NAS and the TFTP clients in
order to let the log files go to the NAS.
Click Applications > TFTP Server to open the following screen.
Figure 150 Applications > TFTP Server

The following table describes the labels in this screen.
Table 87 Applications > TFTP Server
LABEL

DESCRIPTION

Enable TFTP Server

Select this to have the NAS accept log files from TFTP clients. Clear it to stop the NAS
from accepting log files from TFTP clients.

Upload / Download
Directory Setting

Click View Files to browse to where you want to store the log files on the NAS.

Shares

Select the share in which to store the log files.

Path

Use this if you want to further specify a folder within the share This field displays the
share folder’s path. Type the location of the folder using forward slashes as branch
separators or use Browse to find or create a folder on the NAS.

Apply

Click this to save your changes.

Reset

Click this to restore the screen’s last-saved settings.

Cloud Storage User’s Guide

250

Chapter 18 Packages

18.5 pyLoad Screen
Use this screen to configure the NAS so you can use pyLoad to manage your downloads, including
those from one-click hosting sites.
Click Applications > pyLoad to open the following screen.
Figure 151 Applications > pyLoad

The following table describes the labels in this screen.
Table 88 Applications > pyLoad
LABEL

DESCRIPTION

Enable pyLoad

Select this to have the NAS manage your downloads. Clear it to turn the feature off.

Management Page

This is the IP address and port number of the NAS’s pyLoad management login screen.
The pyLoad management login screen uses the NAS’s IPv4 address and the port
number you configure. Click this link to go to it.

Username

Only the admin account can log into the pyLoad management screen.

Password

You can configure a separate password for using the admin account to access the NAS’s
pyLoad management screen.

Password (Confirm)

Type the same password again to make sure you entered it correctly.

Port Number

Set the pyLoad management page’s port number. The range of valid port numbers is
1024~65536. Include this port number after the IP address when manually entering
the pyLoad management login page’s address in your browser’s address bar. For
example, 192.168.1.2:7272.

Apply

Click this to save your changes.

Reset

Click this to restore the screen’s last-saved settings.

18.6 ownCloud Setup
Use the Package Management screen to install the ownCloud package. Use ownCloud to store,
synchronize, and share files, photos, calendars, and more with computers and mobile devices. Use
the following procedure to install the ownCloud package.
1

Click Packages > Package and select ownCloud. Then click the Install/Upgrade icon.

Note: If ownCloud does not appear, click the Retrieve List from Internet icon to update
the list.
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2

The following confirmation screen appears. Select the volume in which to install ownCloud and
store ownCloud data and click Apply. The NAS must have a connection to the Internet to download
the package.

3

The installation progress appears in the ownCloud row.

4

A link appears in the Management Page column after installation finishes. Click this link.
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5

The ownCloud login screen appears. Create an administrator user name and password and click
Finish Setup.

6

The main ownCloud screen displays. Use this web interface to manage files on the NAS ownCloud
server. Click your user name in the upper-right corner to see the help for more information on using
ownCloud.

Note: Get ownCloud desktop clients from owncloud.org and ownCloud mobile apps from
Google Play or the Apple App Store.
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18.7 Memopal
Install the Memopal package to back up folders of files on the NAS to your Memopal online backup
and storage account.

Note: Deleting files from your Memopal account’s online backup set does not delete the
files from the NAS, just as deleting a file from the NAS does not delete a backup
copy in your Memopal account’s online backup set.
Deleting a file or a folder from your Memopal account’s online backup set deletes all
versions of that file from the online backup set.
Click Applications > Memopal to open the following screen.
Figure 152 Applications > Memopal
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The following table describes the labels in this screen.
Table 89 Applications > Memopal
LABEL

DESCRIPTION

Status

This shows the status of the Memopal application’s interaction with the Memopal server.
Disabled: The NAS Memopal application is turned off.
Starting: The backup job is initializing and the NAS is getting ready to back up.
Running: The backup job is executing.
Stopped: The backup job is stopped. This may be due to a network error, remote
server error, or other issue.
Completed: The backup job finished.

To Backup

The number of files remaining to back up.

Backed up

The number of files backed up already.

Failures

The number of files the NAS failed to back up to the Memopal server.

Upload Speed

This is how fast in Bytes per second the NAS is backing up to the Memopal server.

Progress

This shows the percentage of the files already backed up from the total files to be
backed up.

Restart Backup

Re-scan all files and perform a backup.

Retry Failures

Only re-scan and back up files the NAS failed to back up.

Backup Report

Display back up record details.

Enable Memopal

Select this to back up files to your Memopal account. The rest of the configuration fields
display.

Email

Enter the email address you use for your Memopal account.

Password

Enter the password for your Memopal account.

Limit File Size

Select this and enter a number of MegaBytes if you want to restrict the size of files the
NAS uploads to the Memopal account. You have to enter your password again if you
select this.

Enable Schedule

Select this to set when the Memopal backups occur. You have to enter your password
again if you select this. Clear this to have the NAS back up files in the selected folders
to your Memopal account in real-time whenever you add or modify the files.

Weekly

Select this to perform a Memopal backup on a weekly basis. The NAS performs the
backup job every Sunday at 2:00 AM and continues until the job finishes.

Daily

Select this to perform a Memopal backup every day. The NAS performs the backup job
every day at 2:00 AM. Use hours to specify for up to how many hours the NAS can
perform a Memopal backup. Enter 0 in hours to have the NAS continue the backup job
until it finishes (no time limit).

Hourly

Select this to perform a Memopal backup every hour. Use minutes to specify for up to
how many minutes the NAS can perform a Memopal backup. Enter 0 in minutes to
have the NAS continue the backup job until it finishes (no time limit).

Share Name

This is the name of the share containing a folder the NAS Memopal application backs up
to the Memopal server.

Path

This field displays the share folder’s path.

Actions

Click the Delete icon to remove the folder from the list of folders the NAS Memopal
application backs up to the Memopal server.

Share

Select the share containing the folder to back up to the Memopal server.
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Table 89 Applications > Memopal (continued)
LABEL

DESCRIPTION

Path

Identify the folder to back up to the Memopal server.
Use Browse to find or create a folder on the NAS or type the location of the folder
using forward slashes as branch separators.
Click Add to add the folder to the list of folders the NAS Memopal application backs up
to the Memopal server.

Apply

Click this to save your changes.

Reset

Click this to restore the screen’s last-saved settings.

18.8 GoogleDriveClient
Use GoogleDriveClient to synchronize local NAS user folders and Google Drive cloud storage
accounts. This two-way synchronization means changes in the Google Drive account appear in the
local sync folder and changes in the local sync folder appear in the Google Drive account.

Note: Do not store your only copy of a document in Google Drive or the local sync folder.
• Modifying or deleting a file or folder at either end modifies or deletes it at the other end.
• Moving a file out of the local sync folder or Google Drive deletes it at the other end.
• Use the Protect screens instead of Google Drive for backups (see Chapter 27 on page 321).
• You can link multiple NAS user accounts to Google accounts.
• You can link an individual NAS user account to multiple Google accounts.
• You can only link each individual Google account to one NAS user account.
• This feature does not currently download Google Documents.

18.8.1 Account Setting Screen
Use the Account Setting screen to synchronize local NAS shares or folders and Google Drive
accounts.
Click Applications > GoogleDriveClient to open the following screen.
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Figure 153 Applications > GoogleDriveClient > Account Setting

The following table describes the labels in this screen.
Table 90 Applications > GoogleDriveClient > Account Setting
LABEL

DESCRIPTION

Linked Account

Select a Google account linked to an NAS user account.
Click Add to open a screen where you can link an NAS user account and a Google
account.
Click Delete to remove the NAS’s link to the selected Google account. You must disable
the Google Drive feature for the account before you can do this. A screen pops up to let
you decide what to do with the data in the NAS’s linked local sync folder.

Click Yes to delete all data in the local sync folder. Click No to remove the link to the
selected Google account but keep the data in the local sync folder. Click Cancel to do
nothing (keep the account link and data).
Binding User

The NAS user account linked to the selected Google account.

Cloud Storage User’s Guide

257

Chapter 18 Packages

Table 90 Applications > GoogleDriveClient > Account Setting (continued)
LABEL

DESCRIPTION

Status

The current status of the GoogleDrive feature for the selected Google account.
•
•
•

Disabled - The GoogleDrive feature is turned off. During this state you can use the
other sections of this screen to add or delete linked accounts or enable Google
Drive.
Enabled - Waiting - The GoogleDrive feature is configured, enabled, and waiting
to perform the next Google Drive update. During this state you can use the other
sections of this screen to add or delete linked accounts or disable Google Drive.
Enabled - Synchronizing - The GoogleDrive feature is synchronizing the local
sync folder and the Google account. During this state you can use the other sections
of this screen to add linked accounts during this state.

Local Sync Folder

The NAS folder or share the NAS synchronizes with the linked Google account.

Capacity

The Google account’s used, available, and total online Google Drive storage space.

Enable GoogleDrive

Select this to have the NAS periodically synchronize the selected linked account’s local
sync folder and Google Drive storage. You can enable synchronizing with Google Drive
for individual accounts and disable it for other accounts.
Clear this option to disable synchronizing the selected linked account’s local sync folder
and Google Drive storage.

Apply

Click this to save your changes.

18.8.2 Account Setting Add Screen
Use the Account Setting Add screen to link an NAS user account and a Google account. Click
Applications > GoogleDriveClient > Add to open the following screen.

Note: The user has to log into the Google account on the same computer to allow the
NAS to link to it.
Figure 154 Applications > GoogleDriveClient > Account Setting > Add
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The following table describes the labels in this screen.
Table 91 Applications > GoogleDriveClient > Account Setting > Add
LABEL

DESCRIPTION

Step 1

Specify the folder on the NAS to synchronize with Google Drive for the local user.

Share Name

The name of a share on the NAS containing the folder the NAS synchronizes with
Google Drive.

Path

The location of the folder the NAS synchronizes with Google Drive.

Edit

Click this to open the following screen where you can specify the share or folder to
synchronize with Google Drive. The NAS’s sharing configuration must allow the user
access. The user must also have a large enough quota on both the NAS and Google
Drive to hold whatever files go in the local sync folder and in the Google Drive account
(since they both end up containing everything you put in either).

•
•
Step 2

Share - Select the share from the list.
Path - Type the folder location in the share or click Browse to navigate to the
folder. Use a “/” to synchronize the entire share.

Select the local NAS user account to link with Google Drive.
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Table 91 Applications > GoogleDriveClient > Account Setting > Add (continued)
LABEL

DESCRIPTION

Step 3

Click the link to get the authorization code from Google. The user must sign into the
Google account. You may need to sign out of Google’s services first if another user
account is already signed in.

The NAS GoogleDriveClient feature uses the Grive app. Review what the Grive app
wants to use and click Accept if you agree.

Copy the code and paste it into the field in the Web Configurator screen.

Click Apply to have the NAS connect to Google and complete the authorization.
In the Account Setting screen, select the Enable Google Drive option and click
Apply to start synchronizing your files with Google Drive.
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Table 91 Applications > GoogleDriveClient > Account Setting > Add (continued)
LABEL

DESCRIPTION

Apply

Click this to save your changes and complete the authorization.

Cancel

Click this to return to the previous screen without saving.

18.8.3 Update Period Screen
Use the Update Period screen to set how often the NAS synchronizes with Google Drive. The NAS
initiates the connections, thus you do not have to configure rules on a firewall located in front of the
NAS to allow access.
Click Applications > GoogleDriveClient > Update Period to open the following screen.
Figure 155 Applications > GoogleDriveClient > Update Period

The following table describes the labels in this screen.
Table 92 Applications > GoogleDriveClient > Update Period
LABEL

DESCRIPTION

Update Period

Specify how frequently the NAS synchronizes the local sync folders and the linked
Google Drive accounts. The range is 1 to 4320 minutes (3 days).

Apply

Click this to save your changes.
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Auto Upload
19.1 Overview
This chapter discusses the features in the Auto Upload screens.
The auto upload feature uploads media files stored in the NAS to the Flickr and/or YouTube sharing
websites. Besides web publishing and media server, auto upload is another convenient way to share
media files with your friends and family. You can link the NAS to your Flickr and/or YouTube account
and select shares for the NAS to upload. The NAS uploads the media files stored in the specified
shares to your Flickr and/or YouTube account. When you add new files to the specified shares, the
NAS also automatically uploads the new files to your Flickr and/or YouTube account.

19.2 What You Can Do
• Use the Flickr/YouTube screen (Section 19.4 on page 262) to upload photos and videos to your
Flickr and YouTube accounts.
• Use the FTP Uploadr screen (Section 19.5 on page 270) to upload files to FTP servers.

19.3 What You Need to Know
FTP
File Transfer Protocol (FTP) is a file transfer service that operates on the Internet. A system running
the FTP server accepts commands from a system running an FTP client. FTP is not a secure
protocol. Your file transfers could be subject to snooping.

FTPES (File Transfer Protocol over Explicit TLS/SSL)
File Transfer Protocol over Explicit TLS/SSL (FTPES) is a file transfer service that uses TLS
(Transport Layer Security) or Secure Socket Layer (SSL) for secure transfers across the Internet.

19.4 Flickr/YouTube Screen
Use this screen to upload photos and videos to your Flickr and YouTube accounts.
Click Applications > Auto Upload > Flickr/YouTube to open the following screen.
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Figure 156 Applications > Auto Upload > Flickr/YouTube

The following table describes the labels in this screen.
Table 93 Applications > Auto Upload > Flickr/YouTube
LABEL

DESCRIPTION

Flickr/YouTube
Disable/Enable

Select a service from the list and click this to turn the service on or off.
If you disable the service and add more files to the watch folder(s), the NAS will not
auto upload these files. However, the NAS still uploads any files added before you
turned off the service.

Pause/Resume

Select a service from the list and click this to pause or resume the auto upload feature.

Config

Select a service from the list and click this to manage the service’s settings.

Status

This field displays the service’s status.
The service may be Enabled, Disabled, Uploading or Paused.

Service Name

This field displays the name of a sharing website to which the NAS can automatically
upload files.

Account
Information

This field displays the username and related information of the account to use with the
auto upload feature.

19.4.1 Configuring the Flickr Settings
In the Applications > Auto Upload > Flickr/YouTube screen, select Flickr from the list and
then click the Config button.
The following screen displays if you have not authorized the NAS to use a Flickr account. Click OK
to continue the authorization process.
Figure 157 Linking NAS to Flickr

The web browser opens the Yahoo! Flickr login page. Enter your Yahoo account’s information and
click Sign In.
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Figure 158 Yahoo! Flickr Login Page

The following page displays asking for your authorization. Click OK, I’LL ALLOW IT to establish a
link between the NAS and your Flickr account.
Figure 159 Flickr Authorization
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A confirmation page displays indicating successful authorization. Return to the NAS web
configurator. Click Get Ready in the following screen to complete the authorization process.
Figure 160 Confirming Flickr Authorization

Once the NAS is associated with your Flickr account, you can configure auto upload settings in the
following screen.
Figure 161 Applications > Auto Upload > Flickr/YouTube > Config (Flickr)
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The following table describes the labels in this screen.
Table 94 Applications > Auto Upload > Flickr/YouTube > Config (Flickr)
LABEL

DESCRIPTION

Flickr Account Configuration
Username

This field displays the Flickr account authorized for the auto upload feature.

Photo Space Usage

This shows how much storage space for photos (in size and percentage) you have
used and how much space is still available on your Flickr account.

Video Files Usage

This shows how many videos you have uploaded and how many videos you can still
upload to your Flickr account.

Switch User

Click this to use a different Flickr account for the auto upload feature.

Folder Selection
Folder Watch List
Status

This table displays a list of shares and folders selected for auto upload. Files stored in
these locations are uploaded to your Flickr account.
This indicates whether the folder or share is available.
represents a valid folder. The folder is available for auto upload.
represents a missing folder. The share may be deleted from the NAS, or the hard
disk was removed from the NAS.

Share Name

This is the share selected for auto upload.

Path

This is the path of a folder selected for auto upload. The NAS only uploads files stored
in the specified share or folder to your Flickr account.

Action

Use the Remove icon to remove a folder from the Folder Watch List.

Add

Click this to open the following screen where you can set a folder that contains files you
want the NAS to automatically upload.

•
•

Share - Select the share from the list.
Path - Type the folder location in the share directly or click Browse to open the
following screen and navigate to the folder’s location.

•
•
•
•

Current Location - This is the location of the selected folder.
Folder Name - Enter a new folder name and click
to create it.
Type - This is the type of the folder/file.
Name - This is the name of the folder/file.

Select a folder. If you don’t select a folder, a forward slash (/) displays in the Path field.
All contents within the specified share are automatically selected.
Click Apply to save your settings and Cancel to close the screen.
Grace Period
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Table 94 Applications > Auto Upload > Flickr/YouTube > Config (Flickr) (continued)
LABEL

DESCRIPTION

Grace Period N
minutes

Specify how long the NAS should wait when you add a new file for auto upload. For
example, if you set the grace period to 5 minutes, the NAS uploads a new file after it
has been in a watched folder for 5 minutes. You can choose from a range of 1 to 10080
minutes (up to one week).

Default Privacy
Who can see your
media files on
Flickr?

Determine who has the right to see files uploaded to your Flickr account.
Select Only You if you do not want anyone else to see your files. You may also restrict
the access to Your friends and/or Your family. You can set up a friend/family list in
your Flickr account.
Select Anyone to allow everyone to see your files.

Hide from public site
area

Check this option to prevent others from finding your files when they perform a search
in the Flickr website.

Default Safety Level

Assign a safety level to your files.
Select Safe if the contents of your files are suitable for the general public.
Select Moderate if the contents of your files may be offensive to some people.
Select Restricted if the contents of your files are not suitable for certain people, such
as children or your colleagues.

Default Content
Type

Select a content type for your files. You can choose Photo/Video, Screenshots/
Screencasts, or Illustration/Art/Animation/CGI.

Apply

Click this to save your changes.

Reset

Click this to restore previously saved settings.

19.4.2 Configuring the YouTube Settings
In the Applications > Auto Upload > Flickr/YouTube screen, select YouTube from the list and
then click the Config button.

Note: Your YouTube account must be associated with a Google account.
Get a Google account and use it to log into YouTube. You can then merge the existing YouTube
account to your Google account.
If you have not authorized a YouTube account on the NAS, the following screen displays. Enter your
Google account’s e-mail address and password in the fields and click OK to authorize the service.
Figure 162 YouTube Account Settings
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Once the NAS is associated with your YouTube account, you can configure auto upload settings in
the following screen.
Figure 163 Applications > Auto Upload > Flickr/YouTube > Config (YouTube)

The following table describes the labels in this screen.
Table 95 Applications > Auto Upload > Config (YouTube)
LABEL

DESCRIPTION

YouTube Account Configuration
Username
Switch User

This field displays the Youtube account authorized for the auto upload feature.
Click this to use a different YouTube account for the auto upload feature.

Folder Selection
Folder Watch List

This table displays a list of shares and folders selected for auto upload. Files stored in
these locations are uploaded to your YouTube account.
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Table 95 Applications > Auto Upload > Config (YouTube) (continued)
LABEL

DESCRIPTION

Status

This field indicates whether the share or folder is available.
represents a valid folder. The folder is available for auto upload.
represents a missing folder. The share may be deleted from the NAS, or the hard
disk was removed from the NAS.

Share Name

This field displays the share selected for auto upload.

Path

This field displays the path of a folder selected for auto upload. The NAS only uploads
the files stored in the specified share or folder to your YouTube account.

Action

Use the Remove icon to delete a folder from the Folder Watch List.

Add

Click this to open the following screen where you can set a folder that contains files you
want the NAS to automatically upload.

•
•

Share - Select the share from the list.
Path - Type the folder location in the share directly or click Browse to open the
following screen and navigate to the folder’s location.

•
•
•
•

Current Location - This is the location of the selected folder.
Folder Name - Enter a new folder name and click
to create it.
Type - This is the type of the folder/file.
Name - This is the name of the folder/file.

Select a folder. If you don’t select a folder, a forward slash (/) displays in the Path
field. All contents within the specified share are automatically selected.
Click Apply to save your settings and Cancel to close the screen.
Grace Period
Grace Period N
minutes

Specify how long the NAS should wait when you add a new file for auto upload. For
example, if you set the grace period to 5 minutes, the NAS uploads a new file after it
has been in a watched folder for 5 minutes. You can choose from a range of 1 to 10080
minutes (up to one week).

Video Category

Select the category that best describes the media files you want to upload.

Default Privacy
Who can see your
media files on
YouTube?

Determine who has the right to see files uploaded to your YouTube account.
Select Only You if you do not want anyone else to see your files.
Select Anyone to allow everyone to see your files.

Apply

Click this to save your changes.

Reset

Click this to restore your previously stored settings.
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19.5 FTP Uploadr Screen
The FTP Uploadr feature uploads files stored in the NAS to FTP servers. Besides web publishing and
media server, auto upload is another convenient way to share media files with your friends and
family. You can link the NAS to the FTP server or the FTP server on another NAS and select shares
or folders for the NAS to upload. The NAS uploads the files stored in the specified shares to the FTP
server. When you add new files to the specified shares, the NAS also automatically uploads the new
files to the FTP server.
Use this screen to configure the FTP Uploadr.
Click Applications > Auto Upload > FTP Uploadr to open the screen shown next.
Figure 164 Applications > Auto Upload > FTP Uploadr

The following table describes the labels in this screen.
Table 96 Applications > Auto Upload > FTP Uploadr
LABEL

DESCRIPTION

Enable FTP Uploadr

Use the check box to enable or disable the FTP Uploadr. Click Apply to save your
changes.
When you disable the FTP Uploadr, a screen opens requesting confirmation. Select the
check box to stop any current or queued uploads. If you do not select the check box,
the FTP Uploadr will finish uploading the files that are already in the queue list. Clicking
Yes will disable the FTP Uploadr.

Add Server

Click this to add a target FTP server entry. See Section 19.5.1 on page 271 for more
details.

Preferences

Click this to manage the settings of the FTP Uploadr.

Edit Server

Select a server from the list and click this to edit the FTP server entry.
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Table 96 Applications > Auto Upload > FTP Uploadr (continued)
LABEL

DESCRIPTION

Delete Selected
Server(s)

Select a server from the list and click this to remove the FTP server entry.

Server Information

Select a server from the list and click this to display the status and settings about the
FTP server.

Domain Name/IP
Address

This is the domain name or IP address of the FTP server.

Port Number

This is the port number used by the FTP server.

Remote Path

The NAS automatically uploads files to this location of the FTP server.

Account Name

This is the login account for the FTP server.

Description

This is the information related to the FTP server.

19.5.1 Adding or Editing an FTP Server Entry
Use this screen to add or edit an FTP server entry for auto upload.
In the FTP Uploadr screen, click the Add Server or Edit Server button to open the following
screen.
Figure 165 Applications > Auto Upload > FTP Uploadr > Add or Edit a Server

The following table describes the labels in this screen.
Table 97 Applications > Auto Upload > FTP Uploadr > Add or Edit a Server
LABEL

DESCRIPTION

Domain Name/IP
Address

Enter the domain name or IP address of the FTP server.

Account Name

Enter the account name used to access the FTP server.
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Table 97 Applications > Auto Upload > FTP Uploadr > Add or Edit a Server (continued)
LABEL

DESCRIPTION

Password

Enter the password associated with the account name.

Port Number

Enter the port number for the FTP server.

Remote Path

Enter the path of the FTP server where the NAS automatically uploads files.

Description

Enter additional information about this FTP server.

Test Connection

Click this to test your settings and check whether you can use the settings to connect to
the FTP server.

Apply

Click this to save your changes.

Cancel

Click this to return to the previous screen without saving.

19.5.2 FTP Uploadr Preferences Screen
Use this screen to configure the general settings for the FTP Uploadr.
In the FTP Uploadr screen, click the Preferences icon to open the following screen.
Figure 166 Applications > Auto Upload > FTP Uploadr > Preferences

The following table describes the labels in this screen.
Table 98 Applications > Auto Upload > FTP Uploadr > Preferences
LABEL

DESCRIPTION

Folder Watch List
Status

This field indicates whether the share or folder is available.
represents a valid folder. The folder is available for auto upload.
represents a missing folder. The share may be deleted from the NAS, or the hard
disk was removed from the NAS.

Share Name

This is the share selected for auto upload.

Path

This is the path of a folder selected for auto upload. The NAS only uploads files stored in
the specified share or folder to your FTP server.

Action

Use the Remove icon to delete a folder from the Folder Watch List.
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Table 98 Applications > Auto Upload > FTP Uploadr > Preferences (continued)
LABEL

DESCRIPTION

Add

Click this to open the following screen where you can set a folder that contains files you
want the NAS to automatically upload.

•
•

Share - Select the share from the list.
Path - Type the folder location in the share directly or click Browse to open the
following screen and navigate to the folder’s location.

•
•
•
•

Current Location - This is the location of the selected folder.
Folder Name - Enter a new folder name and click
to create it.
Type - This is the type of the folder/file.
Name - This is the name of the folder/file.

Select a folder. If you don’t select a folder, a forward slash (/) displays in the Path field.
All contents within the specified share are automatically selected.
Click Apply to save your settings and Cancel to close the screen.
Settings
Grace Period

Specify how long the NAS should wait when you add a new file for auto upload. For
example, if you set the grace period to 5 minutes, the NAS uploads a new file after it
has been in a watched folder for 5 minutes. You can choose from a range of 1 to 10080
minutes (up to one week).

Bandwidth Limit

Enter the maximum upload rate for auto upload. You can choose from a range of 0 to
100,000 KB/s. Enter 0 if you do not want to set any limit.
Use this to leave bandwidth on your network connection for other traffic, especially if
your Internet connection has restricted upload speed.

Apply

Click this to save your changes in this section.

Reset

Click this to restore previously saved settings.

Close

Click this to return to the previous screen without saving.
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20

Dropbox
20.1 Overview
The Dropbox Web-based file hosting service uses cloud computing to let you use file
synchronization to store and share files and folders with others across the Internet. Use your
Dropbox account to easily move files to your NAS and have the NAS download *.torrent files.

20.2 Dropbox Screen
Use the Dropbox screen to log the NAS into your Dropbox account. This creates Drop2NAS and
zDownload folders in your Dropbox account. See Section 20.3 on page 276 for how to use the
folders to move files to your NAS and have the NAS download *.torrent files. The NAS checks the
Dropbox account’s Drop2NAS and zDownload folders every three minutes.
Click Applications > Dropbox to open the following screen.
Figure 167 Applications > Dropbox
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The following table describes the labels in this screen.
Table 99 Applications > Dropbox
LABEL

DESCRIPTION

Status

This shows the status of the NAS Dropbox application’s interaction with the Dropbox
server.
Disable: The NAS Dropbox application is turned off.
Ready: The NAS Dropbox application has authenticated with the Dropbox server and is
ready to use.
Authenticating with Dropbox. Please wait.: The NAS Dropbox application is logging
into the Dropbox server.
Failed to negotiate link with Dropbox. Please contact your vendor.: The NAS
cannot find the Dropbox server at the normal address.
Receiving file/folder from Dropbox tunnel.: The NAS is getting a file from your
Dropbox account.
Dropbox account has been already used on other NAS.: One Dropbox account can
only work with one NAS at a time. Log the other NAS out of your Dropbox account to be
able to use the account with this NAS.

Name

This is the owner of the Dropbox account the NAS is configured to use.

Email

This is the e-mail address of the owner of the Dropbox account the NAS is configured to
use.

Logout

This displays after the NAS connects to Dropbox. Click Logout to stop syncing your
files with Dropbox and have the NAS log out from your Dropbox account. Use this to be
able to use the NAS with another Dropbox account. If you only want to stop syncing
your files with Dropbox, you can just clear the Enable Dropbox option and click
Apply.

Capacity

This shows how much total storage space is available on the NAS to use for Dropbox as
well as the amounts already in use and still available.
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Table 99 Applications > Dropbox (continued)
LABEL

DESCRIPTION

Enable Dropbox

Select this to synchronize and back up your Dropbox account. The first time you do this
a Dropbox screen prompts you to log into your Dropbox account.

Then a NAS pop-up opens. Click Get Ready.

Click Allow when the Dropbox screen notifies you of the NAS’s DropNAS application
trying to connect to your Dropbox account.

After the NAS connects to Dropbox, clear the Enable Dropbox option and click Apply
to stop syncing your files with Dropbox without logging out from your Dropbox account.
Click Logout instead to be able to use the NAS with another Dropbox account.
Apply

Click this to save your changes.

20.3 How to Use Dropbox with the NAS
Here is how to use the Drop2NAS and zDownload folders the NAS creates in your Dropbox account.

Using the Drop2NAS Folder
The NAS connects to Dropbox and copies files in the Drop2NAS folder to the NAS’s
admin\Dropbox\FromDropbox folder and empties the Drop2NAS folder. The NAS initiates
connections to the Dropbox server so you do not need to configure rules on a firewall in front of the
NAS to allow access to the NAS. Dropbox is not connecting to the NAS. When you upload files of the
same name to the Drop2NAS folder, the NAS adds a number to the names of the files in the NAS’s
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admin\Dropbox\FromDropbox folder in the format of “filename(n).extension”. Here is an example
of the Drop2NAS folder.

Note: Do not delete the NAStoken file as it is needed for your NAS to work with the
Dropbox account.
Figure 168 Dropbox\Drop2NAS

Using the zDownload Folder
The NAS copies *.torrent files in the zDownload folder to the NAS’s admin\download\torrents folder
and automatically starts downloading them. The NAS adds a suffix to the name of each torrent file
in the Dropbox account’s zDownload folder and keeps updating it to show the job’s state
(downloading, queued, paused, canceled, uploading, finished, error, or retrying). The NAS does not
take any action for folders nor other types of files in the zDownload folder. Here is an example of
torrent files in the zDownload folder.
Figure 169 Dropbox\zDownload
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21

Using Time Machine with the NAS
21.1 Overview
Time Machine is a backup system provided by Mac OS X. It automatically backs up everything on
your Mac, including pictures, music, videos, documents, applications, and settings. This chapter
helps you to enable Time Machine in OS X to use your NAS as a backup volume.

21.2 Time Machine Screen
Use the Time Machine screen to turn Time Machine support on or off, and designate the share for
Time Machine backups.
Click Applications > Time Machine to open the following screen.
Figure 170 Applications > Time Machine

The following table describes the labels in this screen.
Table 100 Applications > Time Machine
LABEL

DESCRIPTION

Enable Time
Machine

Select this to allow Macs to use Time Machine to back up to the NAS. Clear it to turn off
Time Machine support.

Share

Select the share the NAS uses to store Time Machine backups.

Apply

Click this to save your changes.

Reset

Click this to restore the screen’s last-saved settings.

21.3 Using Time Machine
After enabling Time Machine on the NSA, follow the steps below to set up Time Machine on your
Mac to use your NAS for backup.

Cloud Storage User’s Guide

278

Chapter 21 Using Time Machine with the NAS

1

Click Apple > System Preferences. Then go to System and select Time Machine.

2

Turn Time Machine ON. Then click Change Disk.

3

Select share01 as the backup disk. Then click Use for Backup.
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4

When prompted for the username and password of share01, enter the login information for an
existing user account with write access permission on share01 (for information on configuring user
accounts and shares see Section 14.6 on page 155). In this example user1/12345 is used. Then
click Connect.

5

Time Machine starts backing up files to share01 after 120 seconds. If you want to backup
immediately, click Time Machine icon and select Back Up Now.

6

The screen shows the status of the backup once the process begins.

7

To stop the backup process, click the Time Machine icon and select Stop Backing Up. Then turn
Time Machine OFF.
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22
Users

22.1 Overview
This chapter introduces the Users screens of the NAS. Use the Users screens to create and
manage administrator and user accounts.
Administrators can:
• Configure and manage the NAS.
• Create volumes, shares, and user accounts.
• Assign individual users specific access rights for specific shares.
Users are people who have access rights to the NAS and can store files there for later retrieval. A
user can:
• Manage shares that he owns.
• Change his own password.
• Access the contents of other shares to which he is given access rights.

22.2 What You Can Do
• Use the main Users screen (Section 22.3 on page 281) to display a list of user accounts created
on the NAS.
• Use the Add User screen (Section 22.3.2 on page 283) to create new user accounts.
• Use the Edit User screen (Section 22.3.2 on page 283) to edit the properties of an existing
account.
• Use the User Info screen (Section 22.4 on page 285) to display the amount of volume space
used by a selected account and the account’s membership in any groups.

22.3 Users Screen
Click Sharing > Users to display the screen shown next.
Use this screen to create and manage accounts for users who can store files on the NAS.
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Figure 171 Sharing > Users

The following table describes the labels in this screen.
Table 101 Sharing > Users
LABEL

DESCRIPTION

Add User

Click this to open a screen where you can configure a new user account.
Refer to Section 22.3.2 on page 283 to see the screen.

Search

Click this to display a search field. Type in the name of an account and then click
Search to look up the account you specified. Click Clear to close the search function.

Edit User

Select an account and click this to open a screen where you can edit the properties of
the account.
Refer to Section 22.3.2 on page 283 to see the screen.

Delete Selected
Users

Select an account and click this to open a screen where you can delete the user
account.

User Info

Select an account and click this to open a screen displaying the amount of storage space
used by the account. You can also check the account’s membership in any groups.
Refer to Section 22.4 on page 285 to see the screen.

Display Number

Click the drop-down menu to set how many accounts you want to display in one screen.

Go to Page

Click the drop-down menu to display and access more user accounts.
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Table 101 Sharing > Users (continued)
LABEL

DESCRIPTION

User Type

This field displays whether the account is an administrator account or a user account.

Username

This field displays the username of each account.

22.3.1 User Icons
The following table describes the user icons.
Table 102 User Icons
ICON

DESCRIPTION
The blue icon is for an administrator account.

The green icon is for a user account.

22.3.2 Adding or Editing an Account
Use this screen to create or edit a NAS user account with NAS access password.
Click the Add User button in the Users screen to open the following screens. Click the Edit User
button in the screen shown previously to edit an existing account.
Figure 172 Sharing > Users > Add or Edit a User: General Settings

Figure 173 Sharing > Users > Add or Edit a User: Quota (per volume)
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Figure 174 Sharing > Users > Add or Edit a User: General Settings

The following table describes the labels in these screens.
Table 103 Users > Add or Edit a User
LABEL

DESCRIPTION

General Settings

Click this to configure the user’s user name and password.

Username

Type a name from 1 to 32 single-byte (no Chinese characters allowed for example)
ASCII characters. See Section 22.3.3 on page 284 for more details on usernames.

New Password

Create a password associated with this user. You can type from one to 14 singlebyte (no Chinese characters allowed for example) ASCII characters.

Password (Confirm)

You must type the exact same password that you just typed in the above field.

Account Type

Select Administrator to give the account full configuration and management
access to the NAS.
Select User to give the account basic access rights to the NAS and allow the user to
manage his own shares, change his own password, and access the contents of other
shares to which he is given access rights.

Quota (per volume)

Click this to configure which volume the user can use and the allowed storage space.

Volume Name

Select the volume in which you want the user’s files to be stored.

Quota (per volume)

Enter how much space (in megabytes) you want to allow for the user to store files.

Group Membership

Click this to configure to which groups on the NAS the user belongs.

Available Group(s)

This field lists the groups created on the NAS to which the selected account does not
belong.

Group Membership

This field lists the groups that the selected account belongs to.

Add Selected
Group(s)

Select a group from the Available Groups list and click this to add the account to
that group.

Remove Selected
Group(s)

Select a group from the Group Membership list and click this to remove the
account from that group.

Apply

Click this to save your changes.

Cancel

Click this to return to the previous screen without saving.

22.3.3 Usernames
Enter a username from one to 32 characters. The first character must be alphabetical (case
insensitive, [A-Z a-z]); numeric characters are not allowed as the first character.
The username can only contain the following characters:
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• Alphanumeric A-z 0-9. Unicode usernames are supported with CIFS logins, but not FTP or web
configurator logins.
• Spaces
• _ [underscores]
• . [periods]
• - [dashes]
Other limitations on usernames are:
• All leading and trailing spaces are removed automatically.
• Multiple spaces within names are converted to a single space.
• Usernames are case insensitive. The username cannot be the same (no matter the letter case) as
an existing user. For example, if a user exists with the name 'BOB', you cannot create a user
named 'bob'. If you enter a user 'bob' but use 'BOB' when connecting via CIFS or FTP, it will use
the account settings used for 'bob'.
• The username cannot be the same as a system username such as ANONYMOUS-FTP nor be the
same as an existing user. Other reserved usernames that are not allowed are:
• bin
• daemon
• ftp
• anonymous-ftp
• anonymous
• nobody
• root
• pc-guest
• admin
• password

22.4 Displaying User Info
Use this screen to display a user’s information.
In the Users screen, select an account and click User Info to open the following screen.

Cloud Storage User’s Guide

285

Chapter 22 Users

Figure 175 Sharing > Users > User Info

The following table describes the labels in this screen.
Table 104 Sharing > Users > User Info
LABEL

DESCRIPTION

Username

This field displays the selected username.

Space Usage

Click this to display the amount of volume space used by the selected account.

Group List

Click this to display the selected user’s group membership.

Volume Name

This field displays the volume(s) created on the NAS.

Used Space

This field displays how much storage space the selected account is currently using. This only
applies for files that the user saved onto the NAS while logged in with that username.

Group Name

This shows when you click the Group List tab.
This displays the list of groups to which the selected user belongs.

OK

Click this to close the current screen.
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23
Groups

23.1 Overview
This chapter introduces the Groups screens. Use the Groups screens to create and manage
groups. You can assign users to groups and grant individual groups access rights to specific shares.

23.2 What You Can Do
• Use the main Groups screen (Section 23.3 on page 287) to display and manage a list of groups
created on the NAS.
• Use the Add Group screen (Section 23.3.1 on page 288) to create new groups.
• Use the Edit Group screen (Section 23.3.1 on page 288) to edit the properties of an existing
group.

23.3 Groups Screen
Use this screen to create and manage groups.
Click Sharing > Groups to display the screen shown next.
Figure 176 Sharing > Groups
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The following table describes the labels in this screen.
Table 105 Sharing > Groups
LABEL

DESCRIPTION

Add Group

Click this to open a screen where you can configure a new group.
ClickSearch
this to display a search field. Type the name of a group and then click
function.to look up the group you specified. Click Clear to close the search

Search

Edit Group

Select a group and click this to open a screen where you can edit the properties of
the selected group.

Delete Selected Group(s)

Select a group and click this to open a screen where you can delete the group.

Display Number

Click the drop-down menu to set how many groups you want to display in one
screen.

Go to Page

Click the drop-down menu to select a page number. Jump to a different page to
display and access more groups.

Status
Group Name

This field displays the group icon.
This field displays the group names created on the NAS.

23.3.1 Adding or Editing a Group
Use this screen to create or edit a NAS group.
Click the Add Group button in the Groups screen to open the following screen. Click the Edit
Group button in the screen shown previously to edit an existing group.
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Figure 177 Sharing > Groups > Add or Edit a Group

The following table describes the labels in this screen.
Table 106 Sharing > Groups > Add or Edit a Group
LABEL

DESCRIPTION

Group Name

Type a name from 1 to 32 single-byte (no Chinese characters allowed for
example) ASCII characters. See Section 23.3.2 on page 289 for more details on
group names.

Group Membership

Use this field to assign group membership to individual users.

Available User(s)

This field lists the user accounts created on the NAS that are not members of the
current group.

Group Membership

This field lists the user accounts added to the group.

Add Selected User(s)

Select a user account from the Available Users list and click this to add the
account to the group.

Remove Selected
User(s)

Select a user account from the Group Membership list and click this to remove
the account from the group.

Apply

Click this to save your changes.

Cancel

Click this to return to the previous screen without saving.

23.3.2 Group Names
Enter a group name from 1 to 32 characters. The first character must be alphabetical (case
insensitive, [A-Z a-z]); numeric characters are not allowed as the first character.
The group name can only contain the following characters:
• Alphanumeric A-z 0-9. Unicode usernames are supported with CIFS logins, but not FTP or web
configurator logins.
• Spaces
• _ [underscores]
• . [periods]
• - [dashes]
Other limitations on group names are:
• All leading and trailing spaces are removed automatically.
• Multiple spaces within names are converted to a single space.
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• Group names are case insensitive. The group name cannot be the same (no matter the letter
case) as an existing group. For example, if a group exists with the name 'FAMILY', you cannot
create a group named 'family'.
• The group name cannot be the same as a system group name such as EVERYONE nor be the
same as an existing group. Other reserved groups names that are not allowed are:
• nobody
• root
• everyone
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24
Shares

24.1 Overview
A share is a set of access permissions mapped to a specific folder on a volume. It is equivalent to
the Windows concept of a shared folder. You can map a share to a network drive for easy and
familiar file transfer for Windows users.

24.2 What You Can Do
• Use the Shares screen (Section 24.3 on page 291) to navigate a list of shares created on the
NAS.
• Use the Add Shares screen (Section 24.3.1 on page 293) to create additional shares on the
NAS.
• Use the Recycle Bin screen (Section 24.4 on page 295) to configure and clean up the recycle
bins.
• Use the Edit Share screen (Section 24.3.1 on page 293) to edit a share’s properties.
• Use the Share Browser screen (Section 24.5 on page 296) to navigate, add and edit the
contents in a share.

24.3 Shares Screen
Click Sharing > Shares in the navigation panel to open the following screen. This screen lists all
shares created on the NAS.
Figure 178 Sharing > Shares
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The following table describes the labels in this screen.
Table 107 Sharing > Shares
LABEL

DESCRIPTION

Add Share

Click this to create a new share.

Recycle Bin

Click this to configure recycle bins.

Edit Share

Select a share and click this to edit the share.

Delete Share

Select a share and click this to remove or restrict access to the share.

Share Browser

Select a share and click this to browse the share’s contents.

Status

This field displays the share icons.
represents a Built-in share on a volume on the internal hard drives.
represents a Predefined or User-Created share on a volume on the internal hard
drives.
represents an Auto or User-Created share on a volume on the external (USB)
devices.
represents a disabled share that no user can access.
represents a missing share. The NAS cannot find the hard disk associated with the
share (the disk may be removed from the NAS for example). You may install the disk
back to the NAS to recover the share, or you may delete the share from the NAS.

Share Type

This field displays Built-in for the admin share. If you delete the volume containing this
share, the NAS automatically creates an admin share in the next volume by alphabetical
order.
This field displays Predefined for default shares. Default shares, including music,
video, and photo, always exist as long as there is a volume. If you delete the volume
containing these default shares, the NAS automatically creates these shares in the next
volume by alphabetical order.
This field displays User-created for shares that an administrator has created. You can
delete these shares.
This field displays Auto for shares that are automatically created on an external (USB)
device when a user plugs in the device.

Share Name

This field displays the share’s names.

Share Path

This field displays the share’s file path, for example, volume1/music.
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Table 107 Sharing > Shares (continued)
LABEL

DESCRIPTION

Share Owner

This is the name of the user account to which this share belongs.

Permission Type

This field displays the access permission of a share.
Everyone on the network can access a Public share.
Only the share owner can access a Private share.
An Advanced share allows you to assign specific access rights (read-only for example)
to individual users/groups.

24.3.1 Adding or Editing Share
Click Add Share to create a new share. In the Shares screen, select a share and click Edit Share
to open the following screen. Use this screen to create or edit a share.
Figure 179 Shares > Add Share (or Edit Share)

The following table describes the labels in this screen.
Table 108 Shares > Add Share (or Edit Share)
LABEL

DESCRIPTION

Share Name

Type a share name from 1 to 239 single-byte (no Chinese characters allowed for example)
ASCII characters. The name cannot be the same as another existing share. See Section
11.2.2 on page 128 for more information on share names.

Volume

You should have already created volumes (a single accessible storage area with a single
file system) on the NAS. Select the one that contains the folder that you want to share out.
You cannot modify this when editing a share.

Make this share
owned by

Select the administrator or user account that can own (manage) this share. The share
owner controls access rights to the share.

Enable this share

Click this to allow access to this share.

Enable Recycle
Bin

Click this to activate the recycle bin. When you delete a file from this share, a recycle
folder is created to store the deleted item.

Publish this share
to Media Server

This option is available only when you enable the Media Server (Section 17.5 on page
216).
Select this option to have the NAS make media files in this share available to media clients
and through the Playzone screens. When you publish a share, you can also select whether
or not to publish music tracks, photos, and videos. The media clients do not have to use a
password to play the shares you publish.
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Table 108 Shares > Add Share (or Edit Share) (continued)
LABEL

DESCRIPTION

Publish this share
to Web

This option is available when you enable the Web Publish (Section 17.8 on page 230).

Share Access

Select this option to let people use a web browser to access this share’s files without
logging into the Web Configurator.
Assign access rights (full, read only or deny) to users or groups. If you publish the share
to the media server or the web, all users will have at least read-only access to the share,
regardless of what you configure here.
Keep it private to owner means only the share owner (selected above) can access the
share.
Make it Public means every user (including people who do not have accounts on the
NAS) can access the share.
Advanced allows you to assign specific access rights (full, read only or deny) to individual
users/groups.

Edit

This button is available only when you select Advanced share access. Click this to
configure advanced share access rights.

Apply

Click this to save your changes.

Cancel

Click this to return to the previous screen without saving.

24.3.2 Configuring Advanced Share Access
In the Sharing > Shares > Add Share or Edit Share screen, select Advanced from the Share
Access drop-down list. Click Edit to open the following screen. Use this screen to configure share
access rights for individual users and groups.
Figure 180 Sharing > Shares > Add Share (or Edit Share) > Advanced
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The following table describes the labels in this screen.
Table 109 Sharing > Shares > Add Share (or Edit Share) > Advanced
LABEL

DESCRIPTION

Available Users/Groups

This field lists the users/groups to which you can assign access rights.

Authority

Use this field to assign access rights to users/groups.
Full Control gives users/groups full access (read, write and execute) to all files
contained within this share.
Read-Only gives users/groups read-only access (they cannot modify nor
execute) to all files contained within this share.
Deny blocks access (users/groups cannot read, modify, nor execute) to all files
contained within this share.
Among all access rights, Deny has the highest priority. For example, User A
belongs to Group 1. You assign User A full access rights to the Music share but
deny access rights to Group 1. Then User A cannot access the Music share.

Note: If you deny access to all users, no-one can use the share, not even the
administrator.
Click an arrow button to move users/groups between the left and right fields. Use
the arrow buttons to assign access rights to users/groups.
Apply

Click this to save your changes.

Cancel

Click this to return to the previous screen without saving.

24.3.3 Public and ANONYMOUS Share Access Rights
If you make a share public, users do not need to log in.
With ANONYMOUS FTP, you must enter either 'anonymous' or 'ftp' as the username. Any other
name is considered a username, so must be valid and have a corresponding correct password.

24.4 Recycle Bin Configuration Screen
Use this screen to periodically clean up items in all recycle bins.

24.4.1 Recycle Bins
Recycle bins in the NAS help users recover accidentally deleted files or folders in the shares. When
you delete an item, a recycle folder is created within the share to hold the deleted item.
Every share can have its own recycle folder. You must enable the recycle-bin function to recycle
deleted items. You can configure this setting when you add or edit a share. See Section 24.4.2 on
page 296 for details on activating the recycle bin in a share.
Later if you want to retrieve a deleted item, you can locate the item in the recycle folder. You may
move or copy the deleted item to another share.
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24.4.2 Configuring Recycle Bins
In the Sharing > Shares screen, click Recycle Bin to open the following screen.
Figure 181 Sharing > Shares > Recycle Bin

The following table describes the labels in this screen.
Table 110 Sharing > Shares > Recycle Bin
LABEL

DESCRIPTION

Clean Recycle Bin every N
days

Specify how often you want to clear the contents in all recycle bins. The specified
days correspond to how long a file has been stored in a recycle bin. For example,
if you set the interval to be 3 days, recycle bins will clean up items deleted or not
accessed for 3 days.

Note: Cleaning up recycle bins permanently removes the files from the NAS.
Empty All Recycle Bins
Now

Click this to immediately remove contents from all recycle bins.

Apply

Click this to save your changes.

Cancel

Click this to return to the previous screen without saving.

24.5 Share Browser Screen
Use this screen to create folders, upload files, and edit files within the share.
Figure 182 Sharing > Shares > Share Browser
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The following table describes the labels in this screen.
Table 111 Sharing > Shares > Share Browser
LABEL

DESCRIPTION

Create Folder

Type a folder name and click Apply to make a new folder. The name can be 1 to 239 singlebyte (no Chinese characters allowed for example) ASCII characters. The name cannot be
the same as another existing folder in the same path. See Section 11.2.2 on page 128 for
more information on folder names.

Upload

Click this to add files to the share. Use Browse to locate a file and click Apply to upload the
file. Note that the size of each file should be less than 2 GB.

Rename

Select a folder or file and click this to open a screen. Enter the name you want and click OK
to make the changes.

Note: When you change a file name, make sure you keep the file extension

Delete

Select a file/folder from the list and click this to open a warning screen. Click Yes to delete
the file/folder, or click No to close the screen.

Move

Select a file/folder from the list and click this to relocate the file/folder to another share.

Copy

Select a file/folder from the list and click this to make a duplicate of the file/folder to
another share.

Current
location

This is the name of the share and folder path that you are in.

Type

The icon in this column identifies the entry as a folder or a file. Click a music or video file’s
play icon to play the file.
The folder with an arrow pointing up is for the link that takes you to the next higher layer in
the share’s folder tree.

Cloud Storage User’s Guide

297

Chapter 24 Shares

Table 111 Sharing > Shares > Share Browser (continued)
LABEL

DESCRIPTION

Name

This section lists the share’s existing folders or files. Click to the right of the file/folder name
to select the file/folder. You can also click the folder’s name to navigate to a sub-folder
within the folder.

Size

This field displays size of the file.

Modified Date

This field displays a file’s latest modification date.

Close

Click this to close the screen.

24.5.1 Moving or Copying Files
Use this screen to move or copy files to another share.
In the Share Browser screen, select a file or folder and click Move or Copy to open the following
screen.
Figure 183 Sharing > Shares > Share Browser > Move (or Copy)

The following table describes the labels in this screen.
Table 112 Sharing > Shares > Share Browser > Move (or Copy)
LABEL

DESCRIPTION

Shares

Select the destination share from the drop-down list.

Path

This field displays the share folder’s path. You can use Browse to find or create a folder on
the NAS or type the location of the folder using forward slashes as branch separators.

Browse

Click this to open the following screen and navigate to the location of the file/folder.

•
•
•
•

Current Location - This is the location of the selected folder.
Folder Name - Enter a new folder name and click
to create it.
Type - This identifies the item as a folder or file.
Name - This is the name of the folder/file.

Select a folder. If you don’t select a folder, a forward slash (/) displays in the Path field. All
contents within the specified share are automatically selected.
Click Apply to save your settings and Cancel to close the screen.
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Table 112 Sharing > Shares > Share Browser > Move (or Copy) (continued)
LABEL

DESCRIPTION

Yes

Click this to move or copy the file/folder to the designated share.

Close

Click this to return to the Share Browser screen.
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25

WebDAV
25.1 Overview
The WebDAV HTTP extension lets users edit and manage files stored on remote servers. The NAS’s
WebDAV service allows client programs that support WebDAV, such as NetDrive and BitKinex on
Windows, Mac OS Finder, and Linux file browsers remotely edit and manage files stored on the NAS.

25.2 WebDAV Screen
Use the WebDAV screen to allow remote users to use client programs that support WebDAV to edit
and manage files stored on the NAS.
Click Sharing > WebDAV to open the following screen.
Figure 184 Sharing > WebDAV

The following table describes the labels in this screen.
Table 113 Sharing > WebDAV
LABEL

DESCRIPTION

Enable WebDAV
(http/Https)

Select this to allow remote users to work with files stored on the NAS. Edit the access
privileges in Sharing > Shares.

Example

When you enable WebDAV the screen displays an example of the URL users would use
to use WebDAV to connect to the NAS where “sharename” represents a share that the
user can access. Use HTTPS for secure WebDAV connections to the NAS.

Enable anonymous
WebDAV

Select this to allow remote users to use WebDAV to access all shares on the NAS
without a login name or password.

Apply

Click this to save your changes.

Reset

Click this to discard any unsaved changes and restore previously saved settings.

Https is for secure WebDAV connections to the NAS.
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25.3 How to Use NetDrive with the NAS
Here is an example of how to use the NetDrive WebDAV client with the NAS.
1

Download and install NetDrive.

2

Click Add Drive and use the URL for WebDAV connections to the NAS to add a drive entry for
accessing the NAS.
Figure 185 NetDrive Example

3

Name the drive and specify the URL of the share to access. Select SSL if the NAS forces HTTPs use.
Specify your user name and password for accessing the share on the NAS.
Figure 186 NetDrive Add Drive
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26

Maintenance Screens
26.1 Overview
This chapter discusses the Maintenance screens. The Maintenance screens allow you to manage
system configurations.

26.2 What You Can Do
• Use the Power screen (Section 26.3 on page 302) to configure power settings for the NAS,
including power saving, UPS, power on/off after power failure, power on/off schedule, and Wake
on LAN.
• Use the Log screen (Section 26.4 on page 306) to check the system’s logs.
• Use the Configuration screen (Section 26.5 on page 310) to backup or restore the NAS
configuration file.
• Use the SSL screen (Section 26.6 on page 311) to configure HTTPS and the NAS’s SSL certificate.
• Use the Shutdown screen (Section 26.7 on page 313) to restart or shut down your NAS.
• Use the Unpair myZyXELcloud screen (Section 26.8 on page 314) to remove the pairing
between the NAS and the myZyXELcloud account.

26.3 Power Screen
Use this screen to manage power settings for the NAS.
Click Maintenance > Power to display the following screen.
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Figure 187 Maintenance > Power

The following table describes the labels in this screen.
Table 114 Maintenance > Power
LABEL

DESCRIPTION

Power Management
Turn off hard
disk(s)

Enter the number of minutes to wait when the NAS is idle before spinning the hard disks
down to sleep (hibernation). The default time is 15 minutes.

Enable Sleeping
HDD LED
Blinking

Select this to have the HDD LED blink slowly when the hard disk is sleeping (hibernating).
Clear this to have the HDD LED stay on when the hard disk is sleeping.

Minimum UPS Capacity
Minimum UPS
Capacity

When you use an APC Uninterruptible Power Supply (UPS) with a USB connection to the
NAS, the NAS shuts itself down if the APC UPS’s battery charge gets down to the
percentage you specify in this field. This allows the NAS to shut down properly and avoid
data loss caused by a power failure when the UPS stops supplying power.
A setting around 50% is recommended. A setting close to 100% is not recommended since
it would cause the NAS to shut down whenever the UPS is charging. A setting close to 0 is
also not recommended since the UPS would not have enough power to allow the NAS to
shutdown properly.

Power On After
Power Failure

Select an option to set whether or not the NAS restarts when the power is restored after a
power failure.

Note:

Keep Former
Status

Select this option to have the NAS automatically restart only if it was operating when the
power failed. The NAS remains off if it was already off when the power failed.

Always
Power On

Select this option to keep the NAS operating as much of the time as possible. The NAS
restarts automatically even if it was turned off when the power failed.
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Table 114 Maintenance > Power (continued)
LABEL
Always
Power Off

DESCRIPTION
Select this option to keep the NAS from automatically restarting when the power is
restored after a power failure. This is a computer’s “traditional” behavior. Select this if you
have other servers such as a domain controller or DNS server that you want to start or
check after a power failure before the NAS turns on.

Power On/Off Schedule
Enable Power
Control Schedule

Select this option to have the NAS turn itself off and on or reboot according to the
schedules you configured.
Click Edit to go to the screen where you can configure the power control schedules.
Refer to Section 26.3.1 on page 304 for this screen.
Note:

Enable Wake On
LAN

Enable Wake On LAN to be able to turn on the NAS through its wired Ethernet connection.
You must have a computer or router on your LAN that supports sending Wake On LAN
“magic packets” to turn on the NAS.
To use Wake On LAN from a computer on your LAN, install a program such as Wake On LAN
EX or another Wake On LAN program that supports sending magic packets.
You can use Wake On LAN from a remote location if the router in front of the NAS supports
sending magic packets.
Use the NAS’s power button or the Web Configurator’s Maintenance > Shutdown menu
to turn off the NAS.

Apply

Click this to save your changes.

Reset

Click this to restore previously saved settings.

26.3.1 Editing the Power Control Schedule Screen
Click Maintenance > Power Management > Edit to open this screen. Use this screen to
configure power control schedules to have the NAS turn on, turn off, or reboot at specified times.
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Figure 188 Maintenance > Power Management > Edit

The following table describes the labels in this screen.
Table 115 Maintenance > Power Management > Edit
LABEL

DESCRIPTION

Power Control
Schedule List

This table lists the power on, power off, and reboot schedules. For example, you could
have one schedule to turn the NAS on every morning, at 8:00, another schedule to turn it
off every evening at 18:00, and a third schedule to have it reboot every Friday at 14:00.
Click a column’s heading cell to sort the schedules by that column’s criteria. Click the
heading cell again to reverse the sort order.

Type

This field displays whether the power control schedule has the NAS turn on, turn off, or
reboot.

Frequency

This field shows how often (monthly, weekly, or daily) the NAS is to apply this power
control schedule.

Execute Time

This field shows when the NAS is to use this power control schedule (when the NAS is to
turn on, turn off, or reboot).

Actions

Click the Delete icon to remove a power control schedule from the list.

Add Power
Control Schedule

Use this part of the screen to configure power on, power off, and reboot times.

Type

Select whether this power control schedule has the NAS turn on, turn off, or reboot.

Frequency

Select whether the NAS is to apply this power control schedule entry on a monthly, weekly,
or daily basis.
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Table 115 Maintenance > Power Management > Edit (continued)
LABEL

DESCRIPTION

Execute Time
(hh:mm)

Enter the time, day, and/or day of the month as appropriate for this power control
schedule entry. Leave more than 10 minutes between the execution times of the entries.
If the NAS turns off or restarts while a user is transferring files to or from the NAS, the
transfer fails. The user will need to restart the transfer.
The NAS skips a scheduled restart or power off if the execution time comes while the NAS
is doing any of the following:
•
•
•

Resynchronizing a RAID
Upgrading firmware
Replacing the configuration file

If the NAS is turned off at the time when a restart or power off is scheduled, the NAS does
not perform the restart or power off.
If the NAS is turned on at the time when a power on is scheduled, the NAS does not
perform the power on.
Use this part of the screen to configure power on, power off, and reboot times.
Please select the This is only available if you set the Frequency to Monthly.
day of the month
Choose the day of each month for the power control schedule entry.
Every how many
weeks?

This is only available if you set the Frequency to Weekly.

Every how many
days?

This is only available if you set the Frequency to Daily.

Add

Click this to add the power control schedule to the list.

Apply

Click this to save your changes.

Cancel

Click this to return to the previous screen without saving.

Enter the interval between weeks and choose the day of the week for the power control
schedule entry.

Enter the interval between days for the power control schedule entry.

26.4 Log Screen
Click Maintenance > Log to open the following screen.
Use this screen to display all NAS logs. There are at most 512 entries in the log. Older logs are
removed by the system. You cannot download the log file via FTP or CIFS.
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Figure 189 Maintenance > Log

The following table describes the labels in this screen.
Table 116 Maintenance > Log
LABEL

DESCRIPTION

Refresh

Click this to update the log display.

Purge all Logs

Click this to erase all logs from the NAS.

Report Config

Click this to open a screen where you can configure email alerts for logs. Refer to Section
26.4.1 on page 307 to see the screens for this.

Display

The screen always shows all logs by default. Choose a specific log category to view logs for
just that category.

#

This is the log entry’s number in the list according to the currently selected sort order.

Time

This shows the date and time the log was created. Click the top of the column to sort by
oldest or newest.

Class

This displays the log category; see Table 124 on page 314for details.

Severity

This displays how serious the log is rated by the NAS. See Table 125 on page 315for more
information.

Message

This displays a description of the log. Click the top of the column to sort by alphabetical or
reverse alphabetical order.

26.4.1 Report Config Screen
In the Log screen, click Report Config to do the following:
• Use the Email Setting screen (Section 26.4.2 on page 308) to enable and configure e-mail
alerts from the NAS.
• Use the Report Setting screen (Section 26.4.3 on page 308) to select the type of alerts you
want to receive through e-mail and schedule when the NAS e-mails the alerts.
• Use the Syslog Server Setting screen (Section 26.4.4 on page 309) to enable the syslog server
and select the categories to include in the log report.
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26.4.2 Email Setting
You can enable and configure e-mail alerts from the NAS. In the Report Config screen, click the
Email Setting tab to open the following screen.
Figure 190 Maintenance > Log > Report Config: Email Setting

The following table describes the labels in this screen.
Table 117 Maintenance > Log > Report Config: Email Setting
LABEL

DESCRIPTION

Enable Log Email

Click this to have the NAS e-mail log alerts to your e-mail account.

Email To

Enter the e-mail address where you want to receive the log alerts.

Email From

Enter the e-mail address the NAS uses in the From field of the e-mail header for its log
alerts.

Email Server

Enter the e-mail server address the NAS uses to send e-mail alerts,

Email Format

Select the e-mail format you want the NAS to use in its e-mail alerts.

Use SMTP
Authentication

Click this if the e-mail server you want the NAS to use for its e-mail alerts requires a
username and password.

User

Enter the username for the e-mail server.

Password

Enter the password for the e-mail server.

Password
(Confirm)

Re-enter the password to confirm it.

After apply settings,
send a test email

Click this to have the NAS send a test e-mail to the settings you have entered.

Apply

Click this to save your changes.

Cancel

Click this to return to the previous screen without saving.

26.4.3 Report Setting
You can have the NAS email you alerts and reports. In the Report Config screen, click the Report
Setting tab to open the following screen.
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Figure 191 Maintenance > Log > Report Config: Report Setting

The following table describes the labels in this screen.
Table 118 Maintenance > Log > Report Config: Report Setting
LABEL

DESCRIPTION

Email Alert

Select the Enable Email Log check box to have the NAS send an alert email to the
configured email address whenever the NAS generates a critical severity log.

Report Time

Select how often (Weekly, Daily or Hourly), the day of the week (for weekly reports), and
the time (hour:minutes) the NAS sends a report email.

Enable Email
Log

Select the check box to have the NAS email reports of all logs the NAS generates to the
configured email address.

Apply

Click this to save your changes.

Cancel

Click this to return to the previous screen without saving.

26.4.4 Syslog Server Setting
You can enable the syslog server and select the categories to include in the log report. In the
Report Config screen, click the Syslog Server Setting tab to open the following screen.
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Figure 192 Maintenance > Log > Report Config: Syslog Server Setting

The following table describes the labels in this screen.
Table 119 Maintenance > Log > Report Config: Syslog Server Setting
LABEL

DESCRIPTION

Enable Syslog
Server

Check this to enable syslog server.

Server Address

Enter the syslog server address you want the NAS to use for its log alerts.

In the table below, check the type of log alerts you want to receive in your e-mail. Select All Log to include all
types of log alerts.
Apply

Click this to save your changes.

Cancel

Click this to return to the previous screen without saving.

26.5 Configuration Screen
Click Maintenance > Configuration to open the following screen. Use this screen to backup or
restore the NAS configuration settings.
Figure 193 Maintenance > Configuration
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The following table describes the labels in this screen.
Table 120 Maintenance > Configuration
LABEL

DESCRIPTION

Backup Current Configuration Settings
Backup
Restore Configuration

Click this to save the current configuration of the NAS to your computer. A pop-up
screen appears asking you to confirm. Click OK to continue or Cancel to quit.
When you restore a file configuration, the NAS checks the volumes/share paths on
the NAS and the configuration file.
If the volume exists but the share path is missing in the NAS, the NAS automatically
creates this share path.
If the volume does not exist on the NAS, the Status of the share will show “missing
share icon” in Shares screen (see Table 107 on page 292).

Browse

Click this to locate a previously-saved configuration file.

Restore

Click this to load the previously-saved configuration file to the NAS. This replaces
your current NAS configuration settings with the settings in the previously-saved
configuration file.
A pop-up screen appears asking you to confirm. Click OK to continue or Cancel to
quit.

26.6 SSL Certification
Click Maintenance > SSL to open this screen, where you can turn on HTTPS, create a public key
certificate, or upload a public key certificate that was issued by a known certificate authority.
Figure 194 Maintenance > SSL
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The following table describes the labels in this screen.
Table 121 Maintenance > SSL
LABEL

DESCRIPTION

Install System Default CA

Click Download button to save a copy of the NAS’s public key certificate to your
local computer. This is useful for installing the certificate without having to
connect to the NAS, or for sending by email to other users for them to install prior
to logging into the NAS for the first time. After saving the certificate to your
computer, double-click it to install it.

Note: Each web browser handles certificate installation differently.
Modify the Existing
Certificate

Select Edit a self-signed CA certificate, then follow the on-screen instructions
for creating a public key certificate signed by the NAS as the local certificate
authority.

Note: Use certificates created and signed by the NAS if the device is not open to
external access.
Select Create a certificate authorized by other CA, then follow the on-screen
instructions to install a certificate that has been authorized by a third-party
certificate authority.

Note: Use this method if the device is open to external access, such as allowing
users to connect through the Internet using FTP over TLS or HTTPs.

26.6.1 Modifying or Creating a Certificate
When you select the Edit a self-signed CA certificate option, then click the Edit button, a screen
opens to allow you to make adjustments to the NAS’s public key certificate.
The screen is also the same for the Create a certificate authorized by other CA option.
Figure 195 Maintenance > SSL > Create or Edit a Certificate
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The following table describes the labels in this screen.
Table 122 Maintenance > SSL > Create or Edit a Certificate
LABEL

DESCRIPTION

Common Name

This name describes the certificate’s origin, either in the form of an IP address or a
domain name.

Host IP Address

Select this option and enter the NAS’s IP address if you want to use this for the
common name.

Host Domain Name

Select this option and enter the NAS’s domain name if you want to use this for the
common name

Organizational Unit
(Optional)

Enter this name of the organizational unit which owns or maintains the NAS. This is
an optional field.

Organization (Optional)

Enter this name of the organization or company which owns or maintains the NAS.
This is an optional field.

Country (Optional)

Enter this name of the country in which the NAS is located. This is an optional field.

Key Type

Select the certificate’s key type, either RSA or DSA. RSA is a public-key encryption
and digital signature algorithm, while DSA is only a digital signature algorithm.

Key Length

Select the encryption key length. The longer the key, the better the encryption
security. The only drawback to having a long key is that the file encrypted with it
swells in size as well.

Apply

Click this to save your changes.

Cancel

Click this to discard changes and close the window.

26.7 Shutdown Screen
Use this screen to turn off the NAS or perform a software restart. A software restart is faster than
turning the NAS off and then turning it on again. Before shutting down or restarting, check the
System Status > Active Sessions screen to make sure that no one is logged into the NAS or
transferring files to or from the NAS.
Click Maintenance > Shutdown to open the following screen.
Figure 196 Maintenance > Shutdown

The following table describes the labels in this screen.
Table 123 Maintenance > Shutdown
LABEL

DESCRIPTION

Restart

Click this to have the device perform a software restart.

Shutdown

Click this to shut down the system and restart it again later.

When you click the Restart button a pop-up screen will appear asking you to confirm. Click OK to
continue or Cancel to quit the restart.
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Figure 197 Maintenance > Shutdown > Confirm Restart

When you click the Shutdown button a pop-up screen will appear asking you to confirm. Click OK
to continue or Cancel to quit the shutdown.
Figure 198 Maintenance > Shutdown > Confirm Shutdown

26.8 Unpair myZyXELcloud Screen
Figure 199 Use this screen to remove the pairing between the NAS and the myZyXELcloud account
if you want to pair the NAS with a different myZyXELcloud account. You have to pair the NAS
and your myZyXELcloud account before performing the unpair. Click Maintenance > Unpair
myZyXELcloud to open the following screen, and click Unpair.

26.9 Technical Reference
This section provides technical background information on the topics discussed in this chapter.

26.9.1 Log Classes
The following table shows information on log classes.
Table 124 Log Classes
LOG
CATEGORY

DESCRIPTION

Users

This log class shows information on user access to the NAS.

Shares

This log class shows information on shares being created or deleted.

Services

This log class shows information on the operation of the NAS’s built-in services.

System

This log class shows all other system related messages.

Network

This log class shows information on network configuration, setting changes and so on.

Storage

This log class shows information on the NAS’s internal and external storage activities.

Backup

This log class shows information on all backup-related activities.

Auto Upload

This log class shows information on automatic uploads done by the NAS.
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26.9.2 Log Severity Levels
The following table shows information on log severity levels. Levels range from 0 to 6 with 0 being
the most severe level log and 6 being an informational log only. Log levels are not displayed in the
logs and are for your reference only.
Table 125 Log Severity Levels
LEVEL

DESCRIPTION

0

Emergency

1

Alert

2

Critical

3

Error

4

Warning

5

Notice

6

Info

26.9.3 Log Messages
Here are some example log messages.
Table 126 Log Messages
CLASS

SEVERITY MESSAGE

Auto upload

INFO

%s is queued.

Auto upload

INFO

%s uploaded (Flickr or YouTube Upload).

Auto upload

WARNING

error uploading "%s" (%s): %s

Auto upload

INFO

%s will not be uploaded to %s for there is already a duplicate file.

Auto upload

INFO

Failed to upload %s to %s (FTP Upload) : %s

Auto upload

INFO

Successfully upload %s to %s (FTP Upload)

Copy/Sync Button

ERROR

[USB %s] Backup Folder Does Not Exist.

Copy/Sync Button

ERROR

[USB %s] Target Folder Does Not Exist.

Copy/Sync Button

ERROR

[USB Sync] Failed at %s: It is a Folder in Internal Volume. But It is not a
Folder in USB.

Copy/Sync Button

ERROR

[USB Sync] Failed at %s: It is a Folder in USB. But It is not a Folder in
Internal Volume.

Copy/Sync Button

ERROR

[USB Sync] Failed at File %s.

Copy/Sync Button

ERROR

[USB Sync] Sync Failed at Folder %s.

Copy/Sync Button

ERROR

Modify COPY/SYNC Button Configuration: %s

Copy/Sync Button

ERROR

Please Change Your Folder Name. Invalid Path: %s

Copy/Sync Button

INFO

[USB Sync] Copying %s from Internal Volume to Backup Folder.

Copy/Sync Button

INFO

[USB Sync] Copying %s from Internal Volume to USB.

Copy/Sync Button

INFO

[USB Sync] Copying %s from USB to Backup Folder.

Copy/Sync Button

INFO

[USB Sync] Copying %s from USB to Internal Volume.

Copy/Sync Button

INFO

[USB Sync] Deleting %s from Internal Volume.

Copy/Sync Button

INFO

[USB Sync] Deleting %s from USB.

Copy/Sync Button

INFO

[USB Sync] Deleting %s from USB Recursively.
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Table 126 Log Messages (continued)
CLASS

SEVERITY MESSAGE

Copy/Sync Button

INFO

[USB Sync] Finished. Elapsed Time %s Seconds.

Copy/Sync Button

INFO

[USB Sync] Moving %s from Internal Volume to Backup Folder.

Copy/Sync Button

INFO

[USB Sync] Moving %s from USB to Backup Folder

Copy/Sync Button

INFO

[USB Sync] Skip %s: File not Exist

Copy/Sync Button

INFO

[USB Sync] Skip %s: Not a Regular File.

Copy/Sync Button

INFO

[USB Sync] Start Pre-Processing: Generating File Lists.

Copy/Sync Button

NOTICE

[USB Sync] Start Copying Files.

Download Service

ERROR

Download service cannot find a volume

Download Service

ERROR

Download service failed to find ipfilter.dat

Download Service

INFO

Download service add a URL download job %s

Download Service

INFO

Download service delete %s by user

Download Service

INFO

Download service download %s error (0x%08x)

Download Service

INFO

Download service download %s finished in %s

Download Service

INFO

Download service found a new torrent file %s

Download Service

INFO

Download service initialized

Download Service

INFO

Download service pause %s by user

Download Service

INFO

Download service set %s to %s priority by user

Download Service

INFO

Download service set default download location to %s

Download Service

INFO

Download service set max P2P download rate to %d KB/s by user

Download Service

INFO

Download service set max P2P upload rate to %d KB/s by user

Download Service

INFO

Download service set max download slot to %d

Download Service

INFO

Download service set seeding time to %d minutes

Download Service

INFO

Download service set TCP port to %d and UDP port to %d

Download Service

INFO

Download service set torrent monitor location to %s

Download Service

INFO

Download service start to download %s

Download Service

INFO

Download service stopped

Download Service

INFO

Download service suspend %s because of no data income detected or to
limit max download slot

Download Service

INFO

Download service add comment %s to %s by user

Download Service

INFO

Download service set min upload/download ratio to %d%

Download Service

INFO

Download service set max seed slot to %d

Download Service

INFO

Download service start loading ipfilter.dat

Download Service

INFO

Download service clear all ipfilter rules

Download Service

INFO

Download service blocked peer removed from peer list

Download Service

INFO

Download service disconnected blocked peer

Download Service

INFO

Download service incoming connection blocked by IP filter

Download Service

INFO

Download service peer from tracker blocked by IP filter

Download Service

INFO

Download service abort loading ipfilter.dat

Download Service

INFO

Download service will update ipfilter.dat from %s after %d day(s)

Download Service

INFO

Download service added %d rules from ipfilter.dat

Download Service

INFO

Download service detected invalid ip range %s in ipfilter.dat
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Table 126 Log Messages (continued)
CLASS

SEVERITY MESSAGE

Download Service

WARNING

Download service default location does not exist. Load default

Download Service

WARNING

Download service default torrent location does not exist. Load default

Groups

NOTICE

Add new group %s.

Groups

NOTICE

Delete group %s.

Network

INFO

DyDNS: Start Success

Network

INFO

DyDNS: Stop Success

Network

NOTICE

%s is active because of changing Port Group. Enable DHCP client.

Network

NOTICE

%s is inactive because of changing Port Group. Disable DHCP client.

Network

NOTICE

%s MTU > (%s MTU - 8), %s may not work correctly.

Network

NOTICE

(%s MTU - 8) < %s MTU, %s may not work correctly.

Network

NOTICE

Add interface %s.

Network

NOTICE

Because %s link down. Default route will not apply until %s link up.

Network

NOTICE

Because base interface %s will be disabled. Interface %s is disabled now.,
base_ud_iface

Network

NOTICE

Network Config setting is changed

Network

NOTICE

Interface %s was disabled.

Network

NOTICE

Interface %s was enabled.

Network

NOTICE

Port Group on %s is changed. Renew DHCP client.

Network

NOTICE

Account pppoe was changed

Network

NOTICE

Add account pppoe

Network

NOTICE

ADD interface ppp0

Network

NOTICE

Interface ppp0 will reapply because Device-Ha become active status.

Network

NOTICE

Interface ppp0 will reapply because Device-Ha is not running.

Network

NOTICE

Network port is disabled

Network

NOTICE

Network port is enabled

Network

ERROR

DyDNS: Start Error

Network

ERROR

DyDNS: Stop Error

Services

INFO

HTTP management port has changed to %s

Services

INFO

Clock timezone is set to GMT%s

Services

INFO

Clock timezone is set to default

Services

INFO

Clock daylight saving is enabled

Services

INFO

Clock daylight saving is disabled

Services

INFO

Clock has disable daylight saving

Services

INFO

MyClock has enable daylight saving

Services

INFO

MyClock has set timezone to %s

Services

INFO

MyClock has set timezone to default

Services

INFO

The date and time are updated from NTP server.

Services

INFO

The date and time are updated manually.

Services

INFO

The time is updated manually.

Services

NOTICE

FTP server stops

Services

NOTICE

FTP server starts
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Table 126 Log Messages (continued)
CLASS

SEVERITY MESSAGE

Services

NOTICE

MyClock has changed daylight saving interval

Services

NOTICE

MyClock has disabled daylight saving interval

Services

NOTICE

NTP server has set to '%s'

Services

NOTICE

NTP server has set to null

Services

NOTICE

The NTP service is disabled.

Services

NOTICE

The NTP service is enabled.

Services

WARNING

Reaching Maximum Allowed Rules

Services

WARNING

Rule is empty

Services

WARNING

The Rule Does Not Exist

Shares

INFO

Expire recycle-bin finish for share %s, process time: %s seconds, remove
%s file (%s bytes)

Shares

NOTICE

Add new disabled share %s for unshared folder: %s in volume: %s.

Shares

NOTICE

Add new share %s.

Shares

NOTICE

Delete share %s.

Shares

NOTICE

Purge all files in recycle-bin folder in share: %s.

Shares

NOTICE

Recycle-bin disabled. Remove recycle-bin folder in share: %s.

Storage

ERROR

Eject External Disk (%s): FAILED

Storage

INFO

Eject External Disk (%s): SUCCESS

Storage

ERROR

Cancel External Volume Scan: FAILED

Storage

ERROR

Cannot Unmount Volume and RAID. System Busy Using Volume and RAID:
Please Reboot and Try Again

Storage

ERROR

Create External Normal Volume [%s] (%s): FAILED

Storage

ERROR

Rename External Volume to [%s]: FAILED

Storage

ERROR

Scan External Volume: FAILED

Storage

INFO

Cancel External Volume Scan: SUCCESS

Storage

INFO

Create External Normal Volume [%s] (%s): SUCCESS

Storage

INFO

Rename External Volume to [%s]: SUCCESS

Storage

INFO

Scan External Volume: SUCCESS

storage

Info

Create raidType [Volume1]: SUCCESS

storage

error

Create raidType [Volume1]: FAILED

storage

Info

Create raidType [Disk group 1]: SUCCESS

storage

error

Create raidType [Disk group 1]: FAILED

storage

Info

Create Internal Volume [Volume1] (Size=512MB): SUCCESS

storage

error

Create Internal Volume [Volume1] (Size=512MB): FAILED

storage

Info

Delete Volume [Volume1] SUCCESS

storage

error

Delete Volume [Volume1] FAILED

storage

Info

Delete Disk Group [ Disk Group 1] SUCCESS

storage

error

Delete Disk Group [ Disk Group 1] FAILED

storage

Info

initialize Repair Degraded Raid [Volume1]: SUCCESS

storage

error

initialize Repair Degraded Raid [Volume1]: FAILED

storage

Info

initialize Repair Degraded Raid [ Disk Group 1]: SUCCESS

storage

error

initialize Repair Degraded Raid [ Disk Group 1]: FAILED
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Table 126 Log Messages (continued)
CLASS

SEVERITY MESSAGE

storage

Info

Add disk1 to Volume1: SUCCESS

storage

error

Add disk1 to Volume1: FAILED

storage

Info

Add disk1 to Disk Group 1: SUCCESS

storage

error

Add disk1 to Disk Group 1: FAILED

storage

Info

Change Volume1 Raid type to raid5: SUCCESS

storage

error

Change Volume1 Raid type to raid5: FAILED

storage

Info

Change Disk Group 1 Raid type to raid5: SUCCESS

storage

error

Change Disk Group 1 Raid type to raid5: FAILED

storage

Info

Add Hot-Spare disk1 to Raid [Volume1]: SUCCESS

storage

error

Add Hot-Spare disk1 to Raid [ Volume1]: FAILED

storage

Info

Add Hot-Spare disk1 to Raid [ Disk Group 1]: SUCCESS

storage

error

Add Hot-Spare disk1 to Raid [ Disk Group 1]: FAILED

storage

Info

Remove Hot-Spare disk1 from Raid [Volume1 ]: FAILED

storage

error

Remove Hot-Spare disk1 from Raid [Volume1 ]: SUCCESS

storage

Info

Remove Hot-Spare disk1 from Raid [Disk Group1 ]: FAILED

storage

error

Remove Hot-Spare disk1 from Raid [Disk Group1 ]: SUCCESS

storage

Info

Expand Volume [Volume1] : SUCCESS

storage

error

Expand Volume [Volume1] : FAILED

storage

Info

Expand Disk Group [Disk Group 1] SUCCESS

storage

error

Expand Disk Group [Disk Group 1] FAILED

System

INFO

NTP update failed

System

INFO

NTP updates successfully from %s

System

INFO

NTP fails to update from %s

System

INFO

Device is rebooted by administrator!

System

INFO

Device is shutdown by administrator!

System

NOTICE

DNS server is changed.

System

NOTICE

Hostname is cleared.

System

NOTICE

Hostname is set to '%s'.

System

NOTICE

System description is changed.

System

NOTICE

System description is empty now.

System

NOTICE

DNS server setting is changed

System

NOTICE

DNS server address is changed to be given from DHCP server

System

NOTICE

DNS server address is changed to be assigned by user

System

NOTICE

Name server is changed.

USB

NOTICE

An external APC UPS device is plugged/unplugged.

USB

NOTICE

An external Mass Storage device is plugged/unplugged.

USB

NOTICE

An external Printer device is plugged/unplugged.

USB

NOTICE

An external USB hub device is plugged/unplugged.

Users

ALERT

Failed %s login attempt (incorrect password or inexistent username)

Users

ALERT

Failed %s login attempt (incorrect password or inexistent username)

Users

INFO

User %s has logged in from %s!
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Table 126 Log Messages (continued)
CLASS

SEVERITY MESSAGE

Users

INFO

User %s has logged out from %s!

Users

INFO

User %s from %s has been logged out (re-auth timeout)!

Users

INFO

User %s from %s has been logged out (lease timeout)!

Users

NOTICE

Add new user %s by %s from %s.

Users

NOTICE

User %s password has been changed.

Users

NOTICE

Delete user %s by %s from %s.

Users

NOTICE

The user %s from %s has attempted to change the user %s password but
old password verification fail.

Users

NOTICE

User %s on %u.%u.%u.%u has been denied access from %s

Users

NOTICE

User %s password has been changed by %s from %s.

Backup/Restore

ERROR

When query remote target [%s]: %s

Backup/Restore

INFO

Backup job [%s] successfully

Backup/Restore

ERROR

When backup [%s]: %s

Backup/Restore

ERROR

When backup [%s], error happens: %s

Backup/Restore

INFO

Start to restore backup job [%s].

Backup/Restore

INFO

Restore backup job [%s] successfully.

Backup/Restore

ERROR

Restore backup job [%s] failed: %s

Backup/Restore

INFO

Start to restore backup job [%s] from [%s].

Backup/Restore

INFO

Restore from [%s] successfully.

Backup/Restore

ERROR

Restore from [%s] failed: %s

Backup/Restore

ERROR

When restore [%s]: %s

Backup/Restore

ERROR

When restore job [%s], error happens: %s

Power Management

INFO

Job [%s] is triggered by schedule

Power Management

INFO

Job [%s] is triggered by user

Power Management

ERROR

Job [%s] is resulted as failed

Power Management

INFO

Job [%s] is finished successfully

Power Management

INFO

Job [%s] is pending because other job is running

Power Management

INFO

Job [%s] is canceled by user

Power Management

INFO

Restore job [%s] is triggered by user

Power Management

INFO

[Power On] schedule is triggered.

Power Management

INFO

[Power Off] schedule is triggered.

Power Management

INFO

[Reboot] schedule is triggered.
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Protect

27.1 Overview
This chapter introduces different ways of protecting data on the NAS and covers the Protect
screens.
Table 127 Overview of Protection Methods
SITUATION

ACTION

Unexpected NAS behavior after configuration
changes

Back up the NAS configuration file before you make
major configuration changes. See Section 27.5 on page
336.

Need to transfer data from your computer to the
NAS after volume(s) have been created

Backup your data to a computer or other storage
devices.

Data infected by virus

Use anti-virus software on your computer to scan files
before saving them onto the NAS. Although this may be
slow so you may want to schedule it to occur while no
one is using the NAS.
Use a firewall with anti-virus capability on your network.

Hard drive malfunction.

Use RAID. See Section 8.6 on page 98 for more
information on RAID.

NAS malfunction

Back up data to another NAS or external USB hard
drive. See Section 14.14 on page 191 for an example of
how to back up the NAS to another NAS.

Network down
Natural disaster such as a fire or earthquake occurs
where your NAS is located

27.2 What You Can Do
• Use the Backup screens (Section 27.3 on page 321) to create and customize backup jobs.
• Use the Restore screens (Section 27.4 on page 332) to restore previous backups made with the
NAS.

27.3 Backup Screens
Use this screen to create and customize scheduled backup jobs for your files.
You can have several backup jobs for specific folders and time periods.
Click Protect > Backup to open the following screen.
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Figure 200 Protect > Backup

The following table describes the labels in this screen.
Table 128 Protect > Backup
LABEL

DESCRIPTION

Backup
Add Job

Click this to create and customize a backup job.

Edit Job

Select a backup job in the list and click this to make some changes to it.

Delete Selected
Job(s)

Select a backup job in the list and click this to delete it.

Execute Job Now

Select a backup job in the list and click this to run the backup job immediately.

Restore Archive

Select a backup job in the list and click this to restore the file(s) included in that backup
job to the NAS.
This applies to Archive backups only. Refer to Section 27.3.8 on page 330 to see the
screens.

Abort Job

Select a backup job in the list and click this to stop the process if the backup job is
currently active.

Activate Job

Enable the selected backup job.

Inactivate Job

Disable the selected backup job.

Status

This shows the current state of the backup job.
•
•

Waiting means the backup job is not active but is scheduled to run at some time.
Running indicates that the NAS is currently doing the backup job. When the backup
job is running, you can also see a progress bar.

Job Name

This identifies the backup job.

Job Description

This is a short description of the backup job.

Backup Info

This lists down the backup job details: type, source and target. Refer to Section 27.3.1
on page 322 and Section 27.3.2 on page 323.

Scheduler Info

This shows the backup schedule, including the frequency, the time it was last run in
(and whether or not it succeeded), and when it is scheduled to run again. The times use
yyyy-mm-dd hh:mm:ss format.
Refer to Section 27.3.4 on page 326.

27.3.1 Backup: Step 1
Use this screen to specify the job information and back up type.
Click Add Job in the Protect > Backup screen to open the following:
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Figure 201 Protect > Backup: Step 1

The following table describes the labels in this screen.
Table 129 Protect > Backup: Step 1
LABEL

DESCRIPTION

Job Information
Job Name

Enter a name to identify the backup job.

Job Description

Enter a short description (up to 100 keyboard characters) for the backup job.

Backup Type

Choose the backup type the NAS implements for the backup job.
Archive - This is a backup of the source folder in an archive format. Once you backup your
files in the target folder, you cannot access the files individually unless you have the
extracting tool used by the NAS. If there are existing files in the target folder prior to the
NAS’s backup job, the files remain undisturbed. You can also choose between the following
types of archive:
•
•

Full - The NAS does a fresh backup each time. This provides the most protection but
also requires the most storage space.
Incremental - The NAS backs up new or modified files from the source folder since the
last backup. The first backup is a full backup. You can also do a full backup after several
incremental backups. Enter how many incremental backups the NAS runs before it
performs a full backup of the source folder. You must keep the latest full backup to be
able to restore the files later.

Synchronization - This does a backup of individual files. If you use this type, you cannot
use the Restore feature of the NAS. You can also choose between the following types of
synchronization:
•
•

Mirror - The NAS deletes all data in the target folder before running the backup. It
makes the target folder identical to the source folder.
Publish- The NAS does a backup of individual files to the target folder without
overwriting existing files in that folder. It makes a copy of the source files.

Rsync - This synchronizes individual files to another device that supports rsync. Rsync is
open source and provides incremental file transfers. It only sends the differences in the
files through the connection so it brings the remote files into sync very quickly.
•
•
Next

The NAS deletes all data in the target folder before running the backup. It makes the
target folder identical to the source folder.
If you use this type, you cannot use the Restore feature of the NAS.

Click this to go to the next step.

27.3.2 Backup: Step 2
Use this screen to specify where the files you want to backup are located and set where you want
the backup to be stored.
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Figure 202 Protect > Backup: Step 2

The following table describes the labels in this screen.
Table 130 Protect > Backup: Step 2
LABEL

DESCRIPTION

Backup Source

Select an (internal) volume and the folders and files to back up using this tree interface.
Click

to browse through folders, sub-folders and files.

Click
to close a folder in the tree. This is useful if there are many folders or files that
you wish to hide from view.
Click

to select a folder or file to back up. This also selects all sub-folders and files.

Click

to deselect the folder or file. This also deselects all sub-folders and files.

and
appear when there are too many folders/files to display. Click the
arrows to scroll up or down through the folders/files.
for a folder means all sub-folders and files and new folders/files added later will be
backed up.
for a file means the file will be backed up.
(a grayed out check box) for a folder means that only some sub-folders and files under
the folder will be backed up. Newly added folders/files will NOT be backed up.
means the file structure is still loading. Please wait for the folders/files to display.

Note: If you select to back up an entire folder and then de-select a sub-folder or file within
that folder, the main folder icon will turn and any new sub-folders and files added
to this main folder after the initial backup configuration will NOT be backed up.
A list of your select folders and files displays below the selection fields.
Selected Source
Folders

This shows the path of the backup source folder you selected.

Backup Target

Select the target folder where you want to place your backup.
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Table 130 Protect > Backup: Step 2 (continued)
LABEL

DESCRIPTION

Remote

Select this to back up to another device.
For Archives:
The remote device can be another NAS in the network. Fill in the following fields in order
to be able to access it.
•
•
•
•

Remote NAS Address
Username
Password
Share Name

Click Test Connection to see if your NAS can communicate with the remote device.
For Synchronization:
The remote device must be another NAS compatible with the NAS’s synchronization
feature. Fill in the following fields in order to be able to access it.
•
•
•

Remote NAS Address
Username (always “admin”)
Remote Admin’s Password

Click Show target content to connect to the remote NAS so you can select the target
share for the backup.
For Rsync:
The remote device must be a NAS that supports rsync or a computer running the rsync
utility. Fill in the following fields in order to be able to access it.
•
•
•

Remote NAS Address
Username (always “admin”)
Remote Admin’s Password

Click Show target content to connect to the remote NAS or computer so you can select
the target folder for the backup.
Local

Select this if you want to place your backup in another volume in the NAS. Select the
folder where you want to place the backup.

External

Select this if you have a USB hard disk connected to the NAS that you want to use for
your backup. Select the folder where you want to place the backup.

Previous

Click this to go back to the previous screen.

Next

Click this to go to the next screen.

27.3.3 Backup: Step 3
Use this screen to specify compression, encryption and purge policies for the backup job. This step
is only available if you are doing an archive backup or a synchronization backup to a remote target.
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Figure 203 Protect > Backup: Step 3

The following table describes the labels in this screen.
Table 131 Protect > Backup: Step 3
LABEL

DESCRIPTION

Compression

Select Yes if you want NAS to compress the files for your backup. Otherwise, choose No.
In an Archive backup, compression is a method of packing computing files in a way that
saves hard disk space.
For a Synchronization backup (to a remote target), the source data will be compressed
before the transmission to reduce the transmission time. It is used in slow networks only.

Encryption

Select Yes if you want NAS to encrypt the files for your backup. Otherwise, choose No.
In an Archive backup, this means using a password to secure files.
For a Synchronization backup (to a remote target), this means securing the file transfer
session. However the final file stored on the remote NAS is unencrypted. This takes a long
time. Make sure you really need this feature before enabling it.

Bandwidth

Restrict the bandwidth of synchronization backups to help stop them from using all of your
network connection’s available bandwidth. This is more important when backing up to a
remote NAS or computer through the Internet.

Purge Policy

The NAS maintains the files that have been included in your backups. However to save hard
disk space, you can choose to delete files that have been included in previous backups.
•
•

•

Select Keep All Old Backup files to store all files that have been included in previous
backups.
If you want to store a certain number of backup files, select Keep Only the last n
backup files (1-30). Enter a value (n) from 1 to 30 to specify how many backups the
NAS stores. All backup files older than the last one are deleted. You will not be able to
recover files that existed (only) in those previous backups. Select this if backup space is
limited and recovery of old files is not important.
If you want to store all backups for a certain time period, select Keep Backups for n
day(s)(1-3650). Enter a value (n) from 1 to 3650 to specify how many days the NAS
stores all backup files. After this day has expired, all backup files will be deleted.

Previous

Click this to go back to the previous screen.

Next

Click this to go to the next screen.

27.3.4 Backup: Step 4
Click this to specify the schedule for the backup job. The backup job automatically runs according
to the schedule that you set in this screen.
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Figure 204 Protect > Backup: Step 4

The following table describes the labels in this screen.
Table 132 Protect > Backup: Step 4
LABEL

DESCRIPTION

Scheduler
Backup Frequency

Select from Hourly, Daily, Weekly and Monthly backup intervals. The screen changes
depending on the item you select.

Every how many
hours?

This is only available if you selected Hourly as your backup frequency.

On which minute of
the hour?

This is only available if you selected Hourly as your backup frequency.

Start Time
(hh:mm)

This is available if you selected Daily, Weekly or Monthly as your backup frequency.

Every how many
days?

This is only available if you selected Daily as your backup frequency.

Every how many
weeks?

This is only available if you selected Weekly as your backup frequency.

Step 1: Please
select the month(s)
of a year

This is only available if you selected Monthly as your backup frequency.

Step 2: Please
select the day of
the month

This is only available if you selected Monthly as your backup frequency.

Previous

Click this to go back to the previous screen.

Done

Click this to close the screen.

Select every how many hours the NAS performs the backup job.

Select the minute (from 0 to 59) in an hour when the NAS performs the backup job.

Select the time in hour:minute format when you want the NAS to perform the backup
job.

Enter the interval between days when the NAS performs the backup job.

Enter the interval between weeks when NAS performs the backup job.

Select the month(s) when you want the NAS to perform the backup job.

Select the day in a month when you want the NAS to perform the backup job.

27.3.5 Edit Job Screen
Use this screen to edit an existing backup job. Some attributes of the backup job cannot be
changed, such as the name, backup type, source folder and so on.
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27.3.6 Edit Job: Step 1
Click Protect > Backup. Select a backup job from the list and click Edit Job to open the Edit Job
screen.
Figure 205 Protect > Backup > Edit: Step 1

The following table describes the labels in this screen.
Table 133 Protect > Backup > Edit: Step 1
LABEL

DESCRIPTION

Job Settings
Job Name

This field is read-only and shows the name of the backup job.

Job Description

Enter a short description for the backup job.

Backup Type

This field is read-only and shows the backup type.

Source folder(s)/
file(s)

This is read-only and shows the path of the source folder for backup.

Backup Target

This field is read-only and shows on which volume (whether internal or external) the
backup files are stored. If the target location is a remote NAS, this shows the remote IP
address.

Target Path

This field is read-only and shows the target folder for the backup files.

Compression

This field is read-only and shows whether the backup employs compression.
Compression reduces the size of the file that you want to back up. Backup is then faster,
but restoring may be slower, so if backup space is not a concern and recovery speed is,
then turn off compression.

Encryption

This field is read-only and shows whether the backup employs encryption.
You can have the NAS use a password to encrypt the backup files.

Bandwidth

For backups to a remote NAS, you can restrict the bandwidth to help prevent the
backups from using all of your network connection’s available bandwidth. This is more
important when backing up to a remote NAS or computer through the Internet.
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Table 133 Protect > Backup > Edit: Step 1 (continued)
LABEL

DESCRIPTION

Purge Policy

The NAS maintains the files that have been included in your backups. However to save
hard disk space, you can choose to delete files that have been included in previous
backups.
•
•

•

Next

Select Keep All Old Backup files to store all files that have been included in
previous backups.
If you want to store a certain number of backup files, select Keep Only the last n
backup files (1-30). Enter a value (n) from 1 to 30 to specify how many backups
the NAS stores. All backup files older than the last one are deleted. You will not be
able to recover files that existed (only) in those previous backups. Select this if
backup space is limited and recovery of old files is not important.
If you want to store all backups for a certain time period, select Keep Backups for
n day(s)(1-3650). Enter a value (n) from 1 to 3650 to specify how many days the
NAS stores all backup files. After this day has expired, all backup files will be
deleted.

Click this to go to the next screen.

27.3.7 Edit Job: Step 2
Use this screen to edit the schedule for the backup job.
Figure 206 Protect > Backup > Edit: Step 2

The following table describes the labels in this screen.
Table 134 Protect > Backup > Edit: Step 2
LABEL

DESCRIPTION

Scheduler Settings
Backup Frequency

Edit this by selecting from Hourly, Daily, Weekly and Monthly backup intervals. The
screen changes depending on the item you select.

Every how many
hours?

This is only available if you selected Hourly as your backup frequency.

On which minute of
the hour?

This is only available if you selected Hourly as your backup frequency.

Start Time (hh:mm)

This is available if you selected Daily, Weekly or Monthly as your backup frequency.

Select every how many hours the NAS performs the backup job.

Select the minute (from 0 to 59) in an hour when the NAS performs the backup job.

Select the time in hour:minute format when you want the NAS to perform the backup
job.
Every how many
days?

This is only available if you selected Daily as your backup frequency.
Enter the interval between days when the NAS performs the backup job.
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Table 134 Protect > Backup > Edit: Step 2 (continued)
LABEL

DESCRIPTION

Every how many
weeks?

This is only available if you selected Weekly as your backup frequency.

Step 1: Please
select the month(s)
of a year

This is only available if you selected Monthly as your backup frequency.

Step 2: Please
select the day of the
month

This is only available if you selected Monthly as your backup frequency.

Previous

Click this to go back to the previous screen.

Done

Click this to close the screen.

Enter the interval between weeks when NAS performs the backup job.

Select the month(s) when you want the NAS to perform the backup job.

Select the day in a month when you want the NAS to perform the backup job.

27.3.8 Restore Archive Screen
Use this screen to restore previous backups made with the NAS.

27.3.9 Restore Archive: Step 1
Click Protect > Backup screen (Section 27.3 on page 321). You can restore a previous backup job
by selecting a backup job from the list and clicking Restore Archive.
Figure 207 Protect > Backup > Restore Archive: Step 1

The following table describes the labels in this screen.
Table 135 Protect > Backup > Restore Archive: Step 1
LABEL

DESCRIPTION

Step 1. Select
Restore Source

Select a previous archive backup that you want to restore to the NAS.

Job Information
Job Name

This is the name to identify the backup job.

Job Description

This is a short description (up to 100 keyboard characters) for the backup job.

Backup Type

This is the type of backup implemented for the backup job.

Scheduler
Information

This field displays the backup’s frequency.

Restored Time

Select a previous backup in the list that you want to restore to your NAS.

Next

Click this to go to the next screen.
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27.3.10 Restore Archive: Step 2
Use this screen to select the folder where the archive you want to restore is located.

Figure 208 Protect > Backup > Restore Archive: Step 2

The following table describes the labels in this screen.
Table 136 Protect > Backup > Restore Archive: Step 2
LABEL

DESCRIPTION

Step 2. Please select which file(s)/folder(s) to restore.
Folder Chooser

Select the folder where the backup you want to restore is located.

Selected Folder

This shows the path of the folder you selected.

Previous

Click this to go back to the previous screen.

Next

Click this to go to the next screen.

27.3.11 Restore Archive: Step 3
Use this screen to select the location in the NAS where you want to restore your backup.
Figure 209 Protect > Backup > Restore Archive: Step 3
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The following table describes the labels in this screen.
Table 137 Protect > Backup > Restore Archive: Step 3
LABEL

DESCRIPTION

Step 3. Set a restore target and start restoring
Original Location

Select this to restore the files to their original location in the NAS.

Other Location

Click this to select a folder where you want to place the restored files. Click Browse to
open the following screen.

•
•
•
•

Volume - Select a volume from the list.
Current Location - This is the location of the selected folder.
Type - This identifies the item as a file or folder.
Name - This is the name of the folder/file.

Click Apply to save your settings and Cancel to close the screen.
Previous

Click this to go back to the previous screen.

Done

Click this to run the restore process and go back to the Backup screen.

27.4 Restore Screen
Use this screen to restore previous backups made with the NAS, including archives and folders from
internal, external or remote NASs to the NAS.

27.4.1 Restore: Step 1
You can access this screen by clicking Protect > Restore.
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Figure 210 Protect > Restore: Step 1

The following table describes the labels in this screen.
Table 138 Protect > Restore: Step 1
LABEL

DESCRIPTION

Step 1. Select
Restore Source

Select a previous archive backup that you want to restore to the NAS.
Select Remote NAS if the file is in another NAS in the network that you used for your
backup. Fill in the fields below when you choose this option.
Select Internal or External Volume if you want to use another volume in the NAS or an
attached USB hard disk for your backup. Click Browse to select the backup file.

IP Address

Enter the address of the NAS you want to use.

User

Enter the username you use to access the NAS.

Password

Enter the password of your NAS account.

Share Name

Enter the name of the share you want to use.

Test Connection

Click this to test your connection to the remote NAS that you have specified in the fields
above.

Browse

Click this to select where the previous backup that you want to restore is located.

•
•
•
•

Volume - Select a volume from the list.
Current Location - This is the location of the selected folder.
Type - This identifies the item as a file or folder.
Name - This is the name of the folder/file.

Click Apply to save your settings and Cancel to close the screen.
Next

Click this to go to the next screen.

Cloud Storage User’s Guide

333

Chapter 27 Protect

27.4.2 Restore: Step 2
Select a previous archive backup that you want to restore to the NAS.

Figure 211 Protect > Restore: Step 2

The following table describes the labels in this screen.
Table 139 Protect > Restore: Step 2
LABEL

DESCRIPTION

Step 2. Select
Restore Point

If you selected Remote NAS for the backup you want to restore, you can see a list of all the
backups you performed in the Job Name table.
If you selected Internal or External Volume for the backup you want to restore, you can
see a list of restore times for the backups you performed in the Restored Time table.

Job Name

Select a previous backup job in the list that you want to restore to your NAS. Once you
choose a job name, all available restore times for that backup job shows in the Restored
Time table.

Restored Time

Select a previous backup job in the list that you want to restore to your NAS.

Previous

Click this to go back to the previous screen.

Next

Click this to go to the next screen.

27.4.3 Restore: Step 3
Use this screen to select the folder where the archive you want to restore is located.
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Figure 212 Protect > Restore: Step 3

The following table describes the labels in this screen.
Table 140 Protect > Restore: Step 3
LABEL

DESCRIPTION

Step 3. Please select which file(s)/folder(s) to restore.
Folder Chooser

Select the folder where the backup you want to restore is located.

Selected Folder

This shows the path of the folder you selected.

Previous

Click this to go back to the previous screen.

Next

Click this to go to the next screen.

27.4.4 Restore: Step 4
Use this screen to select the location in the NAS where you want to restore your backup.
Figure 213 Protect > Restore: Step 4
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The following table describes the labels in this screen.
Table 141 Protect > Restore: Step 4
LABEL

DESCRIPTION

Step 3. Set a restore target and start restoring
Browse

Click this to select a folder where you want to place the restored files.

•
•
•
•

Volume - Select a volume from the list.
Current Location - This is the location of the selected folder.
Type - This identifies the item as a file or folder.
Name - This is the name of the folder/file.

Click Apply to save your settings and Cancel to close the screen.
Previous

Click this to go back to the previous screen.

Done

Click this to run the restore process and go back to the Backup screen.

27.5 Configuration File Backup and Restoration
Use the Maintenance > Configuration menus to create a file of your NAS configurations such as
passwords, shares and volumes created, network settings and so on. If you’re going to do some
major configuration changes, then it is advisable to create a configuration backup file. If things go
wrong after you make the configuration changes, you can always go back to the previous
configuration by restoring an earlier configuration file.
If you forgot the NAS password, then use the RESET button (see Section 1.7 on page 17) to return
the NAS to the factory default configuration.

Note: Configuration File Backup and Restoration does not affect data (your files and
folders), volumes on the NAS.

Cloud Storage User’s Guide

336

C HAPTER

28

Troubleshooting
28.1 Troubleshooting Overview
This chapter offers some suggestions to solve problems you might encounter. The potential
problems are divided into the following categories.
• Power, Hardware, Connections, and LEDs
• NAS Starter Utility
• NAS Login and Access
• I Cannot Access The NAS
• Users Cannot Access the NAS
• External USB Drives
• Storage
• Firmware
• File Transfer
• Networking
• Some Features’ Screens Do Not Display
• Media Server Functions
• Download Service Functions
• Web Publishing
• Auto Upload
• Package Management
• Backups
• Google Drive

28.2 Power, Hardware, Connections, and LEDs
The NAS PWR LED does not turn on (no LEDs are on).

• Make sure the NAS is turned on.
• Make sure you are using the power adaptor or cord included with the NAS.
• Make sure the power adaptor or cord is connected to the NAS and plugged in to an appropriate
power source. Make sure the power source is turned on.
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• Turn the NAS off and on.
• If the problem continues, contact the vendor.

An HDD LED is off.

The HDD LED is off when the NAS cannot detect a hard drive in the drive bay. Replace or install a
hard drive. See Installing or replacing a hard disk.

An HDD LED is red.

Red means that the NAS detected an error on the hard drive (like a bad sector for example). The
NAS automatically tries to recover a bad sector, but the LED stays red until the NAS restarts. Even
if the hard drive still functions, it is recommended that you replace it since errors are a sign that the
hard drive may fail soon. See Installing or replacing a hard disk.

Installing or replacing a hard disk.

Do not remove or install a hard disk while the NAS is turned on. The NAS
must be turned off before you remove or install the hard disk.
1

Turn the NAS off, remove the front panel and make sure:
• there is a SATA I or SATA II (3.0 Gbit/s) compatible hard disk installed.
• the hard disk is installed correctly in the disk bay. Push the disk back into the NAS disk bay
until the hard disk is fitted snugly inside the NAS (see the NAS Quick Start Guide).
• the hard disk could be faulty. Try a different hard drive or test the original hard disk in a
different NAS or computer.

2

If you had to replace the drive, turn on the NAS and go to the Storage screen.
• If you have a RAID I volume click the Repair icon next to the new drive.
• If you are using RAID 0 you will need to recreate the whole volume. All of your data is lost.
• If you are using a single-disk JBOD volume, you need to create a new volume on the new
drive.
• If you are using a two-disk JBOD volume, you need to create a whole new volume on both
drives.

The LAN LED (by the LAN port) is off.
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• Make sure the Ethernet cable is connected properly to the NAS and connected to another
(Ethernet) device. Make sure the other device is turned on. If it’s connected directly to a
computer, make sure that the computer network card is working (ping 127.0.0.1 on the
computer).
• Use another Ethernet cable. If you’re connecting to a Gigabit Ethernet, make sure you’re using
an 8-wire Ethernet cable.
• If the problem continues, contact the vendor.
See Table 1 on page 15 for a description of NAS LEDs.

The NAS turns off or reboots by itself.

Check the Power Management screen. This is where you configure power settings for the NAS,
including power saving, UPS, power on/off during power failure and power on/off schedule. The
NAS may be set to turn off under certain conditions.

A power failure occurred while the NAS was downloading files.

• If power failure occurs during the active download period, the NAS will verify whether the
downloaded files were damaged.
• If a file is corrupted, the NAS will download the file again.
•

If the file is intact but not completely downloaded, the NAS will resume the download task after
it restarts.

28.3 NAS Starter Utility
The NAS Starter Utility cannot discover my NAS.

• Close the NAS Starter Utility and reopen it.
• Check your hardware connections and make sure they are set up correctly.
• Only one instance of the NAS Starter Utility can run on your computer. Make sure you close any
duplicate windows for this application.
• Wait for the SYS LED to stop blinking before clicking Discover.
• Confirm that the computer running the NAS Starter Utility has a network connection. See the
section on the NAS’s LAN connection for related information.
• The computer running the NAS Starter Utility can only discover NASs in the same subnet. NASs
connected to the same switch or router as your NAS Starter Utility computer are usually in the
same subnet unless the router is doing subnetting or the switch is implementing VLAN.
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The NAS Starter Utility discovered my NAS but the status is always unreachable, even
though I can access it.

You may need to add the NAS Starter Utility to your software firewall’s allow list or lower your
software firewall or anti-virus scanner’s security level. Alternatively you may have to configure your
software firewall or other security software to allow UDP port 50127 traffic from the NAS. If there is
a hardware firewall between you and the NAS, configure it to allow UDP port 50127 traffic from the
NAS.

I have at least two NASs in my network, how do I identify which one I want to configure in
the NAS Starter Utility screens.

If you have several NASs connected to your computer/network, give each a unique name. You may
have to disconnect all but one and use the NAS Starter Utility to rename it. Then connect another
NAS and rename it and continue to connect and rename the NASs one-by-one until they are all
connected and each has a unique name.
Alternatively, if you have a DHCP server on your network and you can access it’s list of assigned IP
addresses, you could see which IP address belongs to which NAS. You can check the MAC address
of your NAS by checking the attached sticker in the device housing.

28.4 NAS Login and Access
I forgot the server name of the NAS.

• The default server name is ‘NAS’ followed by the number of your model (‘NAS540’ for example).
• Use the NAS Starter Utility to discover your NAS. If you have admin privileges, you can directly
change the IP address of the NAS using the NAS Starter Utility.
• If the server name has changed and you don’t have the NAS Starter Utility, see Section 1.7 on
page 17 to use the RESET button to return to the default setting.

I cannot get to the NAS login screen.

• Use the NAS Starter Utility to discover your NAS. If you have admin privileges, you can directly
change the IP address of the NAS using the NAS Starter Utility.
• Make sure you have used the NAS Starter Utility to initialize your NAS.
• If you used the RESET button, the NAS may have a new IP address. Close and reopen the NAS
Starter Utility to discover the NAS.
• Make sure the NAS is turned on.
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• If you are trying to login directly by typing the server name into your web browser’s address
field, make sure you are using the correct server name as the web site address.
• The default server name is ‘NAS’ followed by the number of your model (‘NAS540’ for
example). If you have changed the server name, use the new one.
• If the server name has been changed and you do not know the new server name, see the
troubleshooting suggestions for I forgot the server name of the NAS.
• If it still doesn’t work, try using the NAS Starter Utility.
• Check the hardware connections, and make sure the LEDs are behaving as expected. See the
Quick Start Guide and Table 1 on page 15.
• By default, the NAS gets an IP address automatically. The NAS assigns itself an IP address if no
device assigns one. If your computer is also set to get an IP address automatically, the computer
and the NAS can both assign themselves IP addresses and communicate. See Section 10.4 on
page 107 if you need to configure the NAS with a static IP address.
• If you are connecting to the NAS by its IP address, make sure you use the correct one. If the NAS
has a wired Ethernet connection and a wireless connection through an attached USB wireless
dongle, the NAS has a different IP address for each connection. To connect through the wired
Ethernet connection, use the wired Ethernet connection’s IP address. To connect through the
wireless connection, use the wireless connection’s IP address.
• Make sure your computer’s IP address is in the same subnet as the NAS’s IP address. You can use
the NAS Starter Utility to find the NAS’s IP address. Skip this if you know that there are routers
between your computer and the NAS.
• Ping the NAS from your computer. Make sure your computer’s Ethernet adapter is installed and
functioning properly. In a (Windows) computer, click Start, (All) Programs, Accessories and
then Command Prompt. In the Command Prompt window, type “ping” followed by the NAS’s
IP address (use the NAS Starter Utility to find the NAS’s IP address if you don’t know it) and then
press [ENTER].
• Make sure you are using Internet Explorer 6.0 (and later) or Firefox 1.07 (and later).
• Make sure your Internet browser does not block pop-up windows and has JavaScript and Java
enabled. With Internet Explorer 6, you may also have to enable scripting of safe ActiveX controls.
See Section 28.4.1 on page 341.

I forgot the password.

• The default password is 1234.
• If you have changed the password and forgotten it, you will have to reset the NAS.

28.4.1 Enabling Scripting of Safe ActiveX Controls
If pages of the web configurator do not display properly in Internet Explorer, check that scripting of
safe ActiveX controls is enabled.
1

In Internet Explorer, click Tools, Internet Options and then the Security tab.
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Figure 214 Internet Options: Security

2

Click the Custom Level... button.

3

Under Script ActiveX controls marked safe for scripting, make sure that Enable is selected
(the default).

4

Click OK to close the window.
Figure 215 Security Settings - Script Safe ActiveX Controls

I can see the login screen, but I cannot log in to the NAS.
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• Make sure you have entered the username and password correctly. The default username is
admin, and the default password is 1234. These fields are case-sensitive, so make sure [Caps
Lock] is not on.
• Turn the NAS off and on.
• If this does not work, see Section 1.7 on page 17 to reset the device.

I cannot see the multi-language web configurator screens while using Internet Explorer.

Use Section 28.4.1 on page 341 to enable the scripting of safe ActiveX controls.

The Web Configurator logs out by itself.

The web configurator management session automatically times out if it is left idle for 15 minutes.
Simply log back into the NAS if this happens to you.

28.5 I Cannot Access The NAS
I cannot access a share.

• Check that the NAS is turned on and connected to the network. Try to ping the NAS or use the
NAS Starter Utility to discover it.
• Make sure you have used the NAS Starter Utility to initialize your NAS. See Chapter 2 on page 19
for more information.
• Check that you entered your login name and password correctly.
• Check that the share exists and check its access settings.
• Check if the shared folder is a subfolder of another (parent) share. Check that the parent share’s
access rights do not conflict with the subfolder share. It is recommended that you do not create
subfolder shares.
• Check if there are any existing mapped network drives to the NAS. You may need to disconnect
existing mapped network drives as a new mapped network drive connection may use (different)
previously-saved login information. To do this, open Windows Explorer and click Tools >
Disconnect Mapped Network Drives.
• Check that the volume in which the share resides, exists and is not down or degraded. If it is
down or degraded, see Section 28.2 on page 337.
• Make sure you have the client for Microsoft networks installed and enabled in your network
connection’s properties.
• In Windows XP or 2000, click Start > Settings > Control Panel > Network Connections
(Network and Dial-up Connections in Windows 2000/NT) > Local Area Connection >
Properties.
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• Check that Client for Microsoft Networks is in the list of components and has its check box
selected.

28.6 Users Cannot Access the NAS
A local user cannot access a share

• Check that the NAS is turned on and connected to the network. The local user should try to ping
the NAS or use the NAS Starter Utility to discover it.
• The local user should check that he entered his login name and password correctly.
• Check if the share exists and has the correct access settings for this user.
• Check the Access Control List (ACL) of read/write permissions associated with specific files and/
or folders. Account names added to the list are linked to the files and folders that they are
allowed to access, along with what kinds of actions they are allowed to perform with those files
and folders (delete, move, rename, and so on).
• The user’s computer may already be connected to another of the NAS’s shares using a different
user name and/or password. This can happen without the user realizing it if the user’s computer
automatically connects to a share at logon. Right-click any other connected shares and click
Disconnect. Then re-attempt to connect to the desired share.
• Check if the share has an ANONYMOUS or EVERYONE access right. If the user is already logged
into a share using her username and password, she will NOT be able to access a share that has
ANONYMOUS FTP only access rights (as these require ‘no login’). In this case she should log out
and try to access the share again without logging in. See Section 17.4 on page 215 for more
details.
• Check if the shared folder is a subfolder of another (parent) share. Check that the parent share’s
access rights do not conflict with the subfolder share. It is recommended that you do not create
subfolder shares.
• Check if the user belongs to a group with conflicting access rights. DENY always takes
precedence. If you allow a user FULL access to a share but set his group to DENY, then he will
NOT be able to access the share.
• The local user should check if there are any existing mapped network drives to the NAS. He may
need to disconnect existing CIFS connections as new CIFS connection may use previously-saved
login information that may be different to NAS login.
• Check that the array in which the share resides, exists and is not down or degraded. If the array
is down or degraded, see Section 28.2 on page 337.
• If the user is using DFS links, then he can only access the NAS using CIFS and not FTP.
• Check that the share has not been disabled.

I cannot import domain user or user group information even though testing of the connection
to the domain controller is OK.
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• Check the NAS’s DNS setting. The DNS server the NAS is using must be able to resolve the
domain controller’s address. If the domain controller uses a private IP address, the NAS needs to
use a private DNS server. If the domain controller uses a public IP address, the NAS needs to use
a public DNS server.
• Leave the domain and re-join it.

A domain user can’t access a share.

In addition to the checks listed previously for local users, check that the domain controller is turned
on and connected to the network.

A user can access a share but cannot access individual folders or files within the share.

• Check the Access Control List (ACL) of read/write permissions associated with the share’s
specific files and/or folders. Account names added to the list are linked to the files and folders
that they are allowed to access, along with what kinds of actions they are allowed to perform
with those files and folders (delete, move, rename, and so on).

28.7 External USB Drives
The COPY LED is red.

Copying files to or from a USB device or SD card failed. The USB device or SD card may not be
compatible with the NAS. Try to save the files onto a computer and then from the computer to the
NAS (through the network connection).

28.8 Storage
Migrating from RAID 1 to RAID 5 did not expand the storage capacity.

The NAS normally expands the storage capacity by itself after rebuilding the RAID but may not if
the NAS rebooted during the RAID re-build.
After the re-build finishes, go to the Storage screens and select the volume or disk group and click
Manage and use Expand the volume with unallocated disk space.
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Replacing smaller disks in a RAID 1, RAID 5, or RAID 6 with larger capacity hard disks did not
expand the storage capacity.

The NAS normally expands the storage capacity by itself after rebuilding the RAID but may not if
the NAS rebooted during the RAID re-build.
After the re-build finishes, go to the Storage screens and select the volume or disk group and click
Manage and use Expand the volume with unallocated disk space.

28.9 Firmware
I want to know the firmware version on the NAS.

Go to the Status screen. The Firmware field shows you the current firmware version running.

28.10 File Transfer
I want to transfer my file(s) from my local computer or storage device to the NAS.

• After you initialize your hard disk, you can directly access the folders in your NAS and transfer
files in the same way you transfer files in your local computer:
1

On your Windows computer, click Start > Run or open a web browser.

2

Enter \\nas followed by the number of your model (540 for example) or the Server Name you
assigned the NAS. This shows you the folders in the NAS.

3

Use drag-and-drop or copy-and-paste to transfer files over to your NAS.
• Use the COPY/SYNC button to transfer files from an external (USB) storage device to the NAS.

I want to transfer my file(s) from the NAS to my local computer or storage device.

• After you initialize your hard disk, you can directly access the folders in your NAS and transfer
files in the same way you transfer files in your local computer:
1

On your Windows computer, click Start > Run or open a web browser.
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2

Enter \\nas followed by the number of your model (540 for example) or the Server Name you
assigned the NAS. This shows you the folders in the NAS.

3

Use drag-and-drop or copy-and-paste to transfer files from your NAS to your local computer’s folder
or your storage device.
• You can download the files from your NAS. Just click on the file(s) in the Share Browsing screen
(Section 11.2 on page 124). Your computer will prompt you for the location where you want to
save the file.

28.11 Networking
I want to control who can access my folder(s)/file(s).

• If you are an administrator, you can configure a user’s access rights. Use the Shares screen
(Section 24.3 on page 291) to do this.
• If you enabled Web Publishing for a folder, anyone on your network can play the media files in
the published shares. No user name and password or other form of security is used. The media
server is enabled by default with the video, photo, and music shares published.

One of the computers in my network cannot use the printer I connected to the NAS.

• You must install the printer driver on each computer that will use the printer.
• Check Section 28.4 on page 340 and check for related connectivity issues.

28.12 Some Features’ Screens Do Not Display
Many NAS features require a valid internal volume.

Features like the print server, download service, FTP and Windows/CIFS access will not work
without a valid internal volume. Make sure you have a volume on an internal disk and that the
volume is in the healthy state.
• Install an internal disk if one is not installed yet or has failed. See the Quick Start Guide for how
to install an internal disk.
• Create a new volume if you do not have one on the internal disk yet.
• Make sure the volume on the installed internal disk is in a healthy state.
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I cannot use some applications in the Web Configurator.

• The firmware installed in your NAS includes the features mentioned in Section 10.8 on page 122.
This does not include the applications you can install using the Package Management screen.
• You can use the Package Management screen (Chapter 18 on page 246) to install more
applications from a web location (specified in the firmware) to your NAS.
• If you have installed the application and can see the application’s configuration screen but still
cannot use it, check that you have Enabled the application.

28.13 Media Server Functions
I set the media server function to publish a folder, but some of the files in the folder do not
display in the list on the media client.

Files with formats that are not supported on the media server may not display in the list. See page
354 for the file formats that the media server supports.

I published a folder with the media server function, but the media client does not play some
of the files (or does not play them properly).

1

Files with formats that are not supported on the media server may not display in the list. See page
354 for the file formats that the media server supports.

2

If you are using media client software, you may need to install codecs on your computer. Since the
media client software uses your computer’s installed codecs, files do not play if the required codec
is not installed on your computer.

3

The media client may not support the file’s format.

iTunes does not display the names of all the music files I just put on the NAS.

1

Make sure the files are a format supported by iTunes. See page 354.

2

Go to Applications > Media Server. Make sure the share containing the music files is published
and the iTunes server option is enabled.

3

If an iTunes client is connected, the NAS’s iTunes server function scans the published media server
folders for files every three minutes. Leave iTunes connected to the NAS for three minutes. Then
use the NAS’s eject button (as shown next) to disconnect.
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Figure 216 iTunes Eject Button

4

Then click the NAS’s link to reconnect.
Figure 217 iTunes Reconnected

5

Another way to get the NAS’s iTunes server function to scan the published media server folders for
files is to go to Applications > Media Server and disable and re-enable the iTunes server option.
If you uploaded many files, it may take awhile for the NAS to find and list all of them. Then try
reconnecting your iTunes client.

I cannot use iTunes to play files located on my NAS.

1

Make sure the files are a format supported by iTunes. See page 354.

2

If you have files from the iTunes Store that use DRM, you need to use your Apple account ID and
password to authorize other computers to play the files. Apple permits you to authorize up to five
computers at a time. To authorize a computer, open iTunes and click Store > Authorize
Computer.
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3

If you are connecting through a NAT router, make sure that TCP port 3689 and UDP port 5353 are
open for traffic on both the server and the client and all points in between (especially the NAT
router). If your router includes a firewall, make sure it also allows TCP port 3689 and UDP port
5353 traffic.

28.14 Download Service Functions
The download list items are missing after I removed a hard drive.

The NAS’s download list is stored on the system volume. If you have two JBOD volumes, it is
possible to remove one and still use the other. However if you remove the system volume, you may
lose the download list. With two JBOD volumes, the hard disk that was installed first is usually the
system volume.

I cannot find the download files.

By default, the Download Service feature stores downloaded files as follows:
• P2P download jobs are stored in /*/incoming (where ‘*’ is a folder that you have set.)
• HTTP/FTP jobs are stored in /* (where ‘*’ is a folder that you have set.)
• All jobs triggered by RSS channels create the subfolder in /* using the channel name where it
store all files downloaded from that channel (where ‘*’ is a folder that you have set.)
Check your Preferences in the Download Service (Section 17.7 on page 219) screens to know or
configure where downloaded files are stored.

28.15 Web Publishing
A web-published share cannot be accessed by web browser from the Internet.

• Make sure the person trying to access the share is using the correct web address (and port
number if the NAS’s web publishing feature is not using port 80). See page 240 for details.
• Make sure the publishing feature is turned on and the share is in the list of published shares.
• Make sure the person trying to access the share is using Internet Explorer 6.0 (and later) or
Firefox 1.07 (and later).
• You need to use a public address to access the NAS’s web-published shares from the Internet. If
your NAS uses a private IP address, use the public IP address of your Internet gateway (firewall)
and configure NAT or port forwarding on your Internet gateway and possibly firewall rules in
order to let people access the NAS’s web-published shares from the Internet.
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• Make sure the firewall’s public IP address is static or that the firewall uses a Dynamic Domain
Name (DDNS).
• Web publishing uses TCP protocol and the port number you specify. Make sure there is not
another service using TCP protocol with the same port number.
• If Firefox access to the share does not work, check that you did not set the Web publishing
feature to use one of the following ports. (Firefox blocks these ports by default.)
Table 142 Ports Blocked By Default in Firefox
PORT

SERVICE

PORT

SERVICE

PORT

SERVICE

1

tcpmux

95

supdup

513

login

7

echo

101

hostriame

514

shell

9

discard

102

iso-tsap

515

printer

11

systat

103

gppitnp

526

tempo

13

daytime

104

acr-nema

530

courier

15

netstat

109

POP2

531

chat

17

qotd

110

POP3

532

netnews

19

chargen

111

sunrpc

540

uucp

20

ftp data

113

auth

556

remotefs

21

ftp control

115

sftp

563

NNTP+SSL

22

ssh

117

uucp-path

587

submission

23

telnet

119

NNTP

601

syslog

25

smtp

123

NTP

636

LDAP+SSL

37

time

135

loc-srv epmap

993

IMAP+SSL

42

name

139

netbios

995

POP3+SSL

43

nicname

143

IMAP2

2049

nfs

53

domain

179

BGP

4045

lockd

77

priv-rjs

389

LDAP

6000

X11

79

finger

465

SMTP+SSL

87

ttylink

512

print exec

• Make sure your ISP allows you to run a server and is not blocking the port number of the NAS’s
web publishing feature.

28.16 Auto Upload
The NAS does not automatically upload files to Flickr or YouTube.

1

Make sure the NAS is connected to the Internet. See Section 10.4 on page 107 for details about
testing network connections.

2

Click Maintenance > Log to check the NAS’s log for a message about the file.
2a

If the log message displays “no such file or directory”, the file may have been removed from
the NAS. Make sure the file still exists in the watch folder.
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2b

2c

If the log message displays “filename is queued”, the file may still be waiting for auto upload.
Check the grace period setting in the service’s Configuration screen. You can set a smaller
grace period to shorten the queue time.
If you cannot find any log messages about the file:
• Make sure the Folder Watch List includes the folder containing the file. You can upload the
file to the watch folder again.
• Make sure the file’s format is supported by Flickr or YouTube. You can find the supported file
extensions in the Folder Watch List.

2d

If the log message displays “not authorized yet”, check if you can enter the NAS’s
Configuration screen for the service. If you changed the password of your Flickr or YouTube
account, you cannot access the service’s Configuration screen, and the NAS cannot auto
upload files. Make sure you also update the account information in the NAS.

3

Make sure the file size does not exceed the limit imposed by the service. At the time of writing,
Flickr restricts the file size to 10 MB, and YouTube restricts the file size to 100 MB.

4

Make sure you did not exceed the service’s upload quota. Flickr and YouTube have different policies
about how much you can upload within a certain period, for example, 100 MB/week.

5

The NAS may have temporarily failed to connect to the service. You can upload the file to the watch
folder again.

28.17 Package Management
The NAS won’t install the package(s) I selected in the Package Management screen.

• The web location of the package may be undergoing maintenance. Try again at a later time.
Upgrade the firmware of the NAS.
• If a new firmware is available, do an upgrade and try installing the package(s) again.

I want to know how my hard disk is performing.

Use S.M.A.R.T. (Self Monitoring, Analysis, and Reporting Technology) to monitor hard disks. It
detects and reports the reliability of hard disks using standard indicators, enabling administrators to
anticipate possible disk failures.

28.18 Backups
I cannot make a backup.
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• Check that enough space is available on the external disk. If there isn’t you may need to purge
older backups or delete other files on the backup USB disk or NAS.
• If you are using the Backup screen (Section 27.3 on page 321):
• You can look at the Backup screen’s Last Run Result display.
• If you’re backing up to another NAS or a computer, check that it allows the NAS to write files to
it. For a synchronization backup, the target must be another NAS or another compatible
model.
• Check that the NAS is not performing another backup job. Scheduler queues backups when a
different backup is already going on at the time a backup is scheduled.

The backup does not run at the time configured.

• Check that the correct time is configured on the NAS.
• Check that the NAS is able to access the time server from which it gets the time; see Section
16.6 on page 210.

28.19 Google Drive
Google Drive stopped syncing.

1

Make sure the NAS is connected to the Internet. See Section 10.4 on page 107 for details about
testing network connections.

2

Check if you have exceeded the Google Drive account’s storage quota. You may need to:
• Delete unneeded files.
• Empty the Google Drive trash bin. Note, this permanently deletes everything in the bin, even if
Google moved it there without telling you (because you moved a file out of the local sync folder
for example).
• Upgrade the account’s capacity

3

Click Maintenance > Log to check the NAS’s log messages. If a log message says you have
exceeded your storage quota on the NAS:
• Delete unneeded files.
• Clean out the recycle bin (see Section 24.4.2 on page 296).
• Increase the user’s quota on the volume containing the local sync folder (see Section 22.3.2 on
page 283).

4

Check for any logs about removal of the user account. When you remove a user’s NAS account, the
NAS also removes the link to the user’s Google account. However the NAS keeps the data in the
local sync folder. Reconfigure a user account and link it to the Google account to let the user use
Google Drive again.
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Product Specifications
See also Chapter 1 on page 14 for a general overview of the key features.

Supported Media Server Content Formats
The following describes the details about the files that the NAS media server can publish.
• Audio: LPCM (not supported as a file format), MP3, WMA, M4A, M4B, MP4, 3GP, WAV, OGG, FLAC,
AAC, MP2, AC3, MPA, MP1, AIF, ASF, FLV, DSD
• Images: JPEG, PNG, TIF, TIFF, BMP, GIF
• Video: WMV, MPEG2, MP1, MPG, SPTS, MP4, AVI, VOB, DivX, 3GP, VDR, MPE, DVR-MS, Xvid, M1V,
M4V, MOV, MPV, MKV, OGG, FLV, MTS

Note: Not all published file types can be viewed by all client applications.

Supported iTunes Server Content Formats
At the time of writing, the NAS supports iTunes publishing audio files of the following formats: mp3,
m4a, m4p, wav, and mp4.
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B

Customer Support
In the event of problems that cannot be solved by using this manual, you should contact your
vendor. If you cannot contact your vendor, then contact a ZyXEL office for the region in which you
bought the device.
See http://www.zyxel.com/homepage.shtml and also
http://www.zyxel.com/about_zyxel/zyxel_worldwide.shtml for the latest information.
Please have the following information ready when you contact an office.

Required Information
• Product model and serial number.
• Warranty Information.
• Date that you received your device.
• Brief description of the problem and the steps you took to solve it.

Corporate Headquarters (Worldwide)
Taiwan
• ZyXEL Communications Corporation
• http://www.zyxel.com

Asia
China
• ZyXEL Communications (Shanghai) Corp.
ZyXEL Communications (Beijing) Corp.
ZyXEL Communications (Tianjin) Corp.
• http://www.zyxel.cn

India
• ZyXEL Technology India Pvt Ltd
• http://www.zyxel.in

Kazakhstan
• ZyXEL Kazakhstan
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• http://www.zyxel.kz

Korea
• ZyXEL Korea Corp.
• http://www.zyxel.kr

Malaysia
• ZyXEL Malaysia Sdn Bhd.
• http://www.zyxel.com.my

Pakistan
• ZyXEL Pakistan (Pvt.) Ltd.
• http://www.zyxel.com.pk

Philippines
• ZyXEL Philippines
• http://www.zyxel.com.ph

Singapore
• ZyXEL Singapore Pte Ltd.
• http://www.zyxel.com.sg

Taiwan
• ZyXEL Communications Corporation
• http://www.zyxel.com/tw/zh/

Thailand
• ZyXEL Thailand Co., Ltd
• http://www.zyxel.co.th

Vietnam
• ZyXEL Communications Corporation-Vietnam Office
• http://www.zyxel.com/vn/vi

Europe
Austria
• ZyXEL Deutschland GmbH
• http://www.zyxel.de
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Belarus
• ZyXEL BY
• http://www.zyxel.by

Belgium
• ZyXEL Communications B.V.
• http://www.zyxel.com/be/nl/
• http://www.zyxel.com/be/fr/

Bulgaria
• ZyXEL България
• http://www.zyxel.com/bg/bg/

Czech Republic
• ZyXEL Communications Czech s.r.o
• http://www.zyxel.cz

Denmark
• ZyXEL Communications A/S
• http://www.zyxel.dk

Estonia
• ZyXEL Estonia
• http://www.zyxel.com/ee/et/

Finland
• ZyXEL Communications
• http://www.zyxel.fi

France
• ZyXEL France
• http://www.zyxel.fr

Germany
• ZyXEL Deutschland GmbH
• http://www.zyxel.de

Hungary
• ZyXEL Hungary & SEE
• http://www.zyxel.hu
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Italy
• ZyXEL Communications Italy
• http://www.zyxel.it/

Latvia
• ZyXEL Latvia
• http://www.zyxel.com/lv/lv/homepage.shtml

Lithuania
• ZyXEL Lithuania
• http://www.zyxel.com/lt/lt/homepage.shtml

Netherlands
• ZyXEL Benelux
• http://www.zyxel.nl

Norway
• ZyXEL Communications
• http://www.zyxel.no

Poland
• ZyXEL Communications Poland
• http://www.zyxel.pl

Romania
• ZyXEL Romania
• http://www.zyxel.com/ro/ro

Russia
• ZyXEL Russia
• http://www.zyxel.ru

Slovakia
• ZyXEL Communications Czech s.r.o. organizacna zlozka
• http://www.zyxel.sk

Spain
• ZyXEL Communications ES Ltd
• http://www.zyxel.es

Sweden
• ZyXEL Communications
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• http://www.zyxel.se

Switzerland
• Studerus AG
• http://www.zyxel.ch/

Turkey
• ZyXEL Turkey A.S.
• http://www.zyxel.com.tr

UK
• ZyXEL Communications UK Ltd.
• http://www.zyxel.co.uk

Ukraine
• ZyXEL Ukraine
• http://www.ua.zyxel.com

Latin America
Argentina
• ZyXEL Communication Corporation
• http://www.zyxel.com/ec/es/

Brazil
• ZyXEL Communications Brasil Ltda.
• https://www.zyxel.com/br/pt/

Ecuador
• ZyXEL Communication Corporation
• http://www.zyxel.com/ec/es/

Middle East
Israel
• ZyXEL Communication Corporation
• http://il.zyxel.com/homepage.shtml

Middle East
• ZyXEL Communication Corporation
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• http://www.zyxel.com/me/en/

North America
USA
• ZyXEL Communications, Inc. - North America Headquarters
• http://www.zyxel.com/us/en/

Oceania
Australia
• ZyXEL Communications Corporation
• http://www.zyxel.com/au/en/

Africa
South Africa
• Nology (Pty) Ltd.
• http://www.zyxel.co.za
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Legal Information
Copyright
Copyright © 2015 by ZyXEL Communications Corporation.
The contents of this publication may not be reproduced in any part or as a whole, transcribed, stored in a retrieval system, translated into
any language, or transmitted in any form or by any means, electronic, mechanical, magnetic, optical, chemical, photocopying, manual, or
otherwise, without the prior written permission of ZyXEL Communications Corporation.
Published by ZyXEL Communications Corporation. All rights reserved.

Disclaimer
ZyXEL does not assume any liability arising out of the application or use of any products, or software described herein. Neither does it
convey any license under its patent rights nor the patent rights of others. ZyXEL further reserves the right to make changes in any
products described herein without notice. This publication is subject to change without notice.

Regulatory Notice and Statement
UNITED STATES of AMERICA

The following information applies if you use the product within USA area.

FCC EMC Statement
•

The device complies with Part 15 of FCC rules. Operation is subject to the following two conditions:

(1) This device may not cause harmful interference, and
(2) this device must accept any interference received, including interference that may cause undesired operation.
• Changes or modifications not expressly approved by the party responsible for compliance could void the user’s authority to operate the
equipment.
• This product has been tested and complies with the specifications for a Class B digital device, pursuant to Part 15 of the FCC Rules.
These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed and used according to the instructions, may cause
harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular
installation.
• If this equipment does cause harmful interference to radio or television reception, which is found by turning the equipment off and on,
the user is encouraged to try to correct the interference by one or more of the following measures:
•Reorient or relocate the receiving antenna
•Increase the separation between the equipment or devices
•Connect the equipment to an outlet other than the receiver’s
•Consult a dealer or an experienced radio/TV technician for assistance

CANADA
The following information applies if you use the product within Canada area

Industry Canada ICES statement
CAN ICES-3 (B)/NMB-3(B)
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EUROPEAN UNION

The following information applies if you use the product within the European Union.

List of national codes
COUNTRY

ISO 3166 2 LETTER CODE

COUNTRY

ISO 3166 2 LETTER CODE

Austria

AT

Liechtenstein

LI

Belgium

BE

Lithuania

LT

Bulgaria

BG

Luxembourg

LU

Croatia

HR

Malta

MT

Cyprus

CY

Netherlands

NL

Czech Republic

CZ

Norway

NO

Denmark

DK

Poland

PL

Estonia

EE

Portugal

PT

Finland

FI

Romania

RO

France

FR

Serbia

RS

Germany

DE

Slovakia

SK

Greece

GR

Slovenia

SI

Hungary

HU

Spain

ES

Iceland

IS

Switzerland

CH

Ireland

IE

Sweden

SE

Italy

IT

Turkey

TR

Latvia

LV

United Kingdom

GB

Safety Warnings
•
•
•
•
•
•
•
•
•
•
•
•

•
•

•

DO NOT use this product near water, for example, in a wet basement or near a swimming pool.
DO NOT expose your device to dampness, dust or corrosive liquids.
DO NOT store things on the device.
DO NOT install, use, or service this device during a thunderstorm. There is a remote risk of electric shock from lightning.
Connect ONLY suitable accessories to the device.
DO NOT open the device or unit. Opening or removing covers can expose you to dangerous high voltage points or other risks. ONLY
qualified service personnel should service or disassemble this device. Please contact your vendor for further information.
Make sure to connect the cables to the correct ports.
Place connecting cables carefully so that no one will step on them or stumble over them.
Always disconnect all cables from this device before servicing or disassembling.
DO NOT remove the plug and connect it to a power outlet by itself; always attach the plug to the power adaptor first before connecting
it to a power outlet.
DO NOT allow anything to rest on the power adaptor or cord and do NOT place the product where anyone can walk on the power
adaptor or cord.
Please use the provided or designated connection cables/power cables/ adaptors. Connect it to the right supply voltage (for example,
110V AC in North America or 230V AC in Europe). If the power adaptor or cord is damaged, it might cause electrocution. Remove it
from the device and the power source, repairing the power adapter or cord is prohibited. Contact your local vendor to order a new one.
DO NOT use the device outside, and make sure all the connections are indoors. There is a remote risk of electric shock from lightning.
CAUTION: Risk of explosion if battery is replaced by an incorrect type, dispose of used batteries according to the instruction. Dispose
them at the applicable collection point for the recycling of electrical and electronic devices. For detailed information about recycling of
this product, please contact your local city office, your household waste disposal service or the store where you purchased the product.
DO NOT obstruct the device ventilation slots, as insufficient airflow may harm your device.

The following warning statements apply, where the disconnect device is not incorporated in the device or where the plug on the power
supply cord is intended to serve as the disconnect device,
• For permanently connected devices, a readily accessible disconnect device shall be incorporated external to the device;
• For pluggable devices, the socket-outlet shall be installed near the device and shall be easily accessible.
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Environment Statement
ErP (Energy-related Products)
ZyXEL products put on the EU market in compliance with the requirement of the European Parliament and the Council published
Directive 2009/125/EC establishing a framework for the setting of ecodesign requirements for energy-related products (recast), so called
as "ErP Directive (Energy-related Products directive) as well as ecodesign requirement laid down in applicable implementing measures,
power consumption has satisfied regulation requirements which are:
Network standby power consumption < 12W, and/or
Off mode power consumption < 0.5W, and/or
Standby mode power consumption < 0.5W.
Wireless setting, please refer to "Wireless" chapter for more detail.

European Union - Disposal and Recycling Information
The symbol below means that according to local regulations your product and/or its battery shall be disposed of separately from domestic
waste. If this product is end of life, take it to a recycling station designated by local authorities. At the time of disposal, the separate
collection of your product and/or its battery will help save natural resources and ensure that the environment is sustainable development.
Die folgende Symbol bedeutet, dass Ihr Produkt und/oder seine Batterie gemäß den örtlichen Bestimmungen getrennt vom Hausmüll
entsorgt werden muss. Wenden Sie sich an eine Recyclingstation, wenn dieses Produkt das Ende seiner Lebensdauer erreicht hat. Zum
Zeitpunkt der Entsorgung wird die getrennte Sammlung von Produkt und/oder seiner Batterie dazu beitragen, natürliche Ressourcen zu
sparen und die Umwelt und die menschliche Gesundheit zu schützen.
El símbolo de abajo indica que según las regulaciones locales, su producto y/o su batería deberán depositarse como basura separada de la
doméstica. Cuando este producto alcance el final de su vida útil, llévelo a un punto limpio. Cuando llegue el momento de desechar el
producto, la recogida por separado éste y/o su batería ayudará a salvar los recursos naturales y a proteger la salud humana y
medioambiental.
Le symbole ci-dessous signifie que selon les réglementations locales votre produit et/ou sa batterie doivent être éliminés séparément des
ordures ménagères. Lorsque ce produit atteint sa fin de vie, amenez-le à un centre de recyclage. Au moment de la mise au rebut, la
collecte séparée de votre produit et/ou de sa batterie aidera à économiser les ressources naturelles et protéger l'environnement et la
santé humaine.
Il simbolo sotto significa che secondo i regolamenti locali il vostro prodotto e/o batteria deve essere smaltito separatamente dai rifiuti
domestici. Quando questo prodotto raggiunge la fine della vita di servizio portarlo a una stazione di riciclaggio. Al momento dello
smaltimento, la raccolta separata del vostro prodotto e/o della sua batteria aiuta a risparmiare risorse naturali e a proteggere l'ambiente
e la salute umana.
Symbolen innebär att enligt lokal lagstiftning ska produkten och/eller dess batteri kastas separat från hushållsavfallet. När den här
produkten når slutet av sin livslängd ska du ta den till en återvinningsstation. Vid tiden för kasseringen bidrar du till en bättre miljö och
mänsklig hälsa genom att göra dig av med den på ett återvinningsställe.
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台灣

安全警告
為了您的安全，請先閱讀以下警告及指示 :
• 請勿將此產品接近水、火焰或放置在高溫的環境。
• 避免設備接觸任何液體 - 切勿讓設備接觸水、雨水、高濕度、污水腐蝕性的液體或其他水份。
• 灰塵及污物 - 切勿接觸灰塵、污物、沙土、食物或其他不合適的材料。
• 雷雨天氣時，不要安裝，使用或維修此設備。有遭受電擊的風險。
• 切勿重摔或撞擊設備，並勿使用不正確的電源變壓器。
• 若接上不正確的電源變壓器會有爆炸的風險。
• 請勿隨意更換產品內的電池。
• 如果更換不正確之電池型式，會有爆炸的風險，請依製造商說明書處理使用過之電池。
• 請將廢電池丟棄在適當的電器或電子設備回收處。
• 請勿將設備解體。
• 請勿阻礙設備的散熱孔，空氣對流不足將會造成設備損害。
• 請插在正確的電壓供給插座 ( 如 : 北美 / 台灣電壓 110V AC，歐洲是 230V AC)。
• 假若電源變壓器或電源變壓器的纜線損壞，請從插座拔除，若您還繼續插電使用，會有觸電死亡的風險。
• 請勿試圖修理電源變壓器或電源變壓器的纜線，若有毀損，請直接聯絡您購買的店家，購買一個新的電源變壓器。
• 請勿將此設備安裝於室外，此設備僅適合放置於室內。
• 請勿隨一般垃圾丟棄。
• 請參閱產品背貼上的設備額定功率。
• 請參考產品型錄或是彩盒上的作業溫度。
• 產品沒有斷電裝置或者採用電源線的插頭視為斷電裝置的一部分，以下警語將適用 :
－ 對永久連接之設備， 在設備外部須安裝可觸及之斷電裝置；
－ 對插接式之設備， 插座必須接近安裝之地點而且是易於觸及的。

Viewing Certifications
Go to http://www.zyxel.com to view this product’s documentation and certifications.

ZyXEL Limited Warranty
ZyXEL warrants to the original end user (purchaser) that this product is free from any defects in material or workmanship for a specific
period (the Warranty Period) from the date of purchase. The Warranty Period varies by region. Check with your vendor and/or the
authorized ZyXEL local distributor for details about the Warranty Period of this product. During the warranty period, and upon proof of
purchase, should the product have indications of failure due to faulty workmanship and/or materials, ZyXEL will, at its discretion, repair or
replace the defective products or components without charge for either parts or labor, and to whatever extent it shall deem necessary to
restore the product or components to proper operating condition. Any replacement will consist of a new or re-manufactured functionally
equivalent product of equal or higher value, and will be solely at the discretion of ZyXEL. This warranty shall not apply if the product has
been modified, misused, tampered with, damaged by an act of God, or subjected to abnormal working conditions.

Note
Repair or replacement, as provided under this warranty, is the exclusive remedy of the purchaser. This warranty is in lieu of all other
warranties, express or implied, including any implied warranty of merchantability or fitness for a particular use or purpose. ZyXEL shall in
no event be held liable for indirect or consequential damages of any kind to the purchaser.
To obtain the services of this warranty, contact your vendor. You may also refer to the warranty policy for the region in which you bought
the device at http://www.zyxel.com/web/support_warranty_info.php.

Registration
Register your product online to receive e-mail notices of firmware upgrades and information at www.zyxel.com for global products, or at
www.us.zyxel.com for North American products.

Open Source Licenses
This product contains in part some free software distributed under GPL license terms and/or GPL like licenses. Open source licenses are
provided with the firmware package. You can download the latest firmware at www.zyxel.com. To obtain the source code covered under
those Licenses, please contact support@zyxel.com.tw to get it.
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Index
iTunes server 214, 234
print server 240
configuration 231
name 232
web publishing 215, 230, 240
activation 230
example 238
port number 240

A
access rights 127
Flickr 267
shares 294, 295
YouTube 269
activation
download service 219
Flickr/YouTube 263
FTP 216
FTP Uploadr 270
recycle bins 127, 293
web publishing 230

archive 192
authorization
Flickr 263, 264
YouTube 267
auto upload
Flickr/YouTube 262
activation 263
authorization 263, 267
configuration 266, 267
FTP Uploadr 270
activation 270
bandwidth limit 273
configuration 272
server entry 271
grace period 267, 269, 273

adding channels 219
Amazon Fire TV 30
ANONYMOUS FTP 344
anonymous FTP access 216
Apple TV 30
applications 213, 262
adding channels 219
auto upload
Flickr/YouTube 262
FTP Uploadr 270
COPY/SYNC button 232
configuration 232
example 241
synchronization 242
download service 214, 235
activation 219
adding a task 222, 228
configuration 219
notifications 236
P2P download 222, 235
preferences 223
protection 236, 237
status 221
URL 222
FTP 213, 215, 262
activation 216
anonymous access 216
passive mode transfer 216
media server 214, 216
configuration 217

B
backup 191, 192, 254, 256
archive 192
synchronization tutorial 194
tutorial 194
backup files
restoring files by 34, 198
backup job
restoring files by 196
backup settings 310
bandwidth limit 273
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Index

S.M.A.R.T. attributes 79

C

displaying user information 285

certificate 312
editing 312
tutorial 177
verifying 186

DLNA 214, 234

certifications 362
viewing 365

Domain Name System, see DNS

DNS 106, 108
documentation
related 2

CIFS 206

domain user
troubleshooting 345
troubleshooting share access 345

cloud 251

download period control 225

cloud storage 254, 256

download service 214, 235
activation 219
adding a task 222, 228
configuration 219
download period control 225
notifications 236
activation 219
P2P download
IP filtering 227
protection 236, 237
re-seeding 220
settings 225
torrent files 222, 235
preferences 223
status 221
URL, download service 222

Chromecast 30

collaboration 256
configuration
COPY/SYNC button 232
download service 219
Flickr 266
FTP Uploadr 272
print server 231
recycle bins 296
YouTube 267, 268
contact information 355
control panel 106
COPY/SYNC button 17, 232
configuration 232
example 241
synchronization 242

downloading files 126

copying contents 298

Dropbox 274

copyright 361

duplexing 98

CPU
temperature 104
usage 104
creating
groups 288, 289
shares 292, 293
users 282, 283

E

customer support 355

explicit TLS/SSL 188

D

F

date 210

fan speed 104

desktop 41

file
troubleshooting access 345

Exchangeable image file format, see Exif
Exif 130

disclaimer 361

file browser
configure share 126

discovery 20
disk
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Index

file synchronization 256

adding 288, 289
editing 289
membership 284, 289
names 289
searching 288

File Transfer Protocol over Explicit TLS, see FTPES
File Transfer Protocol over TLS, see FTPS
files
downloading 126
uploading 126

Guide
Quick Start 2

FileZilla 188
FindMe 19
fingerprint 186

H

firmware, upgrading 122
Flickr 262
access rights 267
activation 263
authorization 263, 264
grace period 267
safety level 267

hot spare 102
HTTPS 182, 300, 311

I

folder
troubleshooting access 345

icons 140, 142
global 140
users 283

folder creation 125
FTP 188, 213, 215, 262
activation 216
anonymous access 216
over TLS 188
passive mode transfer 216

IP address 106
IP filtering 227
iSCSI 81
iSCSI target 86

FTP Uploadr 270
activation 270
bandwidth limit 273
configuration 272
grace period 273
server entry 271

iTunes server 214, 218, 234

J

FTPES 214

JBOD 98

FTPES - FTP over explicit TLS/SSL 188
FTPS 188, 262

K
G

Ken Burns 137

global icons 140
GMT 24, 211

L

Google Chromecast 30
Google Drive 256

lag, time 206

Google Maps 131

language 137

GPS 131

latitude 131

grace period 267, 269, 273

login 38

groups 287

Logitech® Media Server 218
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logs 306

PPPoE 107, 111, 119
TCP/IP 107

longitude 131

notifications
download service
activation 219

LUN 82

notifications, download service 236

M
maintenance 302
backup settings 310
logs 306
power management 302
failure 303
resume 303
schedule 304
UPS 303
reset 310
restoring settings 310
shutdown 313
upgrading firmware 122

O
one-way incremental backup 254
online backup 254
online support information 2
other documentation 2
ownCloud 251

P

master browser 210
media server 214, 216
configuration 217
iTunes server 214, 218, 234
Logitech® Media Server 218
rebuild database 216
share publish 217
status 216
membership 284
groups 284, 289

P2P download
IP filtering 227
protection 236, 237
re-seeding 220
settings 225
torrent files 222, 235
health 230
info-hash 230
trackers 230

Memopal 254

parity 98

mirroring 98

passive mode transfer 216

moving contents 298

personal cloud 251

myZyXELCloud 26

Play Next 137
port mapping 113
power button 16
power management 302
failure 303
resume 303
schedule 304
UPS 303

N
naming
server 209
shares 128
workgroup 210

PPPoE 107, 111, 119

NAS Starter Utility 19

preferences, download service 223

navigation panel 140

print server 240
configuration 231
name 232

network 106
DNS 106, 108
IP address 106

private cloud 251
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Index

protect 192
backup 191
backup tutorial 194

schedule, power management 304

protection, download service 236, 237
public key certificate 312
editing 312

server
Syslog 243
TFTP 250

publishing shares 217

server entry, FTP Uploadr 271

scheduling, download service 225
secure connections 182

server name 209
setup
COPY/SYNC button 232
download service 219
Flickr 266
FTP Uploadr 272
media server 217
P2P download 225
print server 231
YouTube 267, 268

Q
Quick Start Guide 2

R

share
configuration 126
troubleshooting local user access 344

RAID
background information 98
data protection 102
RAID 0 99
RAID 10 101
RAID 5 101
RAID 5 spare 102

share publishing 217

restoring settings 310

shares 124, 291
access rights 127, 294, 295
adding 292, 293
copying contents 298
downloading files 126
editing 293
folder creation 125
moving contents 298
names 128
recycle bins 292, 295
activation 293
configuration 296
share browser 292, 296
status 292
types 292
uploading files 126, 297

Roku 3 30

shutdown 313

RSS 215
download service notifications 236

smart TVs 30

rebuild media server database 216
recycle bins 295
activation 127, 293
configuration 292, 296
related documentation 2
remote access 26
reset 17, 310
restoring
by backup files tutorial 34, 198
by backup job tutorial 196
files 196

SSL 188, 311
certificate 312
editing 312
tutorial 177

S

status 139, 203
download service 221
shares 292
volume 97

S.M.A.R.T.
attributes 79
safety level, Flickr 267

status center 103
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storage 47
status 97
volumes 95

domain user share access 345
file access 345
folder access 345
forgot password 340, 341
LED indicators 337
LAN 339
local user share access 344
login 343
media files 348
NAS Starter Utility 339
overview 337
user share access 343
web configurator access 341

streaming 30
striping 98
support information 2
synchronization 232, 242, 256
configuration 232
directions 233
single direction 242
tutorial 194
two directions 243
Syslog server 243

two-way synchronization 256

system
date/time 210
login 38
master browser 210
reset 17
server name 209
settings 205
status 203
time lag 206
workgroup name 210

U
Universal Plug and Play. See UPnP.
upgrading firmware 122
uploading files 126, 297
UPnP 113
port mapping 113
UPS 303
URL 222

T

User Name 121
usernames 284

target 86

users 281
adding an account 282, 283
displaying information 282, 285
editing an account 283
group membership 284, 289
icons 283
search 282
usernames 284

TCP/IP 107
temperature
CPU 104
TFTP server 250
thumbprint 186
time 210
lag 206
server 211
zone 24, 211
Time Machine 278

V

TLS 188, 214, 262
torrent files 222, 235
health 230
info-hash 230
trackers 230

video category, YouTube 269
video playback 137
volume
RAID 1 99

Transport Layer Security, see TLS

volumes 95
status 97

troubleshooting
domain user 345

Cloud Storage User’s Guide

371

Index

W
warranty 365
note 365
web configurator 38
login 38
navigation panel 140
status 139
web publishing 215, 230, 240
activation 230
example 238
port number 240
troubleshooting 350
web security 182
workgroup name 210

Y
YouTube 262
access rights 269
activation 263
authorization 267
configuration 267, 268
grace period 269
video category 269

Z
zCloud 30
ZyXEL Drive 26
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